Welcome to Ubuntu

Use the Launcher to start applications
Find apps, files, music, and more with the Dash
Manage apps & settings with the menu bar
Log out, power off, switch users

Desktop, apps & windows
Introduction, keyboard shortcuts, windows...

Networking, web, email & chat
Wireless, wired, connection problems, web browsing, email accounts, instant messaging...

Sound, video & pictures
Digital cameras, iPods, playing videos...

Files, folders & search
Searching, delete files, backups, removable drives, documents...

Add & remove software
Install, remove, extra repositories...

User & system settings
Keyboard, mouse, display, languages, user accounts...

Hardware & drivers
Hardware problems

Universal access
Seeing, hearing...

Tips & tricks
Special characters...
Welcome to Ubuntu

Use the Launcher to start applications

Find apps, files, music, and more with the Dash

Manage apps & settings with the menu bar
Log out, power off, switch users

Desktop, apps & windows
Introduction, keyboard shortcuts, windows...

Networking, web, email & chat
Wireless, wired, connection problems, web browsing, email accounts, instant messaging...
Sound, video & pictures
Digital cameras, iPods, playing videos…

Add & remove software
Install, remove, extra repositories…

Files, folders & search
Searching, delete files, backups, removable drives, documents…

User & system settings
Keyboard, mouse, display, languages, user accounts…
Hardware & drivers
Hardware problems, printers, power settings, color management, Bluetooth, disks...

Universal access
Seeing, hearing, mobility, braille...

Tips & tricks
Special characters, middle click shortcuts...

Get more help
Tips on using this guide, help improve this guide...
Welcome to Ubuntu

Ubuntu features *Unity*, a reimagined way to use your computer. Unity is designed to minimize distractions, give you more room to work, and help you get things done.

This guide is designed to answer your questions about using Unity and your Ubuntu desktop. First we
will take a moment to look at some of Unity's key features, and how you can use them.

Getting started with Unity
The Launcher appears automatically when you log in to your desktop, and
gives you quick access to the applications you use most often.

- Learn more about the Launcher.

The Dash

The Ubuntu Button sits near the top left corner of the screen and is always the top item in the Launcher. If you click the
Ubuntu Button, Unity will present you with an additional feature of the desktop, the Dash.

The *Dash* is designed to make it easier to find, open, and use apps, files, music, and more.
For example, if you type the word "document" into the Search Bar, the Dash will show you applications that help you write and edit documents. It will also show you relevant folders and documents that you have been working on recently.

- Learn more about the Dash.
Desktop, apps & windows — Introduction, keyboard shortcuts, windows...

Ubuntu Desktop Guide

See Also

About this guide — A few tips on using the Ubuntu Desktop Guide.
Use the Launcher to start applications

The Launcher is one of the key components of the Unity desktop. When you log in to your desktop, it will appear
along the left-hand side of the screen. The Launcher provides you with quick access to applications, workspaces, removable devices and the trash.

If an application that you want to start using is present in the Launcher, you can click on that application's icon, and it will start up, ready for you to use.

To learn more about the Launcher,
explore any of the Launcher help topics below.

Use the Launcher

The Launcher Icon Menus
Right clicking a Launcher Icon reveals a menu of actions.

What do the different shapes and colors in Launcher icons mean?
The triangles show you your currently running apps.
Customize the Launcher

Change which applications show in the Launcher
Add, move, or remove frequently-used program icons on the Launcher.

Auto-hide the Launcher
Show the Launcher only when you need it.
Change the size of icons in the Launcher

Make the icons in the Launcher larger or smaller.

More Information

The Desktop

Ubuntu Desktop Guide
The Launcher Icon Menus

Right clicking on a Launcher icon will reveal a menu of actions. The actions available depend on whether the icon is locked to the launcher or not, if the icon is for an application whether it's running or not, and on the specific icon itself. Available actions can include the following.
• launching the application or opening the document, folder, or device

• unlocking the icon from the Launcher if it was previously locked (see Change which applications show in the Launcher)

• locking the icon to the Launcher if it was previously not locked (see Change which
applications show in the Launcher

- quitting the application if it's running
- switching between application instances or windows if there is more than one instance or window
- application-specific shortcuts such as open a new
document or window

More Information
Use the Launcher
What do the different shapes and colors in Launcher icons mean?

When you start an app, the Launcher icon pulses to let you know that Ubuntu is starting your
app. This is useful because while some apps start immediately, others may take a minute to load.

Once the app has finished starting, a small *white triangle* will show to the left of the Launcher square. Two triangles means that you have two windows of the same app open. If you have three or more windows of the same app open, three triangles will show.
Apps that aren't currently running have translucent Launcher icon squares. When an app is running, the Launcher icon square is full of color.

Notifications

If an app wants your attention to notify you of something (like a finished download), the Launcher
icon will wiggle and glow and the white triangle will become *blue*. Click the Launcher icon to dismiss the notification.

Apps can also show a *number* on their Launcher icon. Messaging apps use the number to tell you how many unread messages you have. *Software Updater* uses it to tell you how many updates are available.

Finally, apps can use a *progress bar*
to let you know how long a process is taking without you needing to keep the app window in view.

More Information

Use the Launcher
Change which applications show in the Launcher

To add an application to the Launcher for quick access:

- Drag the application's icon from the Dash onto the Launcher.
• Alternatively, when an application is running, right click on the application icon and select Lock to Launcher.

The Launcher icon order can be changed by dragging an icon off of the Launcher, and then back onto it in the desired location.

To remove an application icon from the Launcher, right click on the application icon and select Unlock.
from Launcher.

More Information

Applications and windows

Customize the Launcher

See Also

Search everything from the Dash home
Auto-hide the Launcher

You can hide the Launcher if you only want to see it when you move your mouse or touchpad pointer to the left side of the screen.

1. Click the icon at the very right of the menu bar and select System Settings.
2. In the Personal section, click Appearance.

3. Switch to the Behavior tab.

4. Switch Auto-hide the Launcher on.

To help prevent you from accidentally showing the Launcher, Ubuntu requires you to push a little bit harder with your mouse or touchpad pointer to make the
Launcher show. You can adjust the force needed by setting the Reveal sensitivity lower or higher.

More Information

Customize the Launcher
Change the size of icons in the Launcher

You can make the Launcher icons smaller to allow more items to fit in the Launcher. Or you might want to make the Launcher icons larger so they are easier to click.
1. Click the icon at the very right of the menu bar and select **System Settings**.

2. Click **Appearance**.

3. Move the **Launcher icon size** slider to increase or decrease the size of the Launcher icons.

The default Launcher
icon size is 48.

More Information

Customize the Launcher
Find apps, files, music, and more with the Dash

The Dash allows you to search
for applications, files, music, and videos, and shows you items that you have used recently. If you have ever worked on a spreadsheet or edited an image and forgot where you saved it, you will surely find this feature of the Dash to be useful.

To start using the Dash, click the top icon in the Launcher. This icon has the Ubuntu logo on it. For faster access, you can just press the Super key.
To hide the Dash, click the top icon again or press Super or Esc.

Search everything from the Dash home

The first thing you'll see when opening the Dash is the Dash Home. Without typing or clicking anything, the Dash Home will show you apps and files you've used recently.
Only one row of results will show for each type. If there are more results, you can click See more results to view them.

To search, just start typing and related search results will automatically appear from the different installed lenses.

Click on a result to open it, or you can press Enter to open the first item in the list.
See Also

Change which applications show in the Launcher — Add, move, or remove frequently-used program icons on the Launcher.

Why are there shopping links in the Dash? — Online results make the Dash more useful and help fund Ubuntu development.

Lenses

Lenses allow you to focus the Dash results and exclude results from
other lenses.

You can see the available lenses in the lens bar, the darker strip at the bottom of the Dash.

To switch to a different lens, click the appropriate icon or press Ctrl + Tab.

See Also

Applications lens — Run, install, or uninstall apps.

Files lens — Find files, folders,
and downloads.

**Friends scope** — Browse messages from your online social media accounts.

**Music lens** — Find and play music from your computer or the internet.

**Photos lens** — View photos from your computer or your online social media accounts.

**Video lens** — Find and play videos from your computer or the internet.
Filters

Filters allow you to narrow down your search even further.

Click Filter results to choose filters. You may need to click a filter heading such as Sources to see the available choices.

Previews

If you right click on a search result,
a preview will open with more information about the result.

To close the preview, click any empty space or press Esc.

More Information

The Desktop

Ubuntu Desktop Guide
Why are there shopping links in the Dash?

In addition to helping you find apps or files on your computer, the Dash also shows you related online results for your searches. Online sources include Amazon.com and dozens of other online sources.
When you purchase music or products from these sources, Canonical receives a small portion of the profits in exchange for directing more business to these stores. Canonical, the company that created and continues to support the Ubuntu project, then uses this money to make Ubuntu better.
If you don't want to receive online search suggestions, you can disable this feature.

1. Click the icon at the far right of the menu bar and select System Settings.

2. Open Security & Privacy and select the Search tab.

3. Switch off Include online search results.
4. Log out and log back in for the change to take effect.

More Information

Find apps, files, music, and more with the Dash — The Dash is the top button in the Launcher.

See Also

Search everything from the Dash home
Applications lens

The applications lens is the first lens after the Dash home in the lens bar. The applications lens gives you access to your apps or apps available for install.

You can use Super + A to open the Dash directly at the applications lens.
Right click on a search result to open a preview. The preview shows a short description of the app, a screenshot, its Software Center rating, and what version is available.

For installed apps, you can see when the app was installed and either launch the app or uninstall it. Certain essential apps cannot be uninstalled from the preview.
For apps that haven't been installed, you can install them right from the preview.

**Filters**

Click Filter results if you'd like to only see results for a certain type of application. You can also click Sources ➤ Local Apps to only view installed apps or Sources ➤ Software Center to only show apps
available for install.

More Information

Lenses

See Also

Lenses
Files lens

The files lens is the second lens after the Dash home in the lens bar and is represented by a document. The files lens gives you access to recently used files, folders, or downloads.

You can use `Super + F` to open the Dash directly at the files lens.
1. If you use Google Drive, be sure to add your Google credentials to Online Accounts to see search results from Google Drive.

Previews

Right click on a search result to open a preview. The preview shows the file format, file size, and when it
You can open a file, email it, or open the folder that contains the file.

Filters

Click Filter results to filter by file type, file size, or the last time the file was saved.
More Information

Lenses

See Also

Lenses
Friends scope

The Friends scope is the sixth lens after the Dash home in the lens bar and is represented by a speaking bubble. The Friends scope gives you access to your social media accounts.

You can use Super + G to open the Dash directly at the Friends Scope icon.
The lens will be blank until you enter your credentials in Online Accounts.

Previews

Right click on a search result to open a preview. The preview gives you more information and allows you to "like" or reshare posts.
Click Filter results to filter by account.

More Information

Lenses

See Also

Lenses
Music lens

The music lens is the fourth lens after the Dash home in the lens bar and is represented by a music note. The music lens gives you access to your music or music available online.

You can use Super + M to open the Dash directly at the music lens.
Previews

Right click on a search result to open a preview. The preview shows the cover art and the tracks.

Click the track number to play the song right from the preview. Click the track number again to pause the song.

Filters
Click Filter results to filter by decade or genre.

More Information

Lenses

See Also

Lenses
Photos lens

The photos lens is the fifth lens after the Dash home in the lens bar and is represented by a camera. The photos lens gives you access to photos on your computer or from Online Accounts such as Facebook or Google Picasa.

You can use Super + C to open the Dash directly at the photos
Previews

Right click on a search result to open a preview with more information about the photo and a larger thumbnail.

For photos stored on your computer, you can open, print, view, or email them.
Click Filter results to filter by date the photo was taken or the source.

More Information

Lenses

See Also

Lenses
Video lens

The video lens is the third lens after the Dash home on the lens bar and is represented by a film strip. The video lens gives you access to your videos or videos available online.

You can even buy or rent videos from the Dash.

You can use Super + V to
open the Dash directly at the video lens.

**Previews**

Right click on a search result to open a **preview** with more information about the video.

**Filters**

Click **Filter results** to filter by video.
source.

More Information

Lenses

See Also

Lenses
Manage apps & settings with the menu bar

The menu bar is the dark strip on the top of your screen. It contains the window management buttons, the app menus, and the status menus.
Window management buttons

The window management buttons are on the top left corner of windows. When maximized, the buttons are in the top left of the screen. Click the buttons to close, minimize, maximize or restore windows.

See Also

Window operations — Restore,
App menus

The app menus are by default located to the right of the window management buttons. Unity hides the app menus and the window management buttons unless you move your mouse pointer to the top left of the screen or press \[\text{Alt} + \text{F10}\]. This feature enables you to see more of your content at resize, arrange and hide.
once, which is especially valuable on small screens like netbooks.

If you want, you can change the default behavior, and have your menus attached to the window title bar of respective application instead of the menu bar.

1. Click the icon at the very right of the menu bar and select System Settings.
2. In the Personal section, click Appearance and choose the Behavior tab.

3. Under Show the menus for a window, select In the window's title bar.

Status menus

Ubuntu has several different status menus (sometimes referred to as
indicators) on the right side of the menu bar. The status menus are a convenient place where you can check and modify the state of your computer and applications.

List of status menus and what they do

- **Network menu**

  Connect to **wired**, **wireless**, **mobile**, and **VPN** networks.
• *Input source menu*

Select keyboard layout/input source, *configure input sources*.

• *Bluetooth menu*

Send or receive files by *Bluetooth*. This menu is hidden if a supported Bluetooth device isn't
detected.

- **Messaging menu**

  Easily launch and receive incoming notifications from messaging applications including email, social networking, and Internet chat.

- **Battery menu**

  Check your laptop battery's
charging status. This menu is hidden if a battery isn't detected.

- **Sound menu**

  Set the **volume**, configure sound **settings**, and control media players like **Rhythmbox**.

- **Clock**

  Access the current time and
date. Appointments from your **Evolution calendar** can also display here.

- **System menu**

Access details about your computer, this help guide, and **system settings**. Switch users, lock screen, log out, suspend, restart or shutdown your computer.
Some of the icons used by the indicator menus change according to the status of the application.

Other programs such as Tomboy or Transmission can also add indicator menus to the panel.

More Information
Log out, power off, switch users

When you've finished using your computer, you can turn it off, suspend it (to save power), or leave it powered on and log out.

Log out or switch users
To let other users use your computer, you can either log out, or leave yourself logged in and just switch users. If you switch users, all of your applications will continue running, and everything will be where you left it when you log back in.

To log out or switch users, click the [system menu](#) at the very right of the menu bar and select the appropriate option.
Lock the screen

If you're leaving your computer for a short time, you should lock your screen to prevent other people from accessing your files or running applications. When you return, simply enter your password to log back in. If you don't lock your screen, it will lock automatically after a certain amount of time.

To lock your screen, click the
system menu in the menu bar and select Lock Screen.

When your screen is locked, other users can log in to their own accounts by clicking Switch User on the password screen. You can switch back to your desktop when they are finished.

See Also

Automatically lock your screen — Prevent other people from using your desktop when you go away
from your computer.

The screen locks itself too quickly — Change how long to wait before locking the screen in the Brightness & Lock settings.

Suspend

To save power, suspend your computer when you aren't using it. If you use a laptop, Ubuntu suspends your computer automatically when you close the
This saves your state to your computer's memory and powers off most of the computer's functions. A very small amount of power is still used during suspend.

To suspend your computer manually, click the system menu in the menu bar and select Suspend.

See Also

What happens when I suspend my computer? — Suspend sends your computer to sleep so it uses...
less power.

## Power off or restart

If you want to power off your computer entirely, or do a full restart, click the system menu and select Shut Down.

If there are other users logged in, you may not be allowed to power off or restart the computer, because this will end their sessions. If you
are an administrative user, you may be asked for your password to power off.

See Also

Use less power and improve battery life — Tips to reduce the power consumption of your computer.

More Information

Power & battery — Suspend, energy savings, power off,
screen dimming...

The Desktop

Ubuntu Desktop Guide

See Also

How do I hibernate my computer? — Hibernate is disabled by default since it's not well supported.
Desktop, apps & windows

Welcome to Ubuntu
A visual introduction to the Unity desktop.

Useful keyboard shortcuts
Get around the desktop using the keyboard.

The Desktop
Use the Launcher to start applications
The Launcher is at the left of your screen.

Calendar appointments
Display your appointments on the calendar at the top of the screen.

Find apps, files, music, and more with the Dash
The Dash is the top button in the Launcher.

Manage apps & settings with the menu bar
The menu bar is the dark strip on the top of your screen.
What are overlay scrollbars?
Overlay scrollbars are the thin orange strips on long documents.

What is the HUD?
Use the HUD to search menus of the apps you use.

Launch a restricted guest session
Let a friend or colleague borrow your computer in a secure manner.

Log out, power off, switch users
Learn how to leave your user
Learn how to leave your user account, by logging out, switching users, and so on.

Applications and windows
Change which applications show in the Launcher
Add, move, or remove frequently-used program icons on the Launcher.

Startup Applications
Choose what applications to start when you log in.

Switch between windows
Press `Alt` + `Tab`.

Windows and workspaces
Move and organize your windows.
More Information

Ubuntu Desktop Guide
Useful keyboard shortcuts

This page provides an overview of keyboard shortcuts that can help you use your desktop and applications more efficiently. If you cannot use a mouse or pointing device at all, see Keyboard navigation for more information on
navigating user interfaces with only the keyboard.

↑ Getting around the desktop

Alt + F4

Alt + F2
Alt + Tab

Alt + `
Super + S
Super + W
Ctrl + Alt + Arrow keys

Ctrl + Alt + Shift + Arrow keys

Ctrl + Alt + Delete
Common editing shortcuts
Ctrl + A  Select all text or items in a list.

Ctrl + X  Cut (remove) selected text or items and place it on the clipboard.

Ctrl + C  Copy selected text or items to
the clipboard.

Ctrl + V Paste the contents of the clipboard.

Ctrl + Z Undo the last action.

Capturing from the screen
Print Screen

Alt + Print Screen

Shift + Print Screen
The pointer changes to a crosshair.

Click and drag to select an area.
Introduction, keyboard shortcuts, windows...

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility...

Tips & tricks — Special characters, middle click shortcuts...

See Also

Keyboard navigation — Use applications and the desktop without a mouse.

Screenshots — Take a picture of what's happening on your screen.

Set keyboard shortcuts — Define
or change keyboard shortcuts in Keyboard settings.

What is the "Super" key? — The Super key provides access to the Dash and the Launcher.
Calendar appointments

You can organize your calendar appointments by clicking on the clock in the panel, if you're using a mail and calendar application called *Evolution*.

If you have already set up Evolution, click the clock on the menu bar and then click the Add
Event to start adding appointments. As appointments are added, they will appear below the calendar when you click on the clock.

To quickly get to the full Evolution calendar, click on the clock and click the first line where today's date is.

This will work only if you have an existing Evolution account. Otherwise, a window will
appear with the necessary steps for adding your first account.

Turn off Evolution calendar integration

You can also turn off this feature if you like.

1. Click on the clock and select Time & Date
Settings.

2. Now, switch to the Clock tab.

3. Uncheck Coming events from Evolution Calendar.

More Information

The Desktop

Time & date — Set time and date, timezone, calendar and appointments…
What are overlay scrollbars?

Ubuntu includes overlay scrollbars which take up less screen space than traditional scrollbars, giving you more room for your content. While inspired by mobile devices where traditional scrollbars aren't needed, Ubuntu's overlay scrollbars are
designed to work just as well with a mouse.

Some apps like Firefox and LibreOffice don't support the new scrollbars yet.

**Use the scrollbars**

The overlay scrollbar appears as a thin orange strip at the edge of a scrollable area. The position of the scrollbar corresponds with your
screen's position in the scrollable content. The strip length corresponds with the content length; the shorter the strip, the longer the content.

Move your mouse pointer over any point on the scrollable edge of the content to reveal the thumb slider.

**Ways to use the scrollbars:**

- Click the top half of the thumb slider to scroll one page up.
Click the bottom half to scroll one page down.

- Drag the thumb slider up or down to move the screen's position exactly where you want it.

- **Middle-click** on the thumb slider to move the screen's position without needing to drag or scroll page by page. This is especially useful in
Disable the scrollbars

You can disable the new scrollbars if you prefer the traditional style:

1. Open the *Terminal* by pressing `Ctrl + Alt + t` or by searching for `terminal` in the Dash.
2. Type the following command and press Enter:

```
gsettings set com.canonical.desktop.interface scrollbar-mode normal
```

If you change your mind and want to re-enable the scrollbars, run this command:

```
gsettings reset com.canonical.desktop.interface scrollbar-mode
```

Setting your theme to High.
Contrast will also disable the overlay scrollbars.

More Information

The Desktop

See Also

Click, drag, or scroll with the touchpad — Click, drag, or scroll using taps and gestures on your touchpad.
What is the HUD?

The HUD or Heads Up Display is a search-based alternative to traditional menus and was introduced in Ubuntu 12.04 LTS.

Some apps like Gimp or Inkscape have hundreds of menu items. If you're using apps like these, you may remember the name of a menu
option, but you might not remember how to find it in the menus.

Using a search box can be quite a bit faster than navigating extended menu hierarchies. The HUD also can be more accessible than normal menus as some people are unable to precisely control a mouse pointer.

Use the HUD

To try the HUD:
1. Tap \texttt{Alt} to open the HUD.

2. Start typing.

3. When you see a result that you want to run, use the up and down keys to select the result, then press \texttt{Enter}, or click your desired search result.

4. If you change your mind
and want to exit the HUD, tap the \texttt{Alt} again or the \texttt{Esc}. You can also click anywhere outside the HUD to close the HUD.

The HUD keeps track of your search history and adjusts the search results to be even more useful the more you use it.
The Desktop
Launch a restricted guest session

Temporary session with restricted privileges

Once in a while a friend, family member, or colleague may want to borrow your computer. The Ubuntu
Guest Session feature provides a convenient way, with a high level of security, to lend your computer to someone else. A guest session can be launched either from the login screen or from within a regular session. If you are currently logged in, click the icon at the far right of the menu bar and select Guest Session. This will lock the screen for your own session and start the guest session.
A guest cannot view the home folders of other users, and by default any saved data or changed settings will be removed/reset at logout. It means that each session starts with a fresh environment, unaffected by what previous guests did.

Customization

The Customize Guest Session
online tutorial explains how to customize the appearance and behavior.

Disabling the feature

If you prefer not to allow guest access to your computer, you can disable the Guest Session feature. To do so, press \texttt{Ctrl + Alt + T} to open a terminal window, and then run this
The command creates a small configuration file. To re-enable
Guest Session, simply remove that file:

```
sudo rm /usr/share/lightdm/lightdm.conf.d/no-guest.conf
```

More Information

Manage user accounts

The Desktop

See Also

Add a new user account — Add
new users so that other people can log in to the computer.
You can configure what applications should be started at login, in addition to the default startup applications configured on the system.

1. Use the Dash to find and open Startup Applications.
Alternatively you can press `Alt + F2` and run the `gnome-session-properties` command.

2. Click **Add** and enter the command to be executed at login (name and comment are optional). For example, to make Firefox start automatically, it's sufficient to type `firefox` in the
Command field and confirm with Add.

You can either type the command, or click the Browse… button and select a command. Applications to autostart are typically located in the /usr/bin folder.
More Information

Applications and windows

User & system settings — Keyboard, mouse, display, languages, user accounts…
Switch between windows

From the Launcher

1. Show the Launcher by moving your mouse to the top left corner of your screen.
2. Applications that are running have a small white triangle arrow on the left. Click on a running application icon to switch to it.

3. If a running application has multiple windows open, there will be multiple white arrows on the left. Click the application icon a second time to show all open
windows zoomed out. Click the window you want to switch to.

From the keyboard

- Press **Alt** + **Tab** to bring up the window switcher.

  - Release **Alt** to select the next (highlighted) window in the switcher.
- Otherwise, still holding down the Alt key, press Tab to cycle through the list of open windows, or Shift + Tab to cycle backwards.

- Windows in the window switcher are grouped by application. Previews of applications with
multiple windows pop up as you click through.

- You can also move between the application icons in the window switcher with the → or ← keys, or select one by clicking it with the mouse.

- Previews of applications
with a single window can be displayed with the ↓ key.

Only windows from the current *workspace* will be shown. To show windows from all workspaces, hold down the Ctrl and Alt keys and press Tab or
• Press **Super** + **W** to show all open windows zoomed out.

  ○ Click the window you want to switch to.

---

**More Information**

Applications and windows

Working with windows
Windows and workspaces

Like other desktops, Unity uses windows to display your running applications. Using both the Dash and the Launcher, you can launch new applications and control which window is active.

In addition to windows, you can also group your applications together
within workspaces. Visit the window and workspace help topics below to better learn how to use these features.

Working with windows

Maximize and unmaximize a window
Double-click or drag a titlebar to maximize or restore a window.

Switch between windows
Press Alt + Tab.
Tile windows
Maximize two windows side-by-side.

Window operations
Restore, resize, arrange and hide.

Working with workspaces
What is a workspace, and how will it help me?

Workspaces are a way of grouping windows on your desktop.

Move a window to a different workspace

Open the workspace switcher and drag the window to a different workspace.

Switch between workspaces

Open the workspace switcher and double-click one of the workspaces.
More Information

Applications and windows
Maximize and unmaximize a window

You can maximize a window to take up all of the space on your desktop and unmaximize a window to restore it to its normal size. You can also maximize windows vertically along the left and right sides of the screen, so you can look at two
windows at once. See [Tile windows](#) for details.

To maximize a window, grab the titlebar and drag it to the top of the screen, or double-click the titlebar.

To maximize a window using the keyboard, hold down **Ctrl** and **Super** and press ↑.

To restore a window to its unmaximized size, drag it away from the edges of the screen. If the
window is fully maximized, you can double-click the titlebar to restore it. You can also use the keyboard shortcut `Ctrl + Super + ↓`.

Hold down the `Alt` key and drag anywhere in a window to move it.

More Information

Working with windows
See Also

Tile windows — Maximize two windows side-by-side.
Tile windows

You can maximize a window on only the left or right side of the screen, allowing you to place two windows side-by-side to quickly switch between them.

To maximize a window along a side of the screen, grab the titlebar and drag it to the left or right side until half of the screen is highlighted.
Using the keyboard, hold down Ctrl and Super and press the Left or Right key.

Hold down the Alt key and drag anywhere in a window to move it.

More Information

Working with windows

See Also
Maximize and unmaximize a window — Double-click or drag a titlebar to maximize or restore a window.
Window operations

Windows can be resized or concealed to suit workflow.

Minimize, restore and close

To minimize or hide a window:

• Click the - in the top left hand
corner of the application's menu bar. If the application is maximized (taking up your whole screen), the menu bar will appear at the very top of the screen. Otherwise, the minimize button will appear at the top of the application window.

- Or press **Alt** + **Space** to bring up the window menu. Then press **n**. The window
'disappears' into the Launcher.

To restore the window:

- Click on it in the Launcher or retrieve it from the window switcher by pressing `Alt + Tab`.

To close the window:

- Click the x in the top left hand corner of the window, or
• Press \texttt{Alt + F4}, or

• Press \texttt{Alt + Space} to bring up the window menu. Then press \texttt{c}.

\section*{Resize}

\begin{itemize}
  \item A window cannot be resized if it is \textit{maximized}.
\end{itemize}

To resize your window horizontally
and/or vertically:

- Move the mouse pointer into any corner of the window until it changes into a 'corner-pointer'. Click+hold+drag to resize the window in any direction.

To resize only in the horizontal direction:

- Move the mouse pointer to
either side of the window until it changes into a 'side-pointer'. Click+hold+drag to resize the window horizontally.

To resize only in the vertical direction:

- Move the mouse pointer to the top or bottom of the window until it changes into a 'top-pointer' or 'bottom-pointer' respectively.
Click+hold+drag to resize the window vertically.

Arranging windows in your workspace

To place two windows side by side:

- Click on the title bar of a window and drag it toward the left edge of the screen. When the mouse pointer touches the edge, the left half of the
screen becomes highlighted. Release the mouse button and the window will fill the left half of the screen.

- Drag another window to the right side: when the right half of the screen is highlighted, release. Each of the two windows fills half the screen.

Pressing $\text{Alt} + \text{click}$
anywhere in a window will allow you to move the window. Some people may find this easier than clicking on the title bar of an application.

More Information
Working with windows

See Also
Window management buttons
What is a workspace, and how will it help me?

Workspaces refer to the grouping of windows on your desktop. These virtual desktops increase the size of your working area. Workspaces are meant to reduce clutter and make
desktop easier to navigate.

Workspaces can be used to organize your work. For example, you could have all your communication windows, such as e-mail and your chat program, on one
workspace, and the work you are doing on a different workspace. Your music manager could be on a third workspace.

Enable workspaces

1. Click the icon at the very right of the menu bar and select System Settings.

2. In the Personal section, click Appearance and select
3. Tick the Enable workspaces checkbox.

Now you can open the Launcher and click the workspace switcher icon near the bottom. By default, Ubuntu shows 4 workspaces, arranged in 2 rows and 2 columns. You can change the number of workspaces:
Change the number of workspaces

1. Go to the **Dash** and open the **Terminal**.

2. To change the number of rows, type the following command, changing the final number to the number you wish. Press **Enter**.

   ```bash
   gsettings set org.compiz.core:/org/compiz/profiles/unity/plugins/core/vsize 2
   ```
3. To change the number of columns, type the following command, changing the final number to the number you wish. Press Enter.

```
gsettings set org.compiz.core:/org/compiz/profiles/unity/plugins/core/hsize 3
```

More Information

Working with workspaces

See Also
Move a window to a different workspace — Open the workspace switcher and drag the window to a different workspace.

Switch between workspaces — Open the workspace switcher and double-click one of the workspaces.
Move a window to a different workspace

Please see What is a workspace, and how will it help me? about enabling workspaces.

Using the mouse:
1. Open the **Launcher** and click the workspace switcher button near the bottom.

2. Drag the window to the workspace you choose.

Using the keyboard:

1. Select the window you want
to move.

2. Press `Ctrl + Alt + Shift + →` to move the window to a workspace which is to the right of the current workspace on the workspace switcher.

3. Press `Ctrl + Alt + Shift + ←` to move the window to a
workspace which is to the left of the current workspace on the workspace switcher.

4. Press Ctrl + Alt + Shift + ↓ to move the window to a workspace which is below the current workspace on the workspace switcher.

5. Press
to move the window to a workspace which is above the current workspace on the workspace switcher.

More Information

Working with workspaces

See Also

What is a workspace, and how will it help me? — Workspaces
are a way of grouping windows on your desktop.
Switch between workspaces

Please see What is a workspace, and how will it help me? about enabling workspaces.

Using the mouse:

Open the Launcher and click
the workspace switcher button near the bottom. Double-click on any window or workspace to switch to it, or press the workspace switcher button again to return to your previous workspace.

Using the keyboard:

- Press Ctrl + Alt + → to move to a workspace
which is to the right of the current workspace.

- Press \textbf{Ctrl} + \textbf{Alt} + \leftarrow to move to a workspace which is to the left of the current workspace.

- Press \textbf{Ctrl} + \textbf{Alt} + \downarrow to move to a workspace which is below the current workspace.
• Press **Ctrl + Alt + ↑** to move to a workspace which is above the current workspace.
More Information

Working with workspaces

See Also

What is a workspace, and how will it help me? — Workspaces are a way of grouping windows on your desktop.
Networking, web, email & chat
Wireless Networking
Connect to wifi, Hidden networks, Edit connection settings, Disconnecting…

Chat & Social Networking
Chat on any network using Empathy, make video calls, install skype, social networking apps
Connect to mobile broadband
Connect to the internet using mobile broadband

Contacts
Access your contacts.

Email & email software
Default email apps

Keeping safe on the internet
Antivirus software, basic firewalls…
Network problems
Troubleshooting wireless connections, finding your wifi network...

Networking terms & tips
Find your IP address, WEP & WPA security, MAC addresses, proxies...

Sharing
Desktop sharing, Share files...

Web Browsers
Change the default browser, install Flash, install the java plugin, Silverlight support...
Wired Networking
Wired internet connections, Fixed IP addresses…

More Information
Ubuntu Desktop Guide
Wireless Networking

Connect to a wireless network
Get on the internet - wirelessly.

Connect to a VPN
VPNs allow you to connect to a local network over the internet. Learn how to set up a VPN connection.

Connect to a hidden wireless network
Click the network menu on the
Click the network menu on the menu bar and select Connect to Hidden Wireless Network.

**Create a wireless hotspot**

Use an ad-hoc network to allow other devices to connect to your computer and its network connections.

**Edit a wireless connection**

Learn what the options on the wireless connection editing screen mean.

**I can't see my wireless network in the list**

The wireless could be turned off or broken, there might be too
or broken, there might be too many wireless networks nearby, or you might be out of range.

I've entered the correct password, but I still can't connect

Double-check the password, try using the pass key instead of the password, turn the wireless card off and on again…

Manually set network settings

If network settings don't get assigned automatically, you may have to enter them yourself.

Turn off wireless (airplane mode)
Click the network menu on the menu bar and uncheck Enable Wireless.

**What do WEP and WPA mean?**
WEP and WPA are ways of encrypting data on wireless networks.

**Why does my wireless network keep disconnecting?**
You might have low signal, or the network might not be letting you connect properly.

**Wireless network troubleshooter**
Identify and fix problems with
More Information

Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging...

See Also

Network problems — Troubleshooting wireless connections, finding your wifi network...
Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies...
Connect to a wireless network

If you have a wireless-enabled computer, you can connect to a wireless network that is within range to get access to the internet, view shared files on the network, and so on.
1. If you have a wireless hardware switch on your computer, make sure that it is turned on.

2. Click the **network menu** in the menu bar, and click the name of the network you want to connect to.

If the name of the network isn't in the list, select **More Networks** to see if the
network is further down the list. If you still don't see the network, you may be out of range or the network might be hidden.

3. If the network is protected by a password (encryption key), enter the password when prompted and click Connect.

If you do not know the key,
it may be written on the underside of the wireless router or base station, in its instruction manual, or you may have to ask the person who administers the wireless network.

4. The network icon will change appearance as the computer attempts to connect to the network.
5. If the connection is successful, the icon will change to a dot with several bars above it. More bars indicate a stronger connection to the network. If there aren't many bars, the connection is weak and might not be very reliable.

If the connection is not successful, you may be asked for your
password again or it might just tell you that the connection has been disconnected. There are a number of things that could have caused this to happen. You could have entered the wrong password, the wireless signal could be too weak, or your computer's wireless card might have a problem, for example. See Wireless network troubleshooter for more help.

A stronger connection to a wireless
network does not necessarily mean that you have a faster internet connection, or that you will have faster download speeds. The wireless connection connects your computer to the device which provides the internet connection (like a router or modem), but the two connections are actually different, and so will run at different speeds.
Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also

I've entered the correct password, but I still can't connect — Double-check the password, try using the pass key instead of the password, turn the wireless card off and on again...

Why does my wireless network keep disconnecting? — You might have low signal, or the
network might not be letting you connect properly.

**Wireless network troubleshooter** — Identify and fix problems with wireless connections
Connect to a VPN

A VPN (or Virtual Private Network) is a way of connecting to a local network over the internet. For example, say you want to connect to the local network at your workplace while you're on a business trip. You would find an internet connection somewhere (like
at a hotel) and then connect to your workplace's VPN. It would be as if you were directly connected to the network at work, but the actual network connection would be through the hotel's internet connection. VPN connections are usually encrypted to prevent people from accessing the local network you're connecting to without logging in.

There are a number of different
types of VPN. You may have to install some extra software depending on what type of VPN you're connecting to. Find out the connection details from whoever is in charge of the VPN and see which VPN client you need to use. Then, open Ubuntu Software Center and search for the network-manager package which works with your VPN (if there is one) and install it. You will need to click the Show technical
items link at the bottom of Ubuntu Software Center.

If there isn't a NetworkManager package for your type of VPN, you will probably have to download and install some client software from the company that provides the VPN software. You'll probably have to follow some different instructions to
get that working.

Once that's done, you can set up the VPN connection:

1. Click the network menu on the menu bar and, under VPN Connections, select Configure VPN.

2. Click Add and choose which kind of VPN connection you
3. Click Create and follow the instructions on the screen, entering details like your username and password as you go.

4. When you've finished setting-up the VPN, click the network menu on the menu bar, go to VPN Connections and click on
the connection you just created. It will try to establish a VPN connection - the network icon will change as it tries to connect.

5. Hopefully, you will successfully connect to the VPN. If not, you may need to double-check the VPN settings you entered. You can do this by clicking the
network menu, selecting Edit Connections and going to the VPN tab.

6. To disconnect from the VPN, click the network menu and select Disconnect under the name of your VPN connection.

More Information

Wired Networking — Wired
internet connections, Fixed IP addresses...

**Wireless Networking** — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...
Connect to a hidden wireless network

It is possible to set up a wireless network so that it is "hidden." Hidden networks won't show up in the list of networks that are displayed when you click the network menu in the menu bar (or the list of wireless networks on any...
other computer). To connect to a hidden wireless network:

1. Click the network menu on the menu bar and select Connect to Hidden Wireless Network.

2. In the window that appears, type the network name, choose the type of wireless security, and click Connect.
You may have to check the settings of the wireless base station or router to see what the network name is. It is sometimes called the BSSID (Basic Service Set Identifier), and looks something like this: 02:00:01:02:03:04.

You should also check the wireless base station's security settings. Look for terms like WEP and WPA.
You may think that hiding your wireless network will improve security by preventing people who don't know about it from connecting. In practice, this is not the case; the network is slightly harder to find but it is still detectable.
Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also

I can't see my wireless network in the list — The wireless could be turned off or broken, there might be too many wireless networks nearby, or you might be out of range.

Wireless
Create a wireless hotspot

You can use your computer as a wireless hotspot. This allows other devices to connect to you without a separate network, and allows you to share an internet connection you've made with another interface, such as to a wired network or over the
1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Network and select Wireless on the left.

3. Click the Use as Hotspot button.

4. If you are already
connected to a wireless network, you will be asked if you want to disconnect from that network. A single wireless adapter can only connect to or create one network at a time. Click Create Hotspot to confirm. A network name (SSID) and security key are automatically generated. The network name will
be based on the name of your computer. Other devices will need this information to connect to the hotspot you've just created.

More Information

**Wireless Networking** — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting…
Edit a wireless connection

This topic describes all of the options that are available when you edit a wireless network connection. To edit a connection, click the network menu in the menu bar and select Edit Connections.

Most networks will work fine if
you leave these settings at their defaults, so you probably don't need to change any of them. Many of the options here are provided to give you greater control over more advanced networks.

Available to all users / Connect automatically

Connect automatically
Check this option if you would like the computer to try to connect to this wireless network whenever it is in range.

If several networks which are set to connect automatically are in range, the computer will connect to the first one shown in the Wireless tab in the Network Connections window. It won't disconnect from one
available network to connect to a different one that has just come in range.

Available to all users

Check this if you would like all of the users on the computer to have access to this wireless network. If the network has a **WEP/WPA password** and you have checked this option, you will only need to enter the
password once. All of the other users on your computer will be able to connect to the network without having to know the password themselves.

If this is checked, you need to be an administrator to change any of the settings for this network. You may be asked to enter your admin password.
SSID

This is the name of the wireless network you are connecting to, otherwise known as the Service Set Identifier. Don't change this unless you have changed the name of the wireless network (for example, by changing the settings of your wireless
router or base station).

Mode

Use this to specify whether you are connecting to an Infrastructure network (one where computers wirelessly connect to a central base station or router) or an Ad-hoc network (where there is no base station, and the computers in the network
connect to one another). Most networks are infrastructure ones; you may wish to set-up your own ad-hoc network though.

If you choose Ad-hoc, you will see two other options, Band and Channel. These determine which wireless frequency band the ad-hoc wireless network will operate on. Some computers are only
able to work on certain bands (for example, only \texttt{A} or only \texttt{B/G}), so you might want to pick a band that all of the computers in the ad-hoc network can use. In busy places, there might be several wireless networks sharing the same channel; this might slow-down your connection, so you can change which channel you are using too.
This is the *Basic Service Set Identifier*. The SSID (see above) is the name of the network which humans are intended to read; the BSSID is a name which the computer understands (it's a string of letters and numbers that is supposed to be unique to the wireless network). If a network is hidden, it will not have an
SSID but it will have a BSSID.

Device MAC address

A **MAC address** is a code which identifies a piece of network hardware (for example, a wireless card, an Ethernet network card or a router). Every device that you can connect to a network has a unique MAC address which was given to it in the factory.
This option can be used to change the MAC address of your network card.

Cloned MAC address

Your network hardware (wireless card) can pretend to have a different MAC address. This is useful if you have a device or service which will only communicate with a certain MAC address.
(for example, a cable broadband modem). If you put that MAC address into the cloned MAC address box, the device/service will think that your computer has the cloned MAC address rather than its real one.

**MTU**

This setting changes the *Maximum Transmission Unit*,
which is the maximum size of a chunk of data that can be sent over the network. When files are sent over a network, data is broken up into small chunks (or packets). The optimal MTU for your network will depend on how likely it is for packets to be lost (due to a noisy connection) and how fast the connection is. In general, you should not need
to change this setting.

See Also

Connect to a hidden wireless network — Click the network menu on the menu bar and select Connect to Hidden Wireless Network.

Wireless Security

Security

This defines what sort of encryption your wireless
network uses. Encrypted connections help protect your wireless connection from being intercepted, so other people can't "listen in" and see what websites you're visiting and so on.

Some types of encryption are stronger than others, but may not be supported by older wireless networking equipment. You'll normally
need to type a password for the connection; more sophisticated types of security may also require a username and a digital "certificate". See What do WEP and WPA mean? for more information on popular types of wireless encryption.

IPv4 Settings
Use this tab to define information like the IP address of your computer and which DNS servers it should use. Change the Method to see different ways of getting/setting that information.

The following methods are available:

Automatic (DHCP)

Get information like the IP address and DNS server to use from a DHCP server. A
DHCP server is a computer (or other device, like a router) connected to the network which decides which network settings your computer should have - when you first connect to the network, you will automatically be assigned the correct settings. Most networks use DHCP.

Automatic (DHCP) addresses only
If you choose this setting, your computer will get its IP address from a DHCP server, but you will have to manually define other details (like which DNS server to use).

Manual

Choose this option if you would like to define all of the network settings yourself, including which IP address the
computer should use.

Link-Local Only

*Link-Local* is a way of connecting computers together on a network without requiring a DHCP server or manually defining IP addresses and other information. If you connect to a Link-Local network, the computers on the network will
decide amongst themselves which IP addresses to use and so on. This is useful if you want to temporarily connect a few computers together so they communicate with each other.

Disabled

This option will disable the network connection and prevent you from connecting
to it. Note that IPv4 and IPv6 are treated as separate connections even though they are for the same network card. If you have one enabled, you may wish to set the other to disabled.

IPv6 Settings

This is similar to the IPv4 tab except it deals with the newer IPv6
standard. Very modern networks use IPv6, but IPv4 is still more popular at the moment.

More Information

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting…
I can't see my wireless network in the list

There are a number of reasons why you might not be able to see your wireless network on the list of networks which appears when you click the network icon on the menu.
bar.

- If no networks are shown in the list, your wireless hardware could be turned off, or it may not be working properly. Make sure it is turned on.

- If there are lots of wireless networks nearby, the network you are looking for might not be on the first page of the list.
If this is the case, look at the bottom of the list for an arrow pointing towards the right and hover your mouse over it to display the rest of the wireless networks.

- You could be out of range of the network. Try moving closer to the wireless base station/router and see if the network appears in the list after a while.
• The list of wireless networks takes time to update. If you have just turned on your computer or moved to a different location, wait for a minute or so and then check if the network has appeared in the list.

• The network could be hidden. You need to connect in a different way if it is a hidden network.
More Information

Network problems — Troubleshooting wireless connections, finding your wifi network...

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also

Connect to a hidden wireless network — Click the network menu on the menu bar and select Connect to Hidden
Wireless Network.
I've entered the correct password, but I still can't connect.

If you're sure that you entered the correct [wireless password] but you still can't successfully connect to a wireless network, try some of the
Double-check that you have the right password.

Passwords are case-sensitive (it matters whether they have capital or lower-case letters), so check that you didn't get the case of one of the letters wrong.

- Try the hex or ASCII pass key.
The password you enter can also be represented in a different way - as a string of characters in hexadecimal (numbers 0-9 and letters a-f) called a pass key. Each password has an equivalent pass key. If you have access to the pass key as well as the password/passphrase, try typing the pass key instead. Make sure you select the
correct wireless security option when asked for your password (for example, select WEP 40/128-bit Key if you're typing the 40-character pass key for a WEP-encrypted connection).

- Try turning your wireless card off and then on again.

Sometimes wireless cards get stuck or experience a minor
problem that means they won't connect. Try turning the card off and then on again to reset it - see Wireless network troubleshooter for more information.

- Check that you're using the right type of wireless security

When prompted for your wireless security password, you can choose which type of
wireless security to use. Make sure you choose the one that is used by the router or wireless base station. This should be selected by default, but sometimes it will not be for some reason. If you don't know which one it is, use trial and error to go through the different options.

- Check that your wireless card is properly supported
Some wireless cards aren't supported very well. They show up as a wireless connection, but they can't connect to a network because their drivers lack the ability to do this. See if you can get an alternative wireless driver, or if you need to perform some extra set-up (like installing a different firmware). See Wireless network
troubleshooter for more information.

More Information

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also

Connect to a wireless network — Get on the internet - wirelessly.
Manually set network settings

If your network doesn't automatically assign network settings to your computer, you may have to manually enter the settings yourself. This topic assumes that you already know the correct settings to use. If not, you may
need to ask your network administrator or look at the settings of your router or network switch.

To manually set your network settings:

1. Click the network menu on the menu bar and click Edit Connections.

2. Select the network connection that you want to set up manually. For
example, if you plug in to
the network with a cable,
look at the **Wired** tab.

3. Click the connection you
want to edit to select it, then
click **Edit**.

4. Go to the **IPv4 Settings** tab
and change the **Method** to
**Manual**.

5. Click **Add** and type the **IP**
address, network mask and default gateway IP address into the corresponding columns of the Addresses list. Press Enter or Tab after typing each address.

These three addresses must be IP addresses; that is, they must be four numbers separated by periods (e.g., 123.45.6.78).
6. Type the IP addresses of the DNS servers you want to use, separated by commas.

7. Click Save. If you are not connected to the network, click the network icon on the menu bar and connect. Test the network settings by trying to visit a website or look at shared files on the network, for example.
More Information

Wired Networking — Wired internet connections, Fixed IP addresses...

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...
Turn off wireless (airplane mode)

If you have your computer on an airplane (or some other area where wireless connections are not allowed), you should switch off your wireless. You may also want to switch off your wireless for other reasons (to save battery power, for
example). To do this:

To do this, click the network menu on the menu bar and uncheck Enable Wireless. This will turn off your wireless connection until you switch it back on again.

To turn wireless back on, click the network menu on the menu bar and select Enable Wireless so that it has a checkmark in front of it.
Your laptop may still be broadcasting if you have not turned off Bluetooth.

More Information

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also

Turn Bluetooth on or off —
Enable or disable the Bluetooth device on your computer.
What do WEP and WPA mean?

WEP and WPA (along with WPA2) are names for different encryption tools used to secure your wireless connection. Encryption scrambles the network connection so that no one can "listen in" to it and look at which web pages you are viewing,
for example. WEP stands for *Wired Equivalent Privacy*, and WPA stands for *Wireless Protected Access*. WPA2 is the second version of the WPA standard.

Using *some* encryption is always better than using none, but WEP is the least secure of these standards, and you should not use it if you can avoid it. WPA2 is the most secure of the three. If your wireless card and router support WPA2, that is
what you should use when setting up your wireless network.

More Information

**Wireless Networking** — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...
Why does my wireless network keep disconnecting?

You may find that you have been disconnected from a wireless network even though you wanted to stay connected. Your computer will normally try to reconnect to the
network as soon as this happens (the network icon on the menu bar will pulse if it is trying to reconnect), but it can be annoying, especially if you were using the internet at the time.

**Weak wireless signal**

A common reason for being disconnected from a wireless network is that you have low signal.
Wireless networks have a limited range, so if you are too far away from the wireless base station you may not be able to get a strong enough signal to maintain a connection. Walls and other objects between you and the base station can also weaken the signal.

The network icon on the menu bar displays how strong your wireless signal is. If the signal looks low, try moving closer to the wireless base station.
Network connection not being established properly

Sometimes, when you connect to a wireless network, it may appear that you have successfully connected at first, but then you will be disconnected soon after. This normally happens because your...
computer was only partially successful in connecting to the network - it managed to establish a connection, but was unable to finalize the connection for some reason and so was disconnected.

A possible reason for this is that you entered the wrong wireless passphrase, or that your computer was not allowed on the network (because the network requires a username to log in, for example).
Some wireless network hardware can be a little unreliable. Wireless networks are complicated, so wireless cards and base stations occasionally run into minor problems and may drop connections. This is annoying, but it happens quite regularly with many devices. If you are disconnected from wireless connections from time
to time, this may be the only reason. If it happens very regularly, you may want to consider getting some different hardware.

Busy wireless networks

Wireless networks in busy places (in universities and coffee shops, for example) often have many computers trying to connect to them at once. Sometimes these networks
get too busy and may not be able to handle all of the computers that are trying to connect, so some of them get disconnected.

More Information

Network problems — Troubleshooting wireless connections, finding your wifi network...

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings,
Disconnecting...

See Also

Connect to a wireless network — Get on the internet - wirelessly.
This is a step-by-step troubleshooting guide to help you identify and fix wireless problems. If you cannot connect to a wireless network for some reason, try following the instructions here.
We will proceed through the following steps to get your computer connected to the internet:

- Performing an initial check
- Gathering information about your hardware
- Checking your hardware
- Attempting to create a connection to your wireless router
Performing a check of your modem and router

To get started, click on the Next link at the top right of the page. This link, and others like it on following pages, will take you through each step in the guide.

Using the command line

Some of the instructions in this guide ask you to type
commands into the command line (Terminal). You can find the Terminal application in the Dash.

If you are not familiar with using a command line, don't worry - this guide will direct you at each step. All you need to remember is that commands are case-sensitive (so you must type them exactly as they appear here), and to press
Enter after typing each command to run it.

More Information

Hardware problems

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...

See Also
Connect to a wireless network —
Get on the internet - wirelessly.
Wireless network troubleshooter

Perform an initial connection check

In this step you will check some basic information about your
wireless network connection. This is to make sure that your networking problem isn't caused by a relatively simple issue, like the wireless connection being turned off, and to prepare for the next few troubleshooting steps.

1. Make sure that your laptop is not connected to a wired internet connection.
2. If you have an external wireless adapter (such as a USB adapter, or a PCMCIA card that plugs into your laptop), make sure that it is firmly inserted into the proper slot on your computer.

3. If your wireless card is inside your computer, make sure that the wireless switch is turned on (if it has one).
Laptops often have wireless switches that you can toggle by pressing a combination of keyboard keys.

4. Click the network menu on the menu bar and make sure that the Enable Wireless setting is checked.

5. Open the Terminal, type `nm-tool` and press
Enter .

This will display information about your network hardware and connection status. Look down the list of information and see if there is a section related to the wireless network adapter. The information for each network device is separated by a row of dashes. If you
find the line State: connected in the section for your wireless adapter, it means that it is working and connected to your wireless router.

If you are connected to your wireless router, but you still cannot access the internet, your router may not be set up correctly, or your Internet Service Provider (ISP)
maybe experiencing some technical problems. Review your router and ISP setup guides to make sure the settings are correct, or contact your ISP for support.

If the information from nm-tool did not indicate that you were connected to the network, click Next to proceed to the next portion of the troubleshooting guide.
More Information

Wireless network troubleshooter
— Identify and fix problems with wireless connections
Wireless network troubleshooter

Gather information about your network hardware

In this step, you will collect
information about your wireless network device. The way you fix many wireless problems depends on the make and model number of the wireless adapter, so you will need to make a note of these details. It can also be helpful to have some of the items that came with your computer too, like device driver installation discs. Look for the following items, if you still have them:
• The packaging and instructions for your wireless devices (especially the user guide for your router)

• The disc containing drivers for your wireless adapter (even if it only contains Windows drivers)

• The manufacturers and model numbers of your computer, wireless adapter and router.
This information can usually be found on the underside/reverse of the device.

- Any version/revision numbers that may be printed on your wireless network devices or their packaging. These can be especially helpful, so look carefully.

- Anything on the driver disc
that identifies either the device itself, its "firmware" version, or the components (chipset) it uses.

If possible, try to get access to an alternative working internet connection so that you can download software and drivers if necessary. (Plugging your computer directly into the router with an Ethernet network cable is one way of providing this, but only plug it in
when you need to.)

Once you have as many of these items as possible, click Next.

More Information

Wireless network troubleshooter — Identify and fix problems with wireless connections
Wireless connection troubleshooter

Check that the wireless adapter was recognized

Even though the wireless adapter is connected to the computer, it may
not have been recognized as a network device by the computer. In this step, you will check whether the device was recognized properly.

1. Open a Terminal window, type `sudo lshw -C network` and press `Enter`. If this gives an error message, you can install the `lshw` program on your computer by typing `sudo apt-get`
install lshw into the terminal.

2. Look through the information that appeared and find the Wireless interface section. If your wireless adapter was detected properly, you should see something similar (but not identical) to this:
3. If a wireless device is listed, continue on to the **Device Drivers** step.

If a wireless device is *not* listed, the next steps you take will depend on the type of device that you use. Refer to the section below
that is relevant to the type of wireless adapter that your computer has (internal PCI, USB, or PCMCIA).

**PCI (internal) wireless adapter**

Internal PCI adapters are the most common, and are found in most laptops made within the past few years. To check if your PCI wireless
1. Open a Terminal, type `lspci` and press Enter.

2. Look through the list of devices that is shown and find any that are marked Network controller or Ethernet controller. Several devices may be marked in this way; the one
corresponding to your wireless adapter might include words like wireless, WLAN, wifi or 802.11. Here is an example of what the entry might look like:

```plaintext
```

3. If you found your wireless adapter in the list, proceed to the **Device Drivers step**. If you didn't find anything
related to your wireless adapter, see the instructions below.

USB wireless adapter

Wireless adapters that plug into a USB port on your computer are less common. They can plug directly into a USB port, or may be connected by a USB cable. 3G/mobile broadband adapters look quite
similar to wireless (wifi) adapters, so if you think you have a USB wireless adapter, double-check that it is not actually a 3G adapter. To check if your USB wireless adapter was recognized:

1. Open a Terminal, type `lsusb` and press Enter.

2. Look through the list of devices that is shown and
find any that seem to refer to a wireless or network device. The one corresponding to your wireless adapter might include words like wireless, WLAN, wifi or 802.11. Here is an example of what the entry might look like:

```
Bus 005 Device 009: ID 12d1:140b Huawei Technologies Co., Ltd. EC1260 Wireless Data Modem HSD USB Card
```

3. If you found your wireless
adapter in the list, proceed to the **Device Drivers** step. If you didn't find anything related to your wireless adapter, see the instructions below.

### Checking for a PCMCIA device

PCMCIA wireless adapters are typically rectangular cards which
slot into the side of your laptop. They are more commonly found in older computers. To check if your PCMCIA adapter was recognized:

1. Start your computer *without* the wireless adapter plugged in.

2. Open a Terminal and type the following, then press Enter:
This will display a list of messages related to your computer's hardware, and will automatically update if anything to do with your hardware changes.

3. Insert your wireless adapter into the PCMCIA slot and see what changes in the Terminal window. The
changes should include some information about your wireless adapter. Look through them and see if you can identify it.

4. To stop the command from running in the Terminal, press Ctrl + C. After you have done that, you can close the Terminal if you like.
5. If you found any information about your wireless adapter, proceed to the **Device Drivers step**. If you didn't find anything related to your wireless adapter, see the instructions below.

**Wireless adapter was not recognized**

If your wireless adapter was not
recognized, it might not be working properly or the correct drivers may not be installed for it.

To get specific help, look at the support options on your distribution's website. These might include mailing lists and web chats where you can ask about your wireless adapter, for example.
More Information

Wireless network troubleshooter
— Identify and fix problems with wireless connections
Wireless network troubleshooter

Make sure that working device drivers are installed

In this step you can check to see if
you can get working device drivers for your wireless adapter. A device driver is a piece of software which tells the computer how to make a hardware device work properly. Even though the wireless adapter has been recognized by the computer, it may not have drivers which work very well. You may be able to find different drivers for the wireless adapter which do work. Try some of the options below:
• Check to see if your wireless adapter is on a list of supported devices

Most Linux distributions keep a list of wireless devices that they have support for. Sometimes, these lists provide extra information on how to get the drivers for certain adapters working properly. Go to the list for your distribution (for example,
Ubuntu, Fedora or openSuSE) and see if your make and model of wireless adapter is listed. You may be able to use some of the information there to get your wireless drivers working.

- Look for additional open or proprietary drivers

Although Ubuntu includes support for a large amount of
devices, some drivers need to be installed separately. Use the Additional Drivers tool to check for these extra open or proprietary drivers.

1. Click the button at the far right side of the menu bar and select System Settings.

2. In the System section,
click Software Sources.

3. Switch to the Additional Drivers tab.

- Use the Windows drivers for your adapter

In general, you cannot use a device driver designed for one operating system (like Windows) on another
operating system (like Linux). This is because they have different ways of handling devices. For wireless adapters, however, you can install a compatibility layer called NDISwrapper which lets you use some Windows wireless drivers on Linux. This is useful because wireless adapters almost always have Windows drivers available for
them, whereas Linux drivers are sometimes not available. You can learn more about how to use NDISwrapper here. Note that not all wireless drivers can be used through NDISwrapper.

Full information on ndiswrapper kept on this page including troubleshooting help specific to ndiswrapper.
More Information

Wireless network troubleshooter — Identify and fix problems with wireless connections
Chat & Social Networking

Instant messaging on Ubuntu
With Empathy you can chat, call and video call with friends and colleagues on a variety of networks

Social networking from the desktop
Post to Twitter, Facebook and other social networking sites directly from your desktop
**Video calls**

What applications can I use to make video calls?

**How can I use Skype on Ubuntu?**

*Skype* is proprietary software and must be installed manually on Ubuntu.

---

**More Information**

Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email
accounts, instant messaging...
Instant messaging on Ubuntu

With the *Empathy* application, you can chat with people online and with friends and colleagues who use Google Talk, AIM, Windows Live and many other chat programs. With a microphone or a webcam you can also have audio or video
calls.

Empathy is installed by default in Ubuntu. Start *Empathy Instant Messaging* from the **Dash**, the **Launcher** or choose Chat from the **Messaging menu**.

You can change your instant messaging status (*Available, Away, Busy, etc.*) from the **Messaging menu**.
For help with using Empathy, read the **Empathy manual**.

---

**More Information**

**Chat & Social Networking** — Chat on any network using *Empathy*, make video calls, install skype, social networking apps

**See Also**

**Video calls** — What applications can I use to make video calls?
Social networking from the desktop

With Ubuntu you can post to your favorite social networking sites from your desktop. Ubuntu uses the *Friends* scope to allow you to organize your social networking
sites in one place, and to post updates from the Me Menu without opening any website.

To set up your social networking accounts:

1. Open the System menu on the right hand side of the menu bar and select "System Settings…".

2. Choose Online accounts
3. Choose the social networking site you want to set up and click Add Account...

4. Click Authorize and insert your account settings for that site, and follow the instructions

You can now view your social networking messages from the
Messaging menu on the right hand side of the menu bar, in the Broadcast section. Click on any of the items in that section to open Friends scope and to read or post messages to your social network.

More Information

Chat & Social Networking — Chat on any network using Empathy, make video calls, install skype, social networking apps
Video calls

You can make video calls from Ubuntu without installing any additional software using Empathy - via the Google Talk, MSN, Jabber, and SIP networks. See the Empathy manual for help on making video calls with Empathy.

Other applications which support video calls include
Chat & Social Networking — Chat on any network using *Empathy*, make video calls, install skype, social networking apps

See Also

How can I use Skype on Ubuntu? — *Skype* is proprietary software and must be installed manually
on Ubuntu

Instant messaging on Ubuntu —
With *Empathy* you can chat, call and video call with friends and colleagues on a variety of networks
How can I use Skype on Ubuntu?

Skype is proprietary software that allows you to make calls over the Internet using your computer. Skype uses decentralized peer-to-peer technologies, so your calls do not go through a central server, but
through distributed servers and other users.

The Skype software is free to use, but it is not free software; the source code is proprietary and not available for modification.

Skype is not installed by default on Ubuntu. Install the skype package to use it.
Additional resources for help with Skype

- How to record Skype conversations
- A list of webcams which are compatible with Skype
- Troubleshooting Skype - for advanced users
More Information

Chat & Social Networking — Chat on any network using *Empathy*, make video calls, install skype, social networking apps

See Also

Video calls — What applications can I use to make video calls?
Connect to mobile broadband

*Mobile Broadband* refers to any kind of high speed Internet connection which is provided by an external device such as a 3G USB stick or mobile phone with built-in HSPA/UMTS/GPRS data connection. Some laptops have
recently been produced with mobile broadband devices already inside them.

Most mobile broadband devices should be recognized automatically when you connect them to your computer. Ubuntu will prompt you to configure the device.

1. The New Mobile Broadband Connection wizard will open
automatically when you connect the device.

2. Click Forward and enter your details, including the country where your Mobile Broadband device was issued, the network provider and type of connection (for example, Contract or pre-pay).

3. Give your connection a
name and click Apply.

4. Your connection is now ready to use. To connect, click the network menu in the menu bar and select your new connection.

5. To disconnect, click the network menu in the menu bar and click Disconnect.

If you are not prompted to configure
the device when you connect it, it may still be recognized by Ubuntu. In such cases you can add the connection manually.

1. Click the **network menu** in the menu bar and select **Edit Connections**…

2. Switch to the **Mobile Broadband tab**.

3. Click **Add**.
4. This should open the **New Mobile Broadband Connection wizard**. Enter your details as described above.

---

**More Information**

**Networking, web, email & chat** — Wireless, wired, connection problems, web browsing, email accounts, instant messaging…
Contacts

Use *Contacts* to store, access or edit information for your contacts, locally or in your Online Accounts.

**Starting Contacts for the first time**

Store your contacts in a local address book or in an online account.

**Add or remove a contact**

Add or remove a contact in the
local address book.

**Connect with your contact**
Email, chat with, or phone a contact.

**Edit contact details**
Edit the information for each contact.

**Link and unlink contacts**
Combine information for a contact from multiple sources.

**Search for a contact**
Search for a contact.
More Information

Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging...
Starting Contacts for the first time

When you run Contacts for the first time, the Contacts Setup window opens.

If you have online accounts configured, they are listed with Local Address Book. Select an item
from the list and click Select.

Click the Online Account Settings to edit existing account settings.

If you have no online accounts configured, click Online Accounts to begin the setup. If you don't wish to set up online accounts at this time, click Local Address Book.
More Information

Contacts — Access your contacts.
Add or remove a contact

To add a contact:

1. Press New.

2. In the New contact window, enter the contact name and the desired information.

Click on the menu next to
each field to choose Work, Home or Other.

3. Press Create Contact.

To remove a contact:

1. Select the contact from your contact list.

2. Press Edit in the top-right corner of Contacts.
3. Press Remove Contact.

More Information

Contacts — Access your contacts.
Connect with your contact

To email, chat with, or phone someone in Contacts:

1. Select the contact from your contact list.

2. Press on the Detail that you want to use. For example,
to email your contact, press the email address.

3. The corresponding application will be launched using the contact's details.

More Information

Contacts — Access your contacts.
Edit contact details

Editing contact details helps you keep the information in your address book up to date and complete.

1. Select the contact from your contact list.
2. Press Edit in the top-right corner of Contacts.

3. Edit the contact details.

   To add a detail such as a new phone number or email address, press New Detail and select the field that you want to add.

4. Press Done to finish editing the contact.
In the case of linked contacts, you can edit a profile by clicking on the profile's avatar.

More Information

Contacts — Access your contacts.
Link and unlink contacts

You can combine duplicate contacts from your local address book and online accounts into one Contacts entry. This feature helps you keep your address book organized, with all details about one contact in one
1. Enable *selection mode* by pressing the tick button above the contact list.

2. A checkbox will appear next to each contact. Tick the checkboxes next to the contacts that you want to merge.

3. Press Link to link the
Unlink contacts

You may want to unlink contacts if you accidentally linked contacts which should not be linked.

1. Select the contact you wish to unlink from your list of contact.
2. Press Edit in the top-right corner of Contacts.

3. Press Linked Contacts.

4. Press Remove to unlink the entry from the contact.

5. Press Close once you have finished unlinking the entries.

6. Press Done to finish editing the contact.
More Information

Contacts — Access your contacts.
Search for a contact

You can search for an online contact in one of two ways:

1. In the Activities overview, start typing the name of the contact.

2. Matching contacts will
appear in the overview instead of the usual list of applications.

3. Press **Enter** to select the contact at the top of the list or click the contact that you want to select if they are not at the top.

To search from inside *Contacts*: 
1. Click inside the search field.

2. Start typing the name of the contact.

More Information

Contacts — Access your contacts.
Email & email software

Change which mail application is used to write emails
Change the default email client by going to Details in the System Settings.

Do I need to scan my emails for viruses?
Viruses are unlikely to infect your computer, but could infect the computers of people you email.
More Information

Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging…
Change which mail application is used to write emails

When you click a button or link to send a new email (for example, in your word processing application), your default mail application will open up with a blank message,
ready for you to write. If you have more than one mail application installed, however, the wrong mail application might open up. You can fix this by changing which one is the default email application:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Details and choose
Default Applications from the list on the left side of the window.

3. Choose which email client you would like to be used by default by changing the Mail option.

More Information

Email & email software — Default email apps
Do I need to scan my emails for viruses?

Viruses are programs that cause problems if they manage to find their way onto your computer. A common way of them getting onto your computer is through email messages.
Viruses that can affect computers running Linux are quite rare, so you are unlikely to get a virus through email or otherwise. If you receive an email with a virus hidden in it, it will probably have no effect on your computer. As such, you probably don't need to scan your email for viruses.

You may, however, wish to scan your email for viruses in case you happen to forward a virus from one
person to another. For example, if one of your friends has a Windows computer with a virus and sends you a virus-infected email, and you then forward that email to another friend with a Windows computer, then the second friend might get the virus too. You could install an anti-virus application to scan your emails to prevent this, but it's unlikely to happen and most people using Windows and Mac OS have anti-
virus software of their own anyway.

More Information

Email & email software — Default email apps

Keeping safe on the internet — Antivirus software, basic firewalls...

See Also

Do I need anti-virus software? — There are few Linux viruses, so you probably don't need anti-virus software.
Keeping safe on the internet

Commonly-used network ports
You need to specify the right network port to enable/disable network access for a program with your firewall.

Do I need anti-virus software?
There are few Linux viruses, so you probably don't need anti-virus software.
Do I need to scan my emails for viruses?

Viruses are unlikely to infect your computer, but could infect the computers of people you email.

Enable or block firewall access

You can control which programs can access the network. This helps to keep your computer secure.

More Information

Networking, web, email & chat —
Wireless, wired, connection problems, web browsing, email accounts, instant messaging…
Commonly-used network ports

This is a list of network ports commonly used by applications that provide network services, like file sharing or remote desktop viewing. You can change your system's firewall to block or allow access to these applications. There are
thousands of ports in use, so this table isn't complete.

<table>
<thead>
<tr>
<th>Port</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5353/udp</td>
<td>mDNS, Avahi</td>
<td>Allows systems to find each other, and describe which</td>
</tr>
</tbody>
</table>
services they offer, without you having to specify the details manually.

631/udp Printing Allows you to send print jobs to a printer
<table>
<thead>
<tr>
<th>Port</th>
<th>Service</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>631/tcp</td>
<td>Printing</td>
<td>Allows you to share your printer with other people over the network.</td>
</tr>
<tr>
<td>5298/tcp</td>
<td>Presence</td>
<td>Allows you to advertise your presence.</td>
</tr>
</tbody>
</table>
your instant messaging status to other people on the network, such as "online" or "busy".

| 5900/tcp | Remote desktop | Allows you to share |
your desktop so other people can view it or provide remote assistance.

3689/tcp Music sharing (DAAP) Allows you to share your music
More Information

Keeping safe on the internet — Antivirus software, basic firewalls...

See Also

Enable or block firewall access —
You can control which programs can access the network. This helps to keep your computer secure.
Do I need anti-virus software?

If you are used to Windows or Mac OS, you are probably also used to having anti-virus software running all of the time. Anti-virus software runs in the background, constantly checking for computer viruses that might find their way onto your computer and cause problems.
Anti-virus software does exist for Linux, but you probably don't need to use it. Viruses that affect Linux are still very rare. Some argue that this is because Linux is not as widely used as other operating systems, so no-one writes viruses for it. Others argue that Linux is intrinsically more secure, and security problems that viruses could make use of are fixed very quickly.

Whatever the reason, Linux viruses
are so rare that you don't really need to worry about them at the moment.

If you want to be extra-safe, or if you want to check for viruses in files that you are passing between yourself and people using Windows and Mac OS, you can still install anti-virus software. Check in the Ubuntu Software Center where a number of applications are available.
More Information

Keeping safe on the internet — Antivirus software, basic firewalls…

See Also

Do I need to scan my emails for viruses? — Viruses are unlikely to infect your computer, but could infect the computers of people you email.
Enable or block firewall access

Ubuntu comes equipped with the *Uncomplicated Firewall (ufw)* but the firewall is not enabled by default. Because Ubuntu does not have any open network services (except for basic network infrastructure) in the default installation, a firewall is not needed to block incoming attempted
malicious connections.

For more information about how to use ufw, see the online documentation.

Turn the firewall on or off

To turn on the firewall, enter `sudo ufw enable` in a terminal. To turn off ufw, enter `sudo ufw disable`. 
Allow or block specific network activity

Many programs are built to offer network services. For instance, you can share content, or let someone view your desktop remotely. Depending on which additional programs you install, you may need to adjust the firewall to allow these services to work as intended. UfW comes with a number of rules already pre-configured. For
instance, to allow SSH connections, enter `sudo ufw allow ssh` in a terminal. To block ssh, enter `sudo ufw block ssh`.

Each program that provides services uses a specific *network port*. To enable access to that program's services, you may need to allow access to its assigned port on the firewall. To allow connections on port 53, enter `sudo ufw allow`
To block port 53, enter `sudo ufw block 53` in a terminal.

To check the current status of ufw, enter `sudo ufw status` in a terminal.

Use `ufw` without a terminal

You can also install `gufw` if you prefer to set up the firewall without
using a terminal. To install, click this link.

You can launch this program by searching for **Firewall Configuration** in the Dash. The program does not need to be kept open for the firewall to work.

---

**More Information**

Keeping safe on the internet — Antivirus software, basic
firewalls…

See Also

Commonly-used network ports — You need to specify the right network port to enable/disable network access for a program with your firewall.
Network problems

I can't see my wireless network in the list
The wireless could be turned off or broken, there might be too many wireless networks nearby, or you might be out of range.

I have no wireless network when I wake up my computer
Some wireless devices have problems handling when your computer is suspended and
My computer connects to the wrong network
Edit your connection settings, and remove the unwanted connection option.

Other users can't connect to the internet
You can save settings (like the password) for a network connection so that everyone who uses the computer will be able to connect to it.

Other users can't edit the network connections
You need to uncheck the Available to all users option in the network connection settings.

The internet seems slow
Other things might be downloading, you could have a poor connection, or it could be a busy time of day.

There's no network menu in the menu bar
Press `Alt` + `F2`. Type `nm-applet`

Why does my wireless network keep disconnecting?
You might have low signal, or the
You might have low signal, or the network might not be letting you connect properly.

More Information

Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging...

See Also

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...
I have no wireless network when I wake up my computer.

If you have suspended your computer, or it has hibernated, you may find that your wireless internet connection does not work when you
resume it again. This happens when the driver for the wireless device does not fully support certain power saving features. Typically, the wireless connection fails to turn on properly when the computer is resumed.

If this happens, try switching your wireless off and then back on again:

1. Click the icon at the very
right of the menu bar and select System Settings

2. Open Network and select the Wireless tab

3. Switch the wireless off and then on again

4. If the wireless still does not work, switch on Airplane Mode and then switch it off again
If this doesn't work, restarting your computer should make the wireless work again.

More Information

**Network problems** — Troubleshooting wireless connections, finding your wifi network...

**Power problems** — Troubleshoot problems with power and batteries.

See Also
Why won't my computer turn back on after I suspended it? — Some computer hardware causes problems with suspend or hibernate.
My computer connects to the wrong network

When you turn your computer on or move to a different location, your computer will automatically try to connect to wireless networks that you have connected to in the past. If it tries to connect to the wrong network each time (that is, not the
one that you want it to connect to), do the following:

1. Click the network menu on the menu bar and select Edit Connections.

2. Go to the Wireless tab and find the network that you don't want it to keep connecting to.

3. Click that network once to
select it and click Delete. Your computer won't try to connect to that network any more.

If you later want to connect to the network you just deleted, simply select it from the list of wireless networks that appears when you click the network menu on the menu bar - just as you would connect to any other wireless network.
More Information

Network problems — Troubleshooting wireless connections, finding your wifi network...
Other users can't connect to the internet

If you have set up a network connection but other users on your computer can't connect to it, they probably aren't entering the right settings when they try to connect. For example, if you have a wireless connection, they may not be
You can make it so that everyone can share the settings for a network connection once you have set it up. This means that you only need to set it up once, and everyone else on the computer will be able to connect to it without being asked any questions. To do this:
1. Click the network menu on the menu bar and click Edit Connections.

2. Find the connection you want everyone to be able to use. You will probably need to switch to the Wireless tab. Select the network name and then click Edit.

3. Check Available to all users
and click Save. You will have to enter your admin password to save the changes. Only admin users can do this.

4. Other users of the computer will now be able to use this connection without entering any further details.
More Information

Network problems — Troubleshooting wireless connections, finding your wifi network...

See Also

Other users can't edit the network connections — You need to uncheck the Available to all users option in the network connection settings.
Other users can't edit the network connections

If you can edit a network connection but other users on your computer can't, you may have set the connection to be available to all users. This makes it so that
everyone on the computer can connect using that connection, but only users with administrative rights are allowed to change its settings.

The reason for this is that, since everyone is affected if the settings are changed, only highly-trusted (admin) users should be allowed to modify the connection.

If other users really need to be able to change the connection
themselves, make it so the connection is not set to be available to everyone on the computer. This way, everyone will be able to manage their own connection settings rather than relying on one set of shared, system-wide settings for the connection.

Make it so that the connection isn't shared any more
1. Click the network menu on the menu bar and click Edit Connections.

2. Find the connection you want everyone to be able to manage/edit themselves. Click to select it and then click Edit.

3. You will have to enter your admin password to change
the connection. Only admin users can do this.

4. Uncheck Available to all users and click Save. Other users of the computer will now be able to manage the connection themselves.

More Information

Network problems — Troubleshooting wireless
connections, finding your wifi network...

**See Also**

*How do administrative privileges work?* — You need admin privileges to change important parts of your system.

*Other users can't connect to the internet* — You can save settings (like the password) for a network connection so that everyone who uses the computer will be able to connect to it.
The internet seems slow

If you are using the internet and it seems slow, there are a number of things that could be causing the slow down.

Try closing your web browser and then re-opening it, and disconnecting from the internet and then reconnecting again. (Doing this
resets a lot of things that might be causing the internet to run slowly.)

- **Busy time of day**

  Internet service providers commonly setup internet connections so that they are shared between several households. Even though you connect separately, through your own phone line or cable connection, the connection to
the rest of the internet at the telephone exchange might actually be shared. If this is the case and lots of your neighbors are using the internet at the same time as you, you might notice a slowdown. You're most likely to experience this at times when your neighbors are probably on the internet (in the evenings, for example).
• **Downloading lots of things at once**

If you or someone else using your internet connection are downloading several files at once, or watching videos, the internet connection might not be fast enough to keep up with the demand. In this case, it will feel slower.

• **Unreliable connection**
Some internet connections are just unreliable, especially temporary ones or those in high demand areas. If you are in a busy coffee shop or a conference center, the internet connection might be too busy or simply unreliable.

- **Low wireless connection signal**

If you're connected to the
internet by wireless (wifi), check the network menu on the menu bar to see if you have good wireless signal. If not, the internet may be slow because you don't have a very strong signal.

- Using a slower mobile internet connection

If you have a mobile internet connection and notice that it is
slow, you may have moved into an area where signal reception is poor. When this happens, the internet connection will automatically switch from a fast "mobile broadband" connection like 3G to a more reliable, but slower, connection like GPRS.

- Web browser has a problem

Sometimes web browsers
encounter a problem that makes them run slow. This could be for any number of reasons - you could have visited a website that the browser struggled to load, or you might have had the browser open for a long time, for example. Try closing all of the browser's windows and then opening the browser again to see if this makes a
More Information

Network problems — Troubleshooting wireless connections, finding your wifi network...
There's no network menu in the menu bar

If the network menu has disappeared from the menu bar, your *Network Manager* may not be running. To start it up again:

1. Press **Alt** + **F2**
2. Type `nm-applet` and press Enter.

3. The Wireless Network Authentication box may pop up. Enter your password in the appropriate box and click Connect.

If this doesn't work, there could be a problem with the Network Manager. To see if this is the case, go to the Dash and open the Terminal. Type
nm-applet and press Enter and see if the network menu appears. If it doesn't, you should see some error messages appear in the Terminal. These should tell you what is going wrong, but they may be quite technical in nature. If so, ask for help on a support forum and quote these error messages.
Network problems —
Troubleshooting wireless connections, finding your wifi network…
Networking terms & tips
Define proxy settings
A proxy filters websites that you look at, usually for control or security purposes.

Find your IP address
Knowing your IP address can help you troubleshoot network problems.

Staying safe on the internet
General tips to keep in mind when using the internet
What is a MAC address?
The unique identifier assigned to network hardware.

What is an IP address?
An IP Address is like a phone number for your computer.

More Information
Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging…
See Also

Wireless Networking — Connect to wifi, Hidden networks, Edit connection settings, Disconnecting...
Define proxy settings

What is a proxy?

A web proxy filters websites that you look at, it receipts requests from your web browser to fetches the web pages and their elements, and following a policy will decide to pass them you back. They are
commonly used in businesses and at public wireless hotspots to control what websites you can look at, prevent you from accessing the internet without logging in, or to do security checks on websites.

Change proxy method

1. Click the icon at the very right of the menu bar and
select System Settings.

2. Open Network and choose Network Proxy from the list on the left side of the window.

3. Choose which proxy method you want to use among the following methods.

None
The applications will use a direct connection to fetch the content on the web.

Manual

For each proxied protocol, define the address of a proxy and port for the protocols. The protocols are HTTP, HTTPS, FTP and
SOCKS.

Automatic

An URL points to a resource, which contains the appropriate configuration for your system.

The proxy settings will be applied to applications that use network connection to use the chosen
configuration.

More Information

Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies...
Find your IP address

Knowing your IP address can help you troubleshoot problems with your internet connection. You may be surprised to learn that you have two IP addresses: an IP address for your computer on the internal network and an IP address for your computer on the internet.
Find your internal (network) IP address

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Network and select Wired or Wireless from the list on the left, depending on which network connection you want to find the IP address for.
3. Your internal IP address will be displayed in the list of information.

Find your external (internet) IP address

1. Visit
   whatismyipaddress.com.

2. The site will display your external IP address for you.
Depending on how your computer connects to the internet, these addresses may be the same.

More Information

Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies…

See Also

Create a connection with a fixed IP address — Using a static IP address can make it easier to
provide some network services from your computer.

What is an IP address? — An IP Address is like a phone number for your computer.
Staying safe on the internet

A possible reason for why you are using Ubuntu is the robust security that Linux based systems are known for. One reason that Linux is relatively safe from malware and viruses is due to the lower number of people who use it. Viruses are targeted at popular operating
systems like Windows, that have an extremely large user base. Linux based systems are also very secure due to their open source nature, which allows experts to modify and enhance the security features included with each distribution.

Despite the measures taken to ensure that your installation of Ubuntu is secure, there are always vulnerabilities. As an average user on the internet you can still be
susceptible to:

- Phishing Scams (websites and emails that try to obtain sensitive information through deception)
- Forwarding malicious emails
- Applications with malicious intent (viruses)
- Unauthorized remote/local network access
To stay safe online, keep in mind the following tips:

- Be wary of emails, attachments, or links that were sent from people you do not know.

- If a website's offer is too good to be true, or asks for sensitive information that seems unnecessary, then think twice about what
information you are submitting and the potential consequences if that information is compromised by identity thieves or other criminals.

- Be careful in providing any application root level permissions, especially ones that you have not used before or apps that are not well-known. Providing
anyone/anything with root level permissions puts your computer at high risk to exploitation.

- Make sure you are only running necessary remote-access services. Having SSH or VNC running can be useful, but also leaves your computer open to intrusion if not secured properly. Consider using a firewall to help protect
your computer from intrusion.

More Information

Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies...
What is a MAC address?

A MAC address is the unique identifier that is assigned by the manufacturer to a piece of network hardware (like a wireless card or an Ethernet card). MAC stands for Media Access Control, and each identifier is intended to be unique to a particular device.
A MAC address consists of six sets of two characters, each separated by a colon. 00:1B:44:11:3A:B7 is an example of a MAC address.

To identify the MAC address of your own network hardware:

1. Click the network menu on the menu bar.

2. Select Connection
3. Your MAC address will be displayed as the Hardware Address.

In practice, you may need to modify or "spoof" a MAC address. For example, some internet service providers may require that a specific MAC address be used to access their service. If the network card stops working, and you need to
swap a new card in, the service won't work anymore. In such cases, you would need to spoof the MAC address.

More Information

Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies...
What is an IP address?

"IP address" stands for Internet Protocol address, and each device that is connected to a network (like the internet) has one.

An IP address is similar to your phone number. Your phone number is a unique set of numbers that identifies your phone so that other
people can call you. Similarly, an IP address is a unique set of numbers that identifies your computer so that it can send and receive data with other computers.

Currently, most IP addresses consist of four sets of numbers, each separated by a period. 192.168.1.42 is an example of an IP address.
An IP address can either be *dynamic* or *static*. Dynamic IP addresses are temporarily assigned each time your computer connects to a network. Static IP addresses are fixed, and do not change. Dynamic IP addresses are more common than static addresses - static addresses are typically only used when
there is a special need for them, such as administering a server.

More Information

Networking terms & tips — Find your IP address, WEP & WPA security, MAC addresses, proxies...

See Also

Find your IP address — Knowing your IP address can help you
troubleshoot network problems.
Sharing

**Browse files on a server or network share**
View and edit files on another computer over FTP, SSH, Windows shares, or WebDAV.

**Send a file to a Bluetooth device**
Share files to Bluetooth devices such as your phone.

**Share and transfer files**
Transfer files to your email
contacts from the file manager.

**Share your desktop**
Let other people view and interact with your desktop using VNC.

---

**More Information**

*Networking, web, email & chat — Wireless, wired, connection problems, web browsing, email accounts, instant messaging...*
Browse files on a server or network share

You can connect to a server or network share to browse and view files on that server, exactly as if they were on your own computer. This is a convenient way to download or upload files on the internet, or to share files with other
people on your local network.

To browse files over the network, open the *Files* application from the Dash, and click *Browse Network* in the sidebar. The file manager will find any computers on your local area network that advertise their ability to serve files. If you want to connect to a server on the internet, or if you do not see the computer you're looking for, you can manually connect to a server by typing in its
Connect to a file server

1. In the file manager, click Files in the menu bar and pick Connect to Server from the app menu.

2. Enter the address of the server, in the form of a URL. Details on supported URLs are listed below.
If you have connected to the server before, you can click on it in the Recent Servers list.

3. Click **Connect**. A new window will open showing you the files on the server. You can browse the files just as you would for those on your own computer. The
A URL, or uniform resource locator, is a form of address that refers to a location or file on a network. The address is formatted like this:
The scheme specifies the protocol or type of server. The example.com portion of the address is called the domain name. If a username is required, it is inserted before the server name:

scheme://username@servername.example.com/folder

Some schemes require the port number to be specified. Insert it
after the domain name:

```
scheme://servername.example.com:port/folder
```

Below are specific examples for the various server types that are supported.

**Types of servers**

You can connect to different types of servers. Some servers are public, and allow anybody to connect.
Other servers require you to log in with a username and password.

You may not have permissions to perform certain actions on files on a server. For example, on public FTP sites, you will probably not be able to delete files.

The URL you enter depends on the protocol that the server uses to export its file shares.

SSH
If you have a secure shell account on a server, you can connect using this method. Many web hosts provide SSH accounts to members so they can securely upload files. SSH servers always require you to log in.

A typical SSH URL looks like this:

```
ssh://username@servername.example.com/folder
```
When using SSH, all the data you send (including your password) is encrypted so that other users on your network can't see it.

FTP (with login)

FTP is a popular way to exchange files on the Internet. Because data is not encrypted over FTP, many servers now provide access through SSH.
Some servers, however, still allow or require you to use FTP to upload or download files. FTP sites with logins will usually allow you to delete and upload files.

A typical FTP URL looks like this:

```
ftp://username@ftp.example.com/path/
```

Public FTP
Sites that allow you to download files will sometimes provide public or anonymous FTP access. These servers do not require a username and password, and will usually not allow you to delete or upload files.

A typical anonymous FTP URL looks like this:

    ftp://ftp.example.com/path
Some anonymous FTP sites require you to log in with a public username and password, or with a public username using your email address as the password. For these servers, use the FTP (with login) method, and use the credentials specified by the FTP site.

Windows share
Windows computers use a proprietary protocol to share files over a local area network. Computers on a Windows network are sometimes grouped into *domains* for organization and to better control access. If you have the right permissions on the remote computer, you can connect to a Windows share from the file manager.
A typical Windows share URL looks like this:

smb://servername/Share

WebDAV and Secure WebDAV

Based on the HTTP protocol used on the web, WebDAV is sometimes used to share files on a local network and to store files on the internet. If the server you're connecting to supports secure
connections, you should choose this option. Secure WebDAV uses strong SSL encryption, so that other users can't see your password.

A typical WebDAV URL looks like this:

```
http://example.hostname.com/path
```
More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...

Sharing — Desktop sharing, Share files...

See Also

Share and transfer files — Transfer files to your email contacts from the file manager.
Send a file to a Bluetooth device

You can send files to connected Bluetooth devices, such as some mobile phones or other computers. Some types of devices don't allow the transfer of files, or specific types of files. You can send files using the Bluetooth icon on the top bar, or
Before you begin, make sure Bluetooth is enabled on your computer. See **Turn Bluetooth on or off**.

Send files using the Bluetooth icon

1. Click the Bluetooth icon on the top bar and select Send Files to Device.
2. Choose the file you want to send and click Select.

To send more than one file in a folder, hold down **Ctrl** as you select each file.

3. Select the device which you want to send the files to and click **Send**.

The list of devices will show
both devices you are already connected to as well as visible devices within range. If you have not already connected to the selected device, you will be prompted to pair with the device after clicking Send. This will probably require confirmation on the other device.

If there are many devices,
you can limit the list to only specific device types using the Device type drop-down.

4. The owner of the receiving device usually has to press a button to accept the file. Once the owner accepts or declines, the result of the file transfer will be shown on your screen.

Send files from the Bluetooth
settings

1. Click the Bluetooth icon on the top bar and select Bluetooth Settings.

2. Select the device to send files to from the list on the left. The list only shows devices you've already connected to. See Connect your computer to a Bluetooth device.
3. In the device information on the right, click Send Files.

4. Choose the file you want to send and click Select.

To send more than one file in a folder, hold down Ctrl as you select each file.

5. The owner of the receiving device usually has to press
a button to accept the file. Once the owner accepts or declines, the result of the file transfer will be shown on your screen.

More Information

**Bluetooth** — Connect, send files, turn on and off...

**Sharing** — Desktop sharing, Share files...
See Also

Share and transfer files — Transfer files to your email contacts from the file manager.
Share and transfer files

You can share files with your contacts or transfer them to external devices or network shares directly from the file manager.

1. Open the file manager.

2. Locate the file you want to
transfer.

3. Right-click the file and select Send To.

4. The Send To window will appear. Choose where you want to send the file and click Send. See the list of destinations below for more information.
You can send multiple files at once. Select multiple files by holding down Ctrl, then right-click any selected file. You can have the files automatically compressed into a zip or tar archive.

**Destinations**

- To email the file, select Email and enter the recipient's email
address.

- To send the file to an instant messaging contact, select "Instant Message", then select contact from the drop-down list. Your instant messaging application may need to be started for this to work.

- To write the file to a CD or DVD, select "CD/DVD Creator". See Write files to a CD or DVD.
DVD to learn more.

- To transfer the file to a Bluetooth device, select Bluetooth (OBEX Push) and select the device to send the file to. You will only see devices you have already paired with. See Bluetooth for more information.

- To copy a file to an external device like a USB flash drive,
or to upload it to a server you've connected to, select Removable disks and shares, then select the device or server you want to copy the file to.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...

Sharing — Desktop sharing,
Share files...

See Also

Browse files on a server or network share — View and edit files on another computer over FTP, SSH, Windows shares, or WebDAV.

Send a file to a Bluetooth device — Share files to Bluetooth devices such as your phone.
Share your desktop

You can let other people view and control your desktop from another computer with a desktop viewing application. Configure Desktop Sharing to allow others to access your desktop and set the security preferences.
1. In the Dash, open *Desktop Sharing*.

2. To let others view your desktop, select *Allow other users to view your desktop*. This means that other people will be able to attempt to connect to your computer and view what's on your screen.
3. To let others interact with your desktop, select *Allow other users to control your desktop*. This may allow the other person to move your mouse, run applications, and browse files on your computer, depending on the security settings which you are currently using.
It is important that you consider the full extent of what each security option means before changing it.

Confirm access to your machine

If you want to be able to choose whether to allow someone to access your desktop, select **You must confirm each access to this machine**. If you disable this option, you will not be asked...
whether you want to allow someone to connect to your computer.

This option is enabled by default.

Enable password

To require other people to use a password when connecting to your desktop, select Require the user to enter this
password. If you do not use this option, anyone can attempt to view your desktop.

This option is disabled by default, but you should enable it and set a secure password.

Allow access to your desktop over the Internet

If your router supports UPnP
Internet Gateway Device Protocol and it is enabled, you can allow other people who are not on your local network to view your desktop. To allow this, select Automatically configure UPnP router to open and forward ports. Alternatively, you can configure your router manually.
This option is disabled by default.

Show notification area icon

To be able to disconnect someone who is viewing your desktop, you need to enable this option. If you select Always, this icon will be visible regardless of whether
someone is viewing your desktop or not.

If this option is disabled, it is possible for someone to connect to your desktop without your knowledge, depending on the security settings.
Sharing — Desktop sharing, Share files...
Web Browsers

Change which web browser websites are opened in
Change the default web browser by going to Details in the System Settings.

Install the Flash plug-in
You may need to install Flash to be able to view websites like YouTube, which display videos and interactive web pages.
Install the Java browser plug-in
Help your browser work with websites that require Java.

Install the Silverlight plug-in
Some websites use Silverlight to display web pages. The Moonlight plug-in lets you view these pages.

More Information
Networking, web, email & chat — Wireless, wired, connection
problems, web browsing, email accounts, instant messaging...
Change which web browser websites are opened in

When you click a link to a web page in any application, a web browser will automatically open up to that page. If you have more than one browser installed, however, the
To fix this, change the default web browser:

1. Click the icon at the very right of the menu bar and select **System Settings**.

2. Open **Details** and choose **Default Applications** from the list on the left side of
the window.

3. Choose which web browser you would like links to be opened in by changing the Web option.

When you open up a different web browser, it might tell you that it's not the default browser any more. If this happens, click the Cancel button (or similar) so that it doesn't try to set itself as the default browser again.
More Information

Web Browsers — Change the default browser, install Flash, install the java plugin, Silverlight support…
Install the Flash plug-in

*Flash* is a plug-in for your web browser that allows you to watch videos and use interactive web pages on some websites. Some websites won't work without Flash.

If you do not have Flash installed, you will probably see a message telling you so when you visit a
website that needs it. Flash is available as a free (but not open-source) download for most web browsers.

How to install Flash

1. Click **this link** to launch the **Software Center**.

2. Read the information and reviews to make sure you want to install Flash.
3. If you choose to install Flash, click Install from the Software Center window.

4. If you have any web browser windows open, close them and then re-open them. The web browser should detect that Flash is installed when you open it again, and you should now be able to view websites using Flash.
Open-source alternatives to Flash

A handful of free, open-source alternatives to Flash are available. These tend to work better than the Flash plug-in in some ways (for example, by handling sound playback better), but worse in others (for example, by not being able to display some of the more
complicated Flash pages on the web).

You might like to try one of these if you are dissatisfied with the Flash player, or if you would like to use as much open-source software as possible on your computer. Here are a few of the options:

- **Gnash**
- **LightSpark**
More Information

Web Browsers — Change the default browser, install Flash, install the java plugin, Silverlight support…
Install the Java browser plug-in

Some websites use small Java programs, which require a Java plugin to be installed in order to run.

Install the icedtea6-plugin package to view Java programs in your browser.
More Information

**Web Browsers** — Change the default browser, install Flash, install the java plugin, Silverlight support…
Install the Silverlight plug-in

Silverlight is a plug-in for your web browser which allows you to watch videos and use interactive web pages on some websites. Some websites won't work without Silverlight.
If you view a Silverlight-enabled website but don't have the plug-in installed, you will probably see a message telling you so. This message should have instructions telling you how to get the plug-in, but these instructions might not be suitable for your web browser or version of Linux.

If you want to view Silverlight-enabled websites, you should install the *Moonlight* plug-in instead. This
is a free, open-source version of Silverlight which runs on Linux.

Please see the Moonlight website for more information and installation instructions.

More Information

Web Browsers — Change the default browser, install Flash, install the java plugin, Silverlight support…
Wired Networking

Connect to a VPN
VPNs allow you to connect to a local network over the internet. Learn how to set up a VPN connection.

Connect to a wired (Ethernet) network
To set up most wired network connections, all you need to do is plug in a network cable.
Create a connection with a fixed IP address

Using a static IP address can make it easier to provide some network services from your computer.

Manually set network settings

If network settings don't get assigned automatically, you may have to enter them yourself.
Wireless, wired, connection problems, web browsing, email accounts, instant messaging…
Connect to a wired (Ethernet) network

To set up most wired network connections, all you need to do is plug in a network cable. The network icon on the menu bar should pulse for a few seconds and
then will change to a "socket" icon when you are connected.

If this does not happen, you should first of all make sure that your network cable is plugged in. One end of the cable should be plugged into the rectangular Ethernet (network) port on your computer, and the other end should be plugged into a switch, router, network wall socket or similar (depending on the network setup.
You have). Sometimes, a light beside the Ethernet port will indicate that it is plugged in and active.

You can't plug one computer directly into another one with a network cable (at least, not without some extra setting-up). To connect two computers, you should plug them both into a network hub, router or switch.
If you are still not connected, your network may not support automatic setup (DHCP). In this case you'll have to configure it manually.

More Information

Wired Networking — Wired internet connections, Fixed IP addresses…
Create a connection with a fixed IP address

Most networks will automatically assign an IP address and other details to your computer when you connect to the network. These details can change periodically, but
you might want to have a fixed IP address for the computer so you always know what its address is (for example, if it is a file server).

To give your computer a fixed (static) IP address:

1. Click the network menu on the menu bar and select Edit Connections.

2. Select the Wired connection
on the Wired tab or your WiFi network on the Wireless tab and click Edit.

3. Click on the IPv4 Settings tab and change the Method to Manual.

4. If no connection information is listed in the Addresses list, or if you want to set up a new connection, click Add.
5. Enter the *IP Address*, *Netmask*, and *Gateway* information into the appropriate boxes. How you choose these will depend on your network setup; there are specific rules governing which IP addresses and netmasks are valid for a given network.

6. If necessary, enter a *Domain Name Server*
address into the DNS servers box. This is the IP address of a server which looks up domain names; most corporate networks and internet providers have dedicated DNS servers.

7. Click Save. The network connection should now have a fixed IP address.
More Information

**Wired Networking** — Wired internet connections, Fixed IP addresses...

**See Also**

**Find your IP address** — Knowing your IP address can help you troubleshoot network problems.
Sound, video & pictures

Basic sound
Sound problems
Troubleshoot problems like having no sound or having poor sound quality.

Change the sound volume
Set the sound volume for the computer and control the loudness of each application.

Choose or disable the alert sound
Choose the sound to play for messages, set the alert volume, or disable alert sounds.
Use a different microphone
Use an analog or USB microphone and select a default input device.

Use different speakers or headphones
Connect speakers or headphones and select a default audio output device.

More Information
User & system settings — Keyboard, mouse, display, languages, user accounts…
Music and portable audio players

I can't play the songs I bought from an online music store
Support for that file format might not be installed or the songs could be "copy protected".

My new iPod won't work
Brand-new iPods need to be set-up using the iTunes software before you can use them.

Open applications for devices or discs
Automatically run applications for
Automatically run applications for CDs and DVDs, cameras, audio players, and other devices and media.

**Songs don't appear on my iPod when I copy them onto it**

Use a media player to copy the songs and safely remove the iPod afterward.

**Why isn't my audio player recognized when I plug it in?**

Add a `.is_audio_player` file to tell your computer that it's an audio player.
Photos and digital cameras

Media card reader problems
Troubleshoot media card readers

Open applications for devices or discs
Automatically run applications for CDs and DVDs, cameras, audio players, and other devices and media.

Videos and video
cameras
Create fun photos and videos with your webcam
It is like your own personal photo booth.

Open applications for devices or discs
Automatically run applications for CDs and DVDs, cameras, audio players, and other devices and media.

Other people can't play the videos I made
Check that they have the right video codecs installed.
Why won't DVDs play?
You might not have the right codecs installed, or the DVD might be the wrong region.

How do I enable restricted codecs to play DVDs?
Most commercial DVDs are encrypted and will not play without decryption software.

More Information
Ubuntu Desktop Guide
There are a number of ways for sound playback to break on your computer. Which of the topics below best describes the problem you are experiencing?

I can't hear any sounds on the computer

Check that it's not muted, that
cables are plugged in properly, and that the sound card is detected.

I hear crackling or buzzing when sounds are playing
Check your audio cables and sound card drivers.

More Information
Hardware problems
Basic sound — Volume, speakers and headphones, microphones...
I can't hear any sounds on the computer

If you can't hear any sounds on your computer, for example when you try to play music, try these troubleshooting steps to see if you can fix the problem.
Make sure that the sound is not muted

Click the sound menu on the menu bar (it looks like a speaker) and make sure that the sound is not muted or turned down.

Some laptops have mute switches or keys on their keyboards—try pressing that key to see if it unmutes the sound.

You should also check that you
haven't muted the application that you're using to play sound (e.g. your music player or movie player). The application may have a mute or volume button in its main window, so check that. Also, click the sound menu on the menu bar and choose Sound Settings. When the Sound window appears, go to the Applications tab and check that your application is not muted.
Check that the speakers are turned on and connected properly.

If your computer has external speakers, make sure that they are turned on and that the volume is turned up. Make sure that the speaker cable is securely plugged into the "output" audio socket on the back of the computer. This socket is usually light green in color.
Some sound cards are able to switch which socket they use for output (to the speakers) and input (from a microphone, for instance). The output socket may be different when running Linux than on Windows or Mac OS. Try connecting the speaker cable to the different audio sockets on the computer in turn to see if that works.

A final thing to check is that the
Check that the right sound device is selected

Some computers have multiple "sound devices" installed. Some of these are capable of outputting
sound and some are not, so you should check that you have the correct one selected. This might involve some trial-and-error to choose the right one.

1. Click the sound menu in the menu bar and click Sound Settings.

2. In the Sound window that appears, try selecting a
different output from the Play sound through list.

3. For the selected device, click Test Sound. In the pop-up window, click the button for each speaker. Each button will speak its position only to the channel corresponding to that speaker.

4. If that doesn't work, you
might want to try doing the same for any other devices that are listed.

Check that the sound card was detected properly

Your sound card may not have been detected properly. If this has happened, your computer will think that it isn't able to play sound. A
possible reason for the card not being detected properly is that the drivers for the card are not installed.

1. Go to the **Dash** and open the Terminal.

2. Type `aplay -l` and press **Enter**.

3. A list of devices will be shown. If there are no
playback hardware devices, your sound card has not been detected.

If your sound card is not detected, you may need to manually install the drivers for it. How you do this will depend on the card you have.

You can see what sound card you have by using the `lspci` command in the Terminal. You can get more complete results if you run `lspci`
as superuser; enter `sudo lspci` and type your password. See if an audio controller or audio device is listed—it should have the sound card's make and model number. `sudo lspci -v` will show a list with more detailed information.

You may be able to find and install drivers for your card by searching the Internet. Otherwise, you can file a bug.
If you can't get drivers for your sound card, you might prefer to buy a new sound card. You can get sound cards that can be installed inside the computer and external USB sound cards.

More Information

Sound problems — Troubleshoot problems like having no sound or having poor sound quality.
I hear crackling or buzzing when sounds are playing

If you hear crackling or buzzing when sounds are playing on your computer, you may have a problem with the audio cables or connectors, or a problem with the drivers for the
Check that the speakers are plugged in correctly.

If the speakers aren't fully plugged in, or if they are plugged into the wrong socket, you might hear a buzzing sound.

Make sure the speaker/headphone cable isn't
Audio cables and connectors can gradually wear with use. Try plugging the cable or headphones into another audio device (like an MP3 player or a CD player) to check if there is still a crackling sound. If there is, you may need to replace the cable or headphones.
• Check if the sound drivers aren't very good.

Some sound cards don't work very well on Linux because they don't have very good drivers. This problem is more difficult to identify. Try searching for the make and model of your sound card on the internet, plus the search term "Ubuntu", to see if other people are having the same
problem.

You can run `sudo lspci -v` in the *Terminal* to get more information about your sound card.

---

**More Information**

**Sound problems** — Troubleshoot problems like having no sound or having poor sound quality.
Change the sound volume

To change the sound volume, click the sound menu on the menu bar and move the volume slider left or right. You can completely turn off sound by checking Mute.

Some keyboards have keys that let you control the volume. They normally look like stylized speakers.
with waves coming out of them. They are often near the "F" keys at the top. On laptop keyboards, they are usually on the "F" keys. Hold down the \texttt{Fn} key on your keyboard to use them.

Of course, if you have external speakers, you can also change the volume using the volume control on the speakers themselves. Some headphones have a volume control too.
Changing the sound volume for individual applications

You can change the volume for one application, but leave the volume for others unchanged. This is useful if you're listening to music and browsing the web, for example. You might want to turn off the volume in the web browser so sounds from websites don't interrupt the music.
Some applications have volume controls in their main windows. If your application has one of these, use that to change the volume. Otherwise, click the sound menu on the menu bar and click Sound Settings. Go to the Applications tab and change the volume of the application there.

Only applications that are playing sounds will be listed. If an application is playing sounds but
isn't listed, it might not support the feature that lets you control its volume in this way. In that case, you can't change its volume.

More Information

Basic sound — Volume, speakers and headphones, microphones...
Choose or disable the alert sound

Your computer will play a simple alert sound for certain types of messages and events. You can choose different sound clips for alerts, set the alert volume independently of your system volume, or disable alert sounds.
entirely.

1. Click the sound menu in the menu bar and click Sound Settings.

2. On the Sound Effects tab, select an alert sound. Each sound will play when you click on it so you can hear how it sounds.
Use the volume slider on the Sound Effects tab to set the volume of the alert sound. This won't affect the volume of your music, movies, or other sound files.

To disable alert sounds entirely, just select Mute next to Alert volume.

More Information
Basic sound — Volume, speakers and headphones,
microphones...

See Also

Flash the screen for alert sounds — Enable visual alerts to flash the screen or window when an alert sound is played.
Use a different microphone

You can use an external microphone for chatting with friends, speaking with colleagues at work, making voice recordings, or using other multimedia applications. Even if your computer has a built-in microphone or a webcam with a microphone, a separate microphone
usually provides better audio quality.

If your microphone has a circular plug, just plug it into the appropriate adapter on your computer. Most computers have two adapters: one for microphones and one for speakers. Look for a picture of a microphone next to the adapter. Microphones plugged into the appropriate adapter will usually be used by default. If not, see the instructions below for selecting a
default input device.

If you have a USB microphone, plug it into any USB port on your computer. USB microphones act as separate audio devices, and you may have to specify which microphone to use by default.

**Select a default audio input device**

1. Click the sound menu on the menu bar and select
Sound Settings.

2. On the Input tab, select the device in the list of devices. The input level indicator should respond when you speak.

More Information

Basic sound — Volume, speakers and headphones, microphones...
See Also

Use different speakers or headphones — Connect speakers or headphones and select a default audio output device.
Use different speakers or headphones

You can use external speakers or headphones with your computer. Speakers usually either connect using a circular TRS (tip, ring, sleeve) plug or with USB.

If your speakers or headphones
have a TRS plug, plug it into the appropriate socket on your computer. Most computers have two sockets: one for microphones and one for speakers. Look for a picture of headphones next to the socket. Speakers or headphones plugged into a TRS socket will usually be used by default. If not, see the instructions below for selecting the default device.

Some computers support multi-
channel output for surround sound. This usually uses multiple TRS jacks, which are often color-coded. If you are unsure which plugs go in which sockets, you can test the sound output in the sound settings. Click the sound menu on the menu bar then click Sound Settings. Select your speakers in the list of devices, then click Test Sound. In the pop-up window, click the button for each speaker. Each button will
speak its position only to the channel corresponding to that speaker.

If you have USB speakers or headphones, or analog headphones plugged into a USB sound card, plug them into any USB port. USB speakers act as separate audio devices, and you may have to specify which speakers to use by default.
Select a default audio input device

1. Click the sound menu on the menu bar and select Sound Settings.

2. On the Output tab, select the device in the list of devices.

If you don't see your device on the Output tab, check the Hardware
tab. Select your device and try different profiles.

---

**More Information**

**Basic sound** — Volume, speakers and headphones, microphones...

**See Also**

**Use a different microphone** — Use an analog or USB microphone and select a default input device.
I can't play the songs I bought from an online music store

If you downloaded some music from an online store you may find that it won't play on your computer, especially if you bought it on a Windows or Mac OS X computer
and then copied it over.

This could be because the music is in a format that is not recognized by your computer. To be able to play a song you need to have support for the right audio formats installed - for example, if you want to play MP3 files, you need MP3 support installed. If you don't have support for a given audio format, you should see a message telling you so when you try to play a song. The
message should also provide instructions for how to install support for that format so that you can play it.

If you do have support installed for the song's audio format but still can't play it, the song might be **copy protected** (also known as being **DRM restricted**). DRM is a way of restricting who can play a song and on what devices they can play it. The company that sold the song to
you is in control of this, not you. If a music file has DRM restrictions, you will probably not be able to play it - you generally need special software from the vendor to play DRM restricted files, but this software is often not supported on Linux.

You can learn more about DRM from the Electronic Frontier Foundation.
My new iPod won't work

If you have a new iPod that has never been connected to a computer before, it won't be recognized properly when you connect it to a Linux computer. This is because iPods need to be set up and updated using the iTunes software, which only runs on...
Windows and Mac OS X.

To set up your iPod, install iTunes on a Windows or Mac computer and plug it in. You will be led through a few steps to set it up. If asked for the Volume Format, choose MS-DOS (FAT), Windows or similar. The other format (HFS/Mac) does not work as well with Linux.

Once you have finished setup, the iPod should work normally when you
plug it into a Linux computer.

---

More Information

Music and players

See Also

Why isn't my audio player recognized when I plug it in? — Add a .is_audio_player file to tell your computer that it's an audio player.
Open applications for devices or discs

You can have an application automatically start when you plug in a device or insert a disc or media card. For example, you might want your photo organizer to start when
you plug in a digital camera. You can also turn this off, so that nothing happens when you plug something in.

To decide which applications should start when you plug in various devices:

1. Click the icon at the very right of the menu bar and select System Settings.
2. Select Details ➤ Removable Media.

3. Find your desired device or media type, and then choose an application or action for that media type. See below for a description of the different types of devices and media. Instead of starting an application, you can also set
it so that the device will be shown in the file manager. When that happens, you will be asked what to do, or nothing will happen automatically.

4. The **Software** option is slightly different from the others - if the computer detects that there is software on a disk that you inserted, it can try to
automatically run the software if you like. This is good if you have an application installed on a CD and want it to start when the disc is inserted (for example, a slideshow).

5. If you don't see the device or media type that you want to change in the list (such as Blu-ray discs or E-book readers), click Other Media
to see a more detailed list of devices. Select the type of device or media from the Type drop-down and the application or action from the Action drop-down.

If you don't want any applications to be opened automatically, whatever you plug in, select Never prompt or
Types of devices and media

Audio discs

Choose your favorite music application or CD audio extractor to handle audio CDs. If you use audio DVDs (DVD-
A), select how to open them under Other Media. If you open an audio disc with the file manager, the tracks will appear as WAV files that you can play in any audio player application.

Video discs

Choose your favorite video application to handle video DVDs. Use the Other Media
button to set an application for Blu-ray, HD DVD, video CD (VCD), and super video CD (SVCD). If DVDs or other video discs do not work correctly when you insert them, see Why won't DVDs play?

Blank discs

Use the Other Media button to select a disc-writing
application for blank CDs, blank DVDs, blank Blu-ray discs, and blank HD DVDs.

Cameras and photos

Use the Photos drop-down to choose a photo-management application to run when you plug in your digital camera, or when you insert a media card from a camera, such as a CF, SD, MMC, or MS card. You
can also simply browse your photos using the file manager.

Under Other Media, you can select an application to open Kodak picture CDs, such as those you might have made in a store. These are regular data CDs with JPEG images in a folder called PICTURES.

Music players

Choose an application to
manage the music library on your portable music player, or manage the files yourself using the file manager.

E-book readers

Use the Other Media button to choose an application to manage the books on your e-book reader, or manage the files yourself using the file manager.
Some discs and removable media contain software that is supposed to be run automatically when the media is inserted. Use the Software option to control what to do when media with autorun software is inserted. You will always be prompted for a confirmation before software is run.
Never run software from media you don't trust.

More Information

Music and players
Photos
Removable drives and external disks
Videos
Songs don't appear on my iPod when I copy them onto it.

When you plug an iPod into your computer, it will appear in your music player application and also in the file manager (the *Files*...
application in the Launcher). You must copy songs onto the iPod using the music player - if you copy them across using the file manager, it won't work because the songs won't be put into the right location. iPods have a special location for storing songs that music player applications know how to get to but the file manager does not.

You also need to wait for the songs to finish copying to the iPod before
you unplug it. Before unplugging the iPod, make sure you choose to **safely remove it**. This will make sure that all of the songs have been copied across properly.

A further reason why songs might not be appearing on your iPod is that the music player application you're using does not support converting the songs from one audio format to another. If you copy a song which is saved in an audio
format that is not supported by your iPod (for example, an Ogg Vorbis (.oga) file), the music player will try to convert it to a format that the iPod does understand, such as MP3. If the appropriate conversion software (also called a codec or encoder) is not installed, the music player will not be able to do the conversion and so will not copy the song. Look in the software installer for an appropriate codec.
More Information

Music and players
Why isn't my audio player recognized when I plug it in?

If your audio player (MP3 player etc.) is plugged in to the computer but you can't see it in your music organizer application, it may not...
have been properly recognized as an audio player.

Try unplugging the player and then plugging it in again. If that doesn't help, open the file manager. You should see the player listed under Devices in the sidebar - click it to open the folder for the audio player. Now, click File ▶ New Document ▶ Empty Document, type .is_audio_player and press
Enter (the period and underscores are important, and it should be all lower-case). This file tells your computer to recognize the device as an audio player.

Now, find the audio player in the file manager sidebar and eject it (right-click and click Eject). Unplug it, then plug it back in. This time it should have been recognized as an audio player by your music organizer. If not, try closing the music organizer
and then re-opening it.

These instructions won't work for iPods and some other audio players. They should work if your player is a *USB Mass Storage* device, though; it should say in its manual if it is.

When you look in the audio player folder again, you won't
see the .is_audio_player file. This is because the period in the file's name tells the file manager to hide the file. You can check that it is still there by clicking View ➤ Show Hidden Files.

More Information

Music and players

See Also
My new iPod won't work —
Brand-new iPods need to be set-up using the iTunes software before you can use them.
Media card reader problems

Many computers contain readers for SD (Secure Digital), MMC (MultiMediaCard), SmartMedia, Memory Stick, CompactFlash, and other storage media cards. These should be automatically detected and mounted. Here are some
troubleshooting steps if they are not:

1. Make sure that the card is put in correctly. Many cards look as though they are upside down when correctly inserted. Also make sure that the card is firmly seated in the slot; some cards, especially CompactFlash, require a
small amount of force to insert correctly. (Be careful not to push too hard! If you come up against something solid, do not force it.)

2. Open *Files* by using the Dash. Does the inserted card appear in the *Devices* list in the left sidebar? Sometimes the card appears in this list but is not mounted; click it once to
mount. (If the sidebar is not visible, press F9 or click View ➤ Sidebar ➤ Show Sidebar.)

3. If your card does not show up in the sidebar, click Go ➤ Computer. If your card reader is correctly configured, the reader should come up as a drive when no card is present, and the card itself when the
4. If you see the card reader but not the card, the problem may be with the card itself. Try a different card or check the card on a different reader if possible.

If no cards or drives are available in the Computer folder, it is possible that your card reader does not work.
with Linux due to driver issues. If your card reader is internal (inside the computer instead of sitting outside) this is more likely. The best solution is to directly connect your device (camera, cell phone, etc.) to a USB port on the computer. USB external card readers are also available, and are far better supported by Linux.
More Information

Hardware problems

Photos
Create fun photos and videos with your webcam

With the Cheese application and your webcam, you can take photos and videos, apply fun special effects and share the fun with others.

Cheese is not installed by default in
Ubuntu. To install Cheese:

1. Click this link to launch the Software Center.

2. Read the information and reviews about Cheese to make sure you want to install it.

3. If you choose to install it, click Install from the Software Center window.
You may need to provide the administrative password to complete the installation.

For help with using Cheese, read the Cheese user guide.

⭐ You need to install Cheese before you can read the Cheese user guide.
Other people can't play the videos I made

If you made a video on your Linux computer and sent it to someone using Windows or Mac OS, you may find that they have problems playing the video.

To be able to play your video, the
person you sent it to must have the right **codecs** installed. A codec is a little piece of software that knows how to take the video and display it on the screen. There are lots of different video formats and each requires a different codec to play it back. You can check which format your video is by doing:

- Open the **file manager**.
- Right-click on video file and
select Properties.

- Go to the Audio/Video tab and look at which codec is listed under Video.

Ask the person having problems with playback if they have the right codec installed. They may find it helpful to search the web for the name of the codec plus the name of their video playback application. For example, if your video uses the
Theora format and you have a friend using Windows Media Player to try and watch it, search for "theora windows media player". You will often be able to download the right codec for free if it's not installed.

If you can't find the right codec, try the VLC media player. It works on Windows and Mac OS as well as Linux, and supports a lot of different video formats. Otherwise, try
converting your video into a different format. Most video editors are able to do this, and specific video converter applications are available. Check the *Ubuntu Software Center* to see what's available.

There are a few other problems which might prevent someone from playing your video. The video could have
been damaged when you sent it to them (sometimes big files aren't copied across perfectly), they could have problems with their video playback application, or the video may not have been created properly (there could have been some errors when you saved the video).
More Information

Videos
Why won't DVDs play?

If you insert a DVD into your computer and it doesn't play, you may not have the right DVD codecs installed, or the DVD might be from a different region.

Installing the right codecs for DVD
In order to play DVDs, you need to have the right codecs installed. A codec is a piece of software that allows applications to read a video or audio format. If you try to play a DVD and don't have the right codecs installed, the Movie Player should tell you about this and offer to install them for you.

DVDs are also copy-protected using
a system called CSS. This prevents you from copying DVDs, but it also prevents you from playing them unless you have extra software to handle the copy protection.

### Checking the DVD region

DVDs have a *region code*, which tells you in which region of the world they are allowed to be played. If the
region of your computer's DVD player doesn't match the region of the DVD you are trying to play, you won't be able to play the DVD. For example, if you have a Region 1 DVD player, you will only be allowed to play DVDs from North America.

It is often possible to change the region used by your DVD player, but it can only be done a few times before it locks into one region permanently. To change the DVD
region of your computer's DVD player, use `regionset`.

---

More Information

Videos

See Also

How do I enable restricted codecs to play DVDs? — Most commercial DVDs are encrypted and will not play without decryption software.
How do I enable restricted codecs to play DVDs?

DVD support cannot be provided by default in Ubuntu due to legal and technical restrictions. Most commercial DVDs are encrypted.
and so require the use of decryption software in order to play them.

Use Fluendo to legally play DVDs

You can buy a commercial DVD decoder that can handle copy protection from Fluendo. It works with Linux and should be legal to use in all countries.
Use alternative decryption software

In some countries, the use of the below unlicensed decryption software is not permitted by law. Verify that you are within your rights to use it.

1. Install libdvdnav4,
2. If you would like to play encrypted DVDs (see the legal note above), open the Dash and launch a Terminal.

3. Type the following into the screen which appears, then press Enter:
sudo
/usr/share/doc/libdvdread4/install-cs.sh

4. Enter your password to complete the installation.

More Information

Videos

See Also

Why won't DVDs play? — You might not have the right codecs
installed, or the DVD might be the wrong region.
Files, folders & search

Common tasks

Browse files and folders
Copy or move files and folders
Delete files and folders
Preview files and folders
Rename a file or folder
Search for files
Sort files and folders
More topics

Browse files on a server or network share
File properties
Find a lost file
Open files with other applications
Recover a file from the Trash
Share and transfer files
Write files to a CD or DVD
File manager preferences

Removable drives and
external disks

Open applications for devices or discs
Automatically run applications for CDs and DVDs, cameras, audio players, and other devices and media.

Safely remove an external drive
Eject or unmount a USB flash drive, CD, DVD, or other device.

Backing up
Back up your important files
Why, what, where and how of backups.

Check your backup
Verify your backup was successful.

Frequency of backups
Learn how often you should backup your important files to make sure that they're safe.
Restore a backup
Retrieve your files from a backup.

Where can I find the files I want to back up?
A list of folders where you can find documents, files and settings that you may want to back up.

Documents
Documents
Organize the documents stored locally on your computer or created online.

Tips and questions
Edit folder bookmarks
Add, delete, and rename bookmarks in the file manager.

Hide a file
Make a file invisible, so you can't see it in the file manager.

Select files by pattern
Press Ctrl + S to select multiple files which have similar names.
Set file permissions
Control who can view and edit your files and folders.

Templates for commonly-used document types
Quickly create new documents from custom file templates.

What is a file with a "~" at the end of its name?
These are backup files. They are hidden by default.
Browse files and folders

Use the *Files* file manager to browse and organize the files on your computer. You can also use it to manage files on storage devices (like external hard disks), on *file servers*, and on network shares.

To start the file manager, open *Files* in the Launcher. You can also
search for files and folders with the Dash in the same way you would search for applications. They will appear under the heading Files and Folders.

Exploring the contents of folders

In the file manager, double-click any folder to view its contents, and double-click any file to open it with
the default application for that file. You can also right-click a folder to open it in a new tab or new window.

The *path bar* above the list of files and folders shows you which folder you're viewing, including the parent folders of the current folder. Click a parent folder in the path bar to go to that folder. Right-click any folder in the path bar to open it in a new tab or window, copy or move it, or access its properties.
If you want to quickly skip to a file in the folder you're viewing, start typing its name. A search box will appear at the top of the window and the first file which matches your search will be highlighted. Press the down arrow key, or scroll with the mouse, to skip to the next file that matches your search.

You can quickly access common places from the sidebar. If you do not see the sidebar, click the ☰
button in the toolbar and pick **Show Sidebar**. You can add bookmarks to folders that you use often and they will appear in the sidebar. Use the **Bookmarks** menu to do this, or simply drag a folder into the sidebar.

---

**More Information**

**Files, folders & search** — Searching, delete files, backups, removable drives, documents...
See Also

Copy or move files and folders — Copy or move items to a new folder.
File properties

To view information about a file or folder, right-click it and select Properties. You can also select the file and press Alt + Enter. The file properties window shows you information like the type of file, the size of the file, and when you last modified it. If you need this information often, you can have it...
displayed in list view columns or icon captions.

The information given on the Basic tab is explained below. There are also Permissions and Open With tabs. For certain types of files, such as images and videos, there will be an extra tab that provides information like the dimensions, duration, and codec.
Basic properties

Name

You can rename the file by changing this field. You can also rename a file outside the properties window. See Rename a file or folder.

Type

This helps you identify the type of the file, such as PDF
document, OpenDocument Text, or JPEG image. The file type determines which applications can open the file, among other things. For example, you can't open a picture with a music player. See Open files with other applications for more information on this.

The MIME type of the file is shown in parentheses; MIME
type is a standard way that computers use to refer to the file type.

Contents

This field is displayed if you are looking at the properties of a folder rather than a file. It helps you see the number of items in the folder. If the folder includes other folders, each inner folder is counted
as one item, even if it contains further items. Each file is also counted as one item. If the folder is empty, the contents will display nothing.

Size

This field is displayed if you are looking at a file (not a folder). The size of a file tells you how much disk space it takes up. This is also an
indicator of how long it will take to download a file or send it in an email (big files take longer to send/receive).

Sizes may be given in bytes, KB, MB, or GB; in the case of the last three, the size in bytes will also be given in parentheses. Technically, 1 KB is 1024 bytes, 1 MB is 1024 KB and so on.
Location

The location of each file on your computer is given by its absolute path. This is a unique "address" of the file on your computer, made up of a list of the folders that you would need to go into to find the file. For example, if Jim had a file called Resume.pdf in his Home folder, its location would be /home/jim/Resume.pdf.
Volume

The file system or device that the file is stored on. This shows you where the file is physically stored, for example if it is on the hard disk or on a CD, or a network share or file server. Hard disks can be split up into several disk partitions; the partition will be displayed under Volume too.

Free Space
This is only displayed for folders. It gives the amount of disk space which is available on the disk that the folder is on. This is useful for checking if the hard disk is full.

Accessed

The date and time when the file was last opened.

Modified
The date and time when the file was last changed and saved.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...

See Also

Set file permissions — Control who can view and edit your files and folders.
Find a lost file

If you created or downloaded a file, but now you can't find it, follow these tips.

• If you don't remember where you saved the file, but you have some idea of how you named it, you can search for the file by name. See Search for files to learn how.
• If you just downloaded the file, your web browser might have automatically saved it to a common folder. Check the Desktop and Downloads folders in your home folder.

• You might have accidentally deleted the file. When you delete a file, it gets moved to the trash, where it stays until you manually empty the trash. See Recover a file from the
Trash to learn how to recover a deleted file.

- You might have renamed the file in a way that made the file hidden. Files that start with a . or end with a ~ are hidden in the file manager. Click the button in the file manager toolbar and pick Show Hidden Files to display them. See Hide a file to learn more.
More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...

See Also

Recover a file from the Trash — Deleted files are normally sent to the Trash, but can be recovered.
Open files with other applications

When you double-click a file in the file manager, it will be opened with the default application for that file type. You can open it in a different application, search online for applications, or set the default application for all files of the same
To open a file with an application other than the default, right-click the file and select the application you want from the top of the menu. If you don't see the application you want, click Open With Other Application. By default, the file manager only shows applications it knows can handle the file. To look through all the applications on your computer, click Show other
If you still can't find the application you want, you can search for more applications by clicking Find applications online. The file manager will search online for packages containing applications that are known to handle files of that type.

Change the default
You can change the default application that is used to open files of a given type. This will allow you to open your preferred application when you double-click to open a file. For example, you might want your favorite music player to open when you double-click an MP3 file.

1. Select a file of the type
whose default application you want to change. For example, to change which application is used to open MP3 files, select a .mp3 file.

2. Right-click the file and select Properties.

3. Select the Open With tab.

4. Select the application you want and click Set as.
By default, the file manager only shows applications it knows can handle the file. To look through all the applications on your computer, click Show other applications.

If Other Applications contains an application you sometimes want to use, but don't want to make the default, select that
application and click Add. This will add it to Recommended Applications. You will then be able to use this application by right-clicking the file and selecting it from the list.

This changes the default application not just for the selected file, but for all files with the same type.
More Information

Files, folders & search —
Searching, delete files, backups, removable drives, documents...
Recover a file from the Trash

If you delete a file with the file manager, the file is normally placed into the Trash, and should be able to be restored.

To restore a file from the Trash:

1. Open the Launcher and
then click the *Trash* shortcut which is located at the bottom of the Launcher.

2. If your deleted file is there, right-click on it and select *Restore*. It will be restored to the folder it was deleted from.

If you deleted the file by pressing `Shift + Delete`, or by using the command line, the file has been
permanently deleted. Files that have been permanently deleted can't be recovered from the Trash.

There are a number of recovery tools available that are sometimes able to recover files that were permanently deleted. These tools are generally not very easy to use, however. If you accidentally permanently deleted a file, it's probably best to ask for advice on a support forum to see if you can
recover it.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...

See Also

Delete files and folders — Remove files or folders you no longer need.

Find a lost file — Follow these tips if you can't find a file you created or downloaded.
Write files to a CD or DVD

You can put files onto a blank disc by using CD/DVD Creator. The option to create a CD or DVD will appear in the file manager as soon as you place the CD into your CD/DVD writer. The file manager lets you transfer files to other computers or perform backups by
putting files onto a blank disc. To write files to a CD or DVD:

1. Place an empty disc into your CD/DVD writable drive.

2. In the Blank CD/DVD-R Disc window that appears, select CD/DVD Creator and click OK. The CD/DVD Creator folder window will open.
(You can also click on Blank CD/DVD-R Disc under Devices in the file manager sidebar.)

3. In the Disc Name field, type a name for the disc.

4. Drag or copy the desired files into the window.

5. Click Write to Disc.

6. Under Select a disc to write
to, choose the blank disc.

(You could choose Image file instead. This will put the files in a disc image, which will be saved on your computer. You can then burn that disc image onto a blank disc at a later date.)

7. Click Properties if you want to adjust burning speed, the location of temporary files,
and other options. The default options should be fine.

8. Click the Burn button to begin recording.

If Burn Several Copies is selected, you will be prompted for additional discs.

9. When the disc burning is
complete, it will eject automatically. Choose Make More Copies or Close to exit.

For more advanced CD/DVD burning projects, try Brasero.

For help with using Brasero, read the user guide.
If the disc wasn't burned properly

Sometimes the computer doesn't record the data correctly, and you won't be able to see the files you put onto the disc when you insert it into a computer.

In this case, try burning the disc again but use a lower burning speed, e.g. 12x rather than 48x. Burning at slower speeds is more
reliable. You can choose the speed by clicking the Properties button in the CD/DVD Creator window.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...
Copy or move files and folders

A file or folder can be copied or moved to a new location by dragging and dropping with the mouse, using the copy and paste commands, or using keyboard shortcuts.
For example, you might want to copy a presentation onto a memory stick so you can take it to work with you. Or, you could make a back-up copy of a document before you make changes to it (and then use the old copy if you don't like your changes).

These instructions apply to both files and folders. You copy and move files and folders in exactly the same way.
Copy and paste files

1. Select the file you want to copy by clicking on it once.

2. Right-click and pick Copy, or press Ctrl + C.

3. Navigate to another folder, where you want to put the copy of the file.

4. Right-click and pick Paste to finish copying the file, or
press $\text{Ctrl} + \text{V}$ . There will now be a copy of the file in the original folder and the other folder.

Cut and paste files to move them

1. Select the file you want to move by clicking on it once.

2. Right-click and pick Cut, or press $\text{Ctrl} + \text{X}$ .
3. Navigate to another folder, where you want to move the file.

4. Right-click and pick Paste to finish moving the file, or press Ctrl + V. The file will be taken out of its original folder and moved to the other folder.

Drag files to copy or move
1. Open the file manager and go to the folder which contains the file you want to copy.

2. Click Files in the top bar, select New Window (or press Ctrl + N) to open a second window. In the new window, navigate to the folder where you want to move or copy the file.
3. Click and drag the file from one window to another. This will *move it* if the destination is on the same device, or *copy it* if the destination is on a *different* device.

For example, if you drag a file from a USB memory stick to your Home folder, it will be copied because you're dragging from one device to another.
You can force the file to be copied by holding down the Ctrl key while dragging, or force it to be moved by holding down the Shift key while dragging.

You can't copy or move a file into a folder that is read-only. Some folders are read-only to prevent you from making
changes to their contents. You can change things from being read-only by changing file permissions.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents…

See Also

Browse files and folders — Manage and organize files with
the file manager.
Delete files and folders

If you don't want a file or folder any more, you can delete it. When you delete an item it is moved to the Trash folder, where it is stored until you empty the trash. You can restore items in the Trash folder to their original location if you decide you need them, or if they were
To send a file to the trash:

1. Select the item you want to place in the trash by clicking it once.

2. Press Delete on your keyboard. Alternatively, drag the item to the Trash in the sidebar.
To delete files permanently, and free up disk space on your computer, you need to empty the trash. To empty the trash, right-click Trash in the sidebar and select Empty Trash.

**Permanently delete a file**

You can immediately delete a file permanently, without having to send
it to the trash first.

To permanently delete a file:

1. Select the item you want to delete.

2. Press and hold the Shift key, then press the Delete key on your keyboard.

3. Because you cannot undo this, you will be asked to
confirm that you want to delete the file or folder.

If you frequently need to delete files without using the trash (for example, if you often work with sensitive data), you can add a Delete entry to the right-click menu for files and folders.

Click Files in the menu bar, pick Preferences and select
the Behavior tab. Select Include a Delete command that bypasses Trash.

Deleted files on a removable device may not be visible on other operating systems, such as Windows or Mac OS. The files are still there, and will be available when you plug the device back into your computer.
More Information

Files, folders & search —
Searching, delete files, backups, removable drives, documents…

See Also

File manager trash preferences

Recover a file from the Trash —
Deleted files are normally sent to the Trash, but can be recovered.
Preview files and folders

You can quickly preview files without opening them in a full-blown application. Select any file and press the space bar. The file will open in a simple preview window. Press the space bar again to dismiss the preview.

The built-in preview supports most
file formats for documents, images, video, and audio. In the preview, you can scroll through your documents or seek through your video and audio.

To view a preview full-screen press f. Press f again to leave full-screen, or press the space bar to exit the preview completely.
Files, folders & search — Searching, delete files, backups, removable drives, documents...

See Also

File manager preview preferences — Control when thumbnails are used for files.
Rename a file or folder

You can use the file manager to change the name of a file or folder.

To rename a file or folder:

1. Right-click on the item and select Rename, or select the file and press F2.
2. Type the new name and press Enter.

You can also rename a file from the properties window.

When you rename a file, only the first part of the name of the file is selected, not the file extension (the part after the "."). The extension normally denotes what type of file it is (e.g. file.pdf is a PDF document), and you usually do not
want to change that. If you need to change the extension as well, select the entire file name and change it.

If you renamed the wrong file, or named your file improperly, you can undo the rename. To revert the action and restore the former name, immediately click Edit in the menu bar and select Undo Rename.
Valid characters for file names

You can use any character except the `/` (slash) character in file names. Some devices, however, use a file system that has more restrictions on file names. Therefore, it is a best practice to avoid the following characters in your file names: `|`, `\`, `?`, `*`, `<`, `"`, `:`, `>`, `/`. 
If you name a file with a `.` as the first character, the file will be hidden when you attempt to view it in the file manager.

Common problems

The file name is already in use

You can't have two files or folders with the same name in the same folder. If you try to
rename a file to a name that already exists in the folder you are working in, the file manager will not allow it.

File and folder names are case sensitive, so the file name `File.txt` is not the same as `FILE.txt`. Using different file names like this is allowed, though it is not recommended.
The file name is too long

On some file systems, file names can have no more than 255 characters in their names. This 255 character limit includes both the file name and the path to the file (e.g., /home/wanda/Documents/work/business-proposals/…), so you should avoid long file and folder names where possible.
The option to rename is grayed out

If Rename is grayed out, you do not have permission to rename the file. You should use caution with renaming such files, as renaming some protected files may cause your system to become unstable. See Set file permissions for more information.
More Information

Files, folders & search —
Searching, delete files, backups, removable drives, documents...
You can search for files based on their name or file type directly within the file manager. You can even save common searches, and they will appear as special folders in your home folder.

Search

1. Open the file manager
2. If you know the files you want are under a particular folder, go to that folder.

3. Click the magnifying glass in the toolbar, or press Ctrl + F.

4. Type a word or words that you know appear in the file name. For example, if you name all your invoices with the word "Invoice", type
invoice. Press Enter.

Words are matched regardless of case.

5. You can narrow your results by location and file type.

- Click Home to restrict the search results to your Home folder, or All Files to search everywhere.
○ Click and pick a File Type from the drop-down list to narrow the search results based on file type. Click the button to remove this option and widen the search results.

6. You can open, copy, delete, or otherwise work with your files from the search results, just as you would
from any folder in the file manager.

7. Click the magnifying glass in the toolbar again to exit the search and return to the folder.

If you perform certain searches often, you can save them to access them quickly.

Save a search
1. Start a search as above.

2. When you're happy with the search parameters, click File in the menu bar and and select Save Search As....

3. Give the search a name and click Save. If you like, select a different folder to save the search in. When you view that folder, you will
see your saved search as an orange folder icon with a magnifying glass on it.

To remove the search file when you are done with it, simply delete the search as you would any other file. When you delete a saved search, it does not delete the files that the search matched.
Files, folders & search — Searching, delete files, backups, removable drives, documents...
Sort files and folders

You can sort files in different ways in a folder, for example by sorting them in order of date or file size. See [Ways of sorting files](#) below for a list of common ways to sort files.

See [Views preferences in Files](#) for information on how to change the default sort order.
The way that you can sort files depends on the folder view that you are using. You can change the current view using the list or icon buttons in the toolbar.

### Icon view

To sort files in a different order, click the ▼ button in the toolbar and choose By Name, By Size, By Type or By Modification Date.
As an example, if you select By Name, the files will be sorted by their names, in alphabetical order. See Ways of sorting files for other options.

You can sort in the reverse order by selecting Reversed Order from the pull-down menu.

List view

To sort files in a different order,
click one of the column headings in the file manager. For example, click **Type** to sort by file type. Click the column heading again to sort in the reverse order.

In list view, you can show columns with more attributes and sort on those columns. Click the \( \downarrow \) button in the toolbar, pick **Visible Columns** and select the columns that you want to be visible. You will then be able to sort by those columns. See
File manager list columns preferences for descriptions of available columns.

Ways of sorting files

By Name

Sorts alphabetically by the name of the file.

By Size

Sorts by the size of the file.
(how much disk space it takes up). Sorts from smallest to largest by default.

By Type

Sorts alphabetically by the file type. Files of the same type are grouped together, then sorted by name.

By Modification Date

Sorts by the date and time
that a file was last changed. Sorts from oldest to newest by default.

More Information

Files, folders & search — Searching, delete files, backups, removable drives, documents...
File manager preferences

Views preferences in *Files*
Specify the default view, sort order, and zoom levels for the file manager.

File manager behavior preferences
Single-click to open files, run or view executable text files, and specify trash behavior.
File manager display preferences
Control icon captions used in the file manager.

File manager list columns preferences
Control what information is displayed in columns in list view.

File manager preview preferences
Control when thumbnails are used for files.
More Information

Files, folders & search —
Searching, delete files, backups, removable drives, documents...
Views preferences in Files

You can change the default view for new folders, how files and folders are sorted by default, the zoom level for the icon and compact views, and whether files are displayed in the tree sidebar. Select Files ➤ Preferences in the top bar
while *Files* is open and select the Views tab.

**Default view**

View new folders using

By default, new folders are shown in icon view. If you prefer the list view, you can set it here as the default. Alternatively, you can select a different view for each folder.
as you browse by clicking the View items as a list or View items as a grid of icons button in the toolbar.

Arrange items

You can change the default sort order that is used in folders using the Arrange items drop-down list in the preferences to sort by name, file size, file type, when they
were last modified, when they were last accessed or when they were trashed.

You can change how **files are sorted** in an individual folder by clicking the ▼ button in the toolbar and choosing **By Name**, **By Size**, **By Type** or **By Modification Date**, or by clicking the list column headers in list view. This menu only affects the current
Sort folders before files

By default, the file manager no longer shows all folders before files. To see all folders listed before files, enable this option.

Show hidden and backup files

The file manager does not display hidden files and
folders by default. You can always show hidden files by selecting this option.

You can also show hidden files in an individual window by selecting Show Hidden Files, from the menu in the toolbar.

Icon view defaults

Default zoom level
You can make the icons and text larger or smaller by default in icon view using this option. You can also change this setting in an individual folder by clicking the ▼ button in the toolbar and selecting Zoom In, Zoom Out or Normal Size. If you frequently use a larger or smaller zoom level, you can set the default with this option.
In icon view, more or fewer captions are shown based on your zoom level.

List view defaults

Default zoom level

You can make the icons and text larger or smaller in list view using this option. You can also do this in an individual folder by clicking the
button in the toolbar and selecting Zoom In, Zoom Out or Normal Size.

More Information

File manager preferences
You can control whether you single-click or double-click files, how executable text files are handled, and the trash behavior. Click Files in the menu bar, pick Preferences and select the Behavior tab.
Behavior

Single click to open items
Double click to open items

By default, clicking selects files and double-clicking opens them. You can instead choose to have files and folders open when you click on them once. When you use single-click mode, you can hold down the "Ctrl" key while clicking to select one or more files.
An executable text file is a file that contains a program that you can run (execute). The file permissions must also allow for the file to run as a program. The most common are Shell, Python and Perl scripts. These have extensions .sh, .py and .pl, respectively.

When you open an executable text file, you can select from:
• Run executable text files when they are opened

• View executable text files when they are opened

• Ask each time

If Ask each time is selected, a dialog will pop up asking if you wish to run or view the selected text file.

Executable text files are also called scripts. All scripts in
folder will appear in the context menu for a file under the Scripts submenu. When a script is executed from a local folder, all selected files will be pasted to the script as parameters. To execute a script on a file:

1. Navigate to the desired folder.
2. Select the desired file.

3. Right click on the file to open the context menu and select the desired script to execute from the Scripts menu.

⭐️ A script will not be passed any parameters when executed from a remote folder such as a folder showing web or ftp
Trash

Ask before emptying the Trash or deleting files

This option is selected by default. When emptying the trash, a message will be displayed confirming that you would like to empty the trash or delete files.
Include a Delete command that bypasses Trash

Selecting this option will add a Delete item to the menu that pops up when you right-click on an item in the *Files* application.

⚠️ Deleting an item using the Delete menu option bypasses the Trash altogether. The item is
removed from the system completely. There is no way to recover the deleted item.

See Also

Delete files and folders — Remove files or folders you no longer need.

More Information

File manager preferences
You can control how the file manager displays captions under icons. Click Edit in the menu bar, pick Preferences and select the Display tab.
When you use icon view, you can choose to have extra information about files and folders displayed in a caption under each icon. This is useful, for example, if you often need to see who owns a file or when it was last modified.
You can zoom in a folder by clicking the View ➤ Zoom In or press Ctrl + +. As you zoom in, the file manager will display more and more information in captions. You can choose up to three things to show in captions. The first will be displayed at most zoom levels. The last will only be shown at very large sizes.

If you have a file manager
window open, you may have to reload for icon caption changes to take effect. Click View ▶ Reload or press Ctrl + R.

More Information

File manager preferences
There are nine columns of information that you can display in the file manager's list view. Click Files in the menu bar, pick Preferences and choose the List Columns tab to select which columns will be visible.
Use the **Move Up** and **Move Down** buttons to choose the order in which the selected columns will appear.

**Name**

The name of folders and files in the folder being viewed.

**Size**

The size of a folder is given as
the number of items contained in the folder. The size of a file is given as bytes, KB, or MB.

Type

Displayed as folder, or file type such as PDF document, JPEG image, MP3 audio, and more.

Modified

Gives the date and time of the
last time the file was modified.

Owner

The name of the user the folder or file is owned by.

Group

The group the file is owned by. On my home computers, each user is in their own group. Groups are sometimes used in corporate
environments, where users might be in groups according to department or project.

Permissions

Displays the file access permissions e.g. `drwxrwr--`

- The first character `-` is the file type. `-` means regular file and `d` means directory (folder).
The next three characters \texttt{rwx} specify permissions for the user who owns the file.

The next three \texttt{rw-} specify permissions for all members of the group that owns the file.

The last three characters in the column \texttt{r--} specify permissions for all other users on the system.
Each character has the following meanings:

- **r**: Read permission.
- **w**: Write permission.
- **x**: Execute permission.
- **-**: No permission.

**MIME Type**

Displays the MIME type of the item.
Location

The path to the location of the file.

More Information

File manager preferences
The file manager creates thumbnails to preview image, video, and text files. Thumbnail previews can be slow for large files or over networks, so you can control when previews are made. Click Files in the menu bar, pick Preferences and
select the Preview tab.

Files

By default, all previews are done for Local Files Only, those on your computer or connected external drives. You can set this feature to Always or Never. The file manager can browse files on other computers over a local area network or the internet. If
you often browse files over a local area network, and the network has high bandwidth, you may want to set the preview option to *Always*.

In addition, you can use the *Only for files smaller than* setting to limit the size of files previewed.

**Folders**

If you show file sizes in *list*
view columns or icon captions, folders will be shown with a count of how many files and folders they contain. Counting items in a folder can be slow, especially for very large folders, or over a network. You can turn this feature on or off, or turn it on only for files on your computer and local external drives.
More Information

File manager preferences

See Also

Preview files and folders —
Quickly show and hide previews for documents, images, videos, and more.
Safely remove an external drive

When you use external storage devices like USB flash drives, you should safely remove them before unplugging them. If you just unplug a device, you run the risk of unplugging while an application is still using it. This could result in
some of your files being lost or damaged. When you use an optical disc like a CD or DVD, you can use the same steps to eject the disc from your computer.

To eject a removable device:

1. **Open the file manager.**

2. Locate the device in the sidebar. It should have a small eject icon next to the
name. Click the eject icon to safely remove or eject the device.

Alternately, you can right-click the name of the device in the sidebar and select Eject.

Safely remove a device that is in use
If any of the files on the device are open and in use by an application, you will not be able to safely remove the device. You will be prompted with a window telling you that "the volume is busy," and listing all the open files on the device. Once you close all the files on the device, the device will automatically be safe to remove. At that time you can unplug or eject it.

If you can't close one of the files, for
example if the application using the file is locked up, you can right-click the file in the Volume is busy window and select End Process. This will force the entire locked up application to close, which could close other files you have open with that application.

⚠️ You can also choose Eject Anyway to remove the device without closing the files. This
may cause errors in applications that have those files open.

More Information

Removable drives and external disks
Back up your important files

Back up your files simply means making a copy of them for safekeeping. This is done in case the original files become unusable due to loss or corruption. These copies can be used to restore the original data in the event of loss. Copies should be stored on a
different device from the original files. For example, you may use a USB drive, an external hard drive, a CD/DVD, or an off-site service.

The best way to back up your files is to do so regularly, keeping the copies off-site and (possibly) encrypted.
How to back up
Use Déjà Dup (or some other backup application) to make copies of your valuable files and settings to protect against loss.

What to back up
Back up anything that you can't bear to lose if something goes wrong.

Where to store your backup
Advice on where to store your backups and what type of storage device to use.
More Information

Backing up
How to back up

The recommended way of backing up your files and settings is to let a backup application manage the backup process for you. A number of different backup applications are available, like Déjà Dup.

The help for your chosen backup application will walk you through setting your preferences for the
backup, as well as how to restore your data.

An alternative option is to copy your files to a safe location, such as an external hard drive, another computer on the network, or a USB drive. Your personal files and settings are usually in your Home folder, so you can copy them from there.

The amount of data you can back...
up is limited by the size of the storage device. If you have the room on your backup device, it is best to back up the entire Home folder with the following exceptions:

- Files that are already backed up somewhere else, such as to a CD, DVD, or other removable media.

- Files that you can recreate easily. For example, if you are
a programmer, you don't have to back up the files that get produced when you compile your programs. Instead, just make sure that you back up the original source files.

- Any files in the Trash folder. Your Trash folder can be found in

  ~/.local/share/Trash.
More Information

Back up your important files — Why, what, where and how of backups.
What to back up

Your priority should be to back up your **most important files** as well as those that are difficult to recreate. For example, ranked from most important to least important:

Your personal files

This may include documents,
spreadsheets, email, calendar appointments, financial data, family photos, or any other personal files that you would consider irreplaceable.

Your personal settings

This includes changes you may have made to colors, backgrounds, screen resolution and mouse settings on your desktop. This also
includes application preferences, such as settings for *LibreOffice*, your music player, and your email program. These are replaceable, but may take a while to recreate.

System settings

Most people never change the system settings that are created during installation. If
you do customize your system settings for some reason, or if you use your computer as a server, then you may wish to back up these settings.

Installed software

The software you use can normally be restored quite quickly after a serious computer problem by reinstalling it.
In general, you will want to back up files that are irreplaceable and files that require a great time investment to replace without a backup. If things are easy to replace, on the other hand, you may not want to use up disk space by having backups of them.

More Information

Back up your important files — Why, what, where and how of
backups.
Where to store your backup

You should store backup copies of your files somewhere separate from your computer - on an external hard disk, for example. That way, if the computer breaks, the backup will still be intact. For maximum security, you shouldn't keep the backup in the same building as your
computer. If there is a fire or theft, both copies of the data could be lost if they are kept together.

It is important to choose an appropriate backup medium, too. You need to store your backups on a device that has sufficient disk capacity for all of the backed-up files.

Local and remote storage options
- USB memory key (low capacity)
- Writable CDs or DVDs (low/medium capacity)
- External hard disk (typically high capacity)
- Internal disk drive (high capacity)
- Network-connected drive (high capacity)
• File/backup server (high capacity)

• Online backup service (Amazon S3, for example; capacity depends on price)

Some of these options have sufficient capacity to allow for a backup of every file on your system, which is also known as a complete system backup.
More Information

Back up your important files — Why, what, where and how of backups.
Check your backup

After you have backed up your files, you should make sure that the backup was successful. If it didn't work properly, you could lose important data since some files could be missing from the backup.

When you use the file manager to copy or move files, the computer
checks to make sure that all of the data transferred correctly. However, if you are transferring data that is very important to you, you may want to perform additional checks to confirm that your data has been transferred properly.

You can do an extra check by looking through the copied files and folders on the destination media. By checking to make sure that the files and folders you transferred are
actually there in the backup, you can have extra confidence that the process was successful.

If you find that you do regular backups of large amounts of data, you may find it easier to use a dedicated backup program, such as Déjà Dup. Such a program is more powerful and more reliable than just copying and pasting
files.

More Information

Back up
Frequency of backups

How often you make backups will depend on the type of data to be backed up. For example, if you are running a network environment with critical data stored on your servers, then even nightly backups may not be enough.

On the other hand, if you are
backing up the data on your home computer then hourly backups would likely be unnecessary. You may find it helpful to consider the following points when planning your backup schedule:

- The amount of time you spend on the computer.
- How often and by how much the data on the computer changes.
If the data you want to back up is lower priority, or subject to few changes, like music, e-mails and family photos, then weekly or even monthly backups may suffice. However, if you happen to be in the middle of a tax audit, more frequent backups may be necessary.

As a general rule, the amount of time in between backups should be no more than the amount of time you are willing to spend re-doing
any lost work. For example, if spending a week re-writing lost documents is too long for you, you should back up at least once per week.

More Information

Backing up
Restore a backup

If you lost or deleted some of your files, but you have a backup of them, you can restore them from the backup:

- To restore your backup from a device such as an external hard drive, USB drive or another computer on the
network, you can copy the files back to your computer.

- If you created your backup using a backup application such as Déjà Dup, it is recommended that you use the same application to restore your backup. Review the application help for your backup program: it will provide specific instructions on how to restore your files.
More Information

Backing up
Where can I find the files I want to back up?

Listed below are the most common locations of important files and settings that you may want to back up.

- Personal files (documents,
music, photos and videos)

These are usually stored in your home folder (/home/your_name). They could be in subfolders such as Desktop, Documents, Pictures, Music, and Videos.

If your backup medium has sufficient space (if it's an external hard disk, for example), consider backing up
the entire Home folder. You can find out how much disk space your Home folder takes up by using the *Disk Usage Analyzer*.

- **Hidden files**

Any file or folder name that starts with a period (.) is hidden by default. To view hidden files, click **View ▸ Show Hidden Files** or press
Ctrl + H. You can copy these to a backup location like any other file.

- Personal settings (desktop preferences, themes, and software settings)

Most applications store their settings in hidden folders inside your Home folder (see above for information on hidden files).
Most of your application settings will be stored in the hidden folders `.config`, `.gconf`, `.gnome2`, and `.local` in your Home folder.

- **System-wide settings**

  Settings for important parts of the system aren't stored in your Home folder. There are a number of locations that they could be stored, but most are
stored in the /etc folder. In general, you won't need to back up these files on a home computer. If you are running a server, however, you should back up the files for the services that it is running.

More Information

Backing up
Documents

*Documents* is a GNOME application that lets you display, organize, and print the documents on your computer or those created remotely using *Google Docs* or *SkyDrive*.

**View, Sort and Search**
Display documents stored locally or online
View documents full-screen.

Formats supported
*Documents* displays a number of popular document types.

Filter documents
Choose which documents to display.
Search for files
Find your documents by title or author.

View files in a list or grid
Change the way documents are displayed.

Find information about documents
See a document's name, location, date modified, or type.

Select, Organize, Print
Make collections of documents
Group related documents in a collection.

Print a document
Print documents that are stored locally or online.

Selecting documents
Use selection mode to select more than one document or collection.

Questions
My documents cannot be seen
Local or remote documents do not appear.

Why don't some files have previews?
You can only preview files stored locally.
Display documents stored locally or online

When you open *Documents*, all of your documents, those stored locally as well as online, are displayed as thumbnails.
In order for your *Google Docs* or *SkyDrive* documents to appear, it is necessary to configure Google or Windows Live, respectively, as an online account.

To view the contents of a document:

1. Click the thumbnail. The
The document is displayed full-width in the *Documents* window (or full-screen if maximized).

To exit the document, click the back arrow button.

---

More Information

*View, Sort and Search*
Formats supported

*Documents* displays PDF, DVI, XPS, PostScript and the formats supported by *Document Viewer* (Evince), *Microsoft Office*, *LibreOffice* and *Google Docs*.
View, Sort and Search
Filter documents

Click the button next to the search bar to limit the scope of the search in these categories:

- **Sources**: Local, Google, SkyDrive, or All.

- **Type**: Collections, PDF Documents, Presentations,
Spreadsheets, Text Documents, or All.

• Title, Author, or All.

In order for Google or SkyDrive to appear in the filter list, it is necessary to configure Google or Windows Live as an online account.
More Information

View, Sort and Search
Search for files

To start a search in Documents:

- Press Ctrl + F.
- Click the magnifying glass icon.
- Start typing. Documents will match by title or author.
You can restrict or filter the search results by clicking the button and selecting various filters.

More Information
View, Sort and Search
Documents and collections are presented in Grid format by default. To view in List format:

1. Go to the top bar and click Documents to display the app menu.
2. Click List from the View as section.

List view has columns displaying the document type and date modified, and whether it's stored locally, or in Google Docs or SkyDrive.

Click Grid in the app menu to return to the default format.
More Information

View, Sort and Search
Find information about documents

When a document is created, it comes with metadata. *Documents* displays the following metadata for each document:

- **Title:** the name of the
document, which can be edited;

- Source: the path of the folder containing the document;

- Date Modified;

- Type: the file format of the document.

To see a document's properties:
1. Click the Check button to switch to selection mode.

2. Select a document.

3. Click the Properties button at the right end of the button bar.

Some types of documents (e.g. PDF files) can be
password protected, preventing access to their metadata or content.

*Files* does not currently offer any mechanism to add privacy to a document. You may be able to do this from the application you used to create the document (e.g. *LibreOffice* or *Adobe Acrobat*).
More Information

View, Sort and Search
Make collections of documents

*Documents* lets you put together documents of different types in one place called a *collection*. If you have documents that are related, you can group them to make them easier to find. For example, if you had a business trip where you made a
presentation, your slides, your flight itinerary (a PDF file), your budget spreadsheet, and other hybrid PDF/ODF documents, can be grouped in one collection.

To create or add to a collection:

- Click the ✓ button.
- In selection mode, check the documents to be collected.
- Click the + button in the
button bar.

- In the collection list, click Add and type a new collection name, or select an existing collection. The selected documents will be added to the collection.

Collections do not behave like folders and their hierarchy: you cannot put collections inside
To delete a collection:

- Click the ✓ button.

- In selection mode, check the collection to be deleted.

- Click the Trash button in the button bar. The collection will be deleted, leaving the original documents.
More Information

Select, Organize, Print
Print a document

To print a document:

1. Click the ✓ button.

2. In selection mode, check the document to be printed.

3. Click the Print button in the button bar. The Print dialog
Printing is not available when more than one document is selected, or when a collection is selected.
Selecting documents

From Documents selection mode you can open, print, view or make collections of your documents. To use selection mode:

1. Click the ✓ button.

2. Select one or more
documents or collections. The button bar appears with the actions that are valid for your selection.

**Selection mode actions**

After selecting one or more documents you can:

- Open with Document Viewer (folder icon).
• Print (printer icon): print a document (only available when a single document is selected).

• Organize (plus icon): create a collection of documents.

• Properties (wrench icon): display the properties of a document (only available when a single document is selected).
• Delete (trash icon): delete one or more collections.

More Information

Select, Organize, Print
My documents cannot be seen

If your documents fail to display in Documents, Tracker may not be running or properly configured. Make sure Tracker is running in your session. The default configuration, set to index files in your home directory (non-recursively) and XDG folders
(recursively), should be adequate. Ensure that your documents are in one of these paths.

More Information

Questions
Why don't some files have previews?

When you open Documents, a preview thumbnail is displayed for documents that are stored locally. Those stored on a remote server like Google Docs or SkyDrive show as missing (or blank) preview thumbnails.
If you download a *Google Docs* or *SkyDrive* document to local storage, a thumbnail will be generated.

⭐ The local copy of a document downloaded from *Google Docs* or *SkyDrive* will lose its ability to be updated online. If you want to continue to edit it online, it is better not to download it.
Edit folder bookmarks

Your bookmarks are listed in the sidebar of the file manager.

Add a bookmark:

1. Open the folder (or location) that you want to bookmark.

2. Click Bookmarks in the
menu bar and select Bookmark this Location.

Delete a bookmark:

1. Click Bookmarks in the menu bar and select Bookmarks... from the app menu.

2. In the Bookmarks window, select the bookmark you wish to delete and click the
Rename a bookmark:

1. Click on Files in the top bar and pick Bookmarks from the app menu.

2. In the Bookmarks window, select the bookmark you wish to rename.

3. In the Name text box, type
the new name for the bookmark.

Renaming a bookmark does not rename the folder. If you have bookmarks to two different folders in two different locations, but which each have the same name, the bookmarks will have
the same name, and you won't be able to tell them apart. In these cases, it is useful to give a bookmark a name other than the name of the folder it points to.
Hide a file

The GNOME file manager gives you the ability to hide and unhide files at your discretion. When a file is hidden, it isn't displayed by the file manager, but it's still there in its folder.

To hide a file, rename it with a . at the beginning of its name. For example, to hide a file named
You can hide folders in the same way that you can hide files. Hide a folder by placing a . at the beginning of the folder's name.
If you want to see all hidden files in a folder, go to that folder and either click the button in the toolbar and pick Show Hidden Files, or press Ctrl + H. You will see all hidden files, along with regular files that are not hidden.

To hide these files again, either click the button in the toolbar and pick Show Hidden Files, or press Ctrl + H again.
Unhide a file

To unhide a file, go to the folder containing the hidden file and click the button in the toolbar and pick Show Hidden Files. Then, find the hidden file and rename it so that it doesn't have a in front of its name. For example, to unhide a file called .example.txt, you should rename it to example.txt.

Once you have renamed the file,
you can either click the ▾ button in the toolbar and pick Show Hidden Files, or press Ctrl + H to hide any other hidden files again.

By default, you will only see hidden files in the file manager until you close the file manager. To change this setting so that the file manager will always show hidden files, see Views preferences in Files.
Most hidden files will have a . at the beginning of their name, but others might have a ~ at the end of their name instead. These files are backup files. See What is a file with a "~" at the end of its name? for more information.
What is a file with a "~" at the end of its name? — These are backup files. They are hidden by default.
Select files by pattern

You can select files in a folder using a pattern on the file name. Press Ctrl + S to bring up the Select Items Matching window. Type in a pattern using common parts of the file names plus wild card characters. There are two wild card characters available:
• * matches any number of any characters, even no characters at all.

• ? matches exactly one of any character.

For example:

• If you have an OpenDocument Text file, a PDF file, and an image that all have the same base name
Invoice, select all three with the pattern

Invoice.*

- If you have some photos that are named like Vacation-001.jpg, Vacation-002.jpg, Vacation-003.jpg; select them all with the pattern Vacation-???.jpg
If you have photos as before, but you've edited some of them and added `-edited` to the end of the file name of the photos you've edited, select the edited photos with 

```
Vacation-???-edited.jpg
```
Set file permissions

You can use file permissions to control who can view and edit files that you own. To view and set the permissions for a file, right click it and select Properties, then select the Permissions tab.

See Files and Folders below for details on the types of permissions.
You can set the permissions for the file owner, the group owner, and all other users of the system. For your files, you are the owner, and you can give yourself read-only or read-and-write permission. Set a file to read-only if you don't want to accidentally change it.
Every user on your computer belongs to a group. On home computers, it is common for each user to have their own group, and group permissions are not often used. In corporate environments, groups are sometimes used for departments or projects. As well as having an owner, each file belongs to a group. You can set the file's group and control the permissions for all users in that group. You can
only set the file's group to a group you belong to.

You can also set the permissions for users other than the owner and those in the file's group.

If the file is a program, such as a script, you must select Allow executing file as program to run it. Even with this option selected, the file manager may still open the file in an application or ask you what to
You can set permissions on folders for the owner, group, and other users. See the details of file permissions above for an explanation of owners, groups, and other users.

The permissions you can set for a
folder are different from those you can set for a file.

None

The user will not even be able to see what files are in the folder.

List files only

The user will be able to see what files are in the folder, but will not be able to open,
create, or delete files.

Access files

The user will be able to open files in the folder (provided they have permission to do so on the particular file), but will not be able to create new files or delete files.

Create and delete files

The user will have full access
to the folder, including opening, creating, and deleting files.

You can also quickly set the file permissions for all the files in the folder by clicking Change Permissions for Enclosed Files. Use the drop-down lists to adjust the permissions of contained files or folders, and click Change. Permissions are applied to files and folders in subfolders as well, to any
More Information

Tips and questions

See Also

File properties — View basic file information, set permissions, and choose default applications.
Templates for commonly-used document types

If you often create documents based on the same content, you might benefit from using file templates. A file template can be a document of any type with the
Make a new template

1. Create a document that you are going to use as a template. For example, you could make your letterhead in a word processing application.
2. Save the file with the template content in the Templates folder in your Home folder. If the Templates folder doesn't exist, you will need to create it first.

Use a template to create a document

1. Open the folder where you want to place the new document.
2. Right-click anywhere in the empty space in the folder, then choose **New Document**. The names of available templates will be listed in the submenu.

3. Choose your desired template from the list.

4. Enter a filename for the newly-created document.
5. Double-click the file to open it and start editing.

More Information

Tips and questions
What is a file with a "~" at the end of its name?

Files with a "~" at the end of their names (for example, example.txt~) are automatically created backup copies of documents edited in the *gedit* text editor or other.
applications. It is safe to delete them, but there's no harm to leave them on your computer.

These files are hidden by default. If you are seeing them, that is because you either selected Show Hidden Files (in the menu of the Files toolbar) or pressed Ctrl + H. You can hide them again by repeating either of these steps.
These files are treated in the same way as normal hidden files. See Hide a file for advice on dealing with hidden files.

More Information
Tips and questions

See Also

Hide a file — Make a file invisible, so you can't see it in the file manager.
Add & remove software
Install additional software
Use the Ubuntu Software Center to add programs and make Ubuntu more useful.

Remove an application
Remove software that you no longer use.

Add a Personal Package Archive (PPA)
Add PPAs to help test pre-release or specialty software.

Add additional software repositories
Add other repositories to extend the software sources Ubuntu
the software sources Ubuntu uses for installation and upgrades.

Use Synaptic for more advanced software management

Synaptic is a powerful but complicated software management alternative to Ubuntu Software Center.

Install languages

Install more translations and related language support packages.
More Information

Ubuntu Desktop Guide
Install additional software

The Ubuntu development team has chosen a default set of applications that we think makes Ubuntu very useful for most day-to-day tasks. However, you will certainly want to install more software to make Ubuntu more useful to you.
To install additional software, complete the following steps:

1. Connect to the Internet using a **wireless** or **wired** connection.

2. Click the *Ubuntu Software Center* icon in the Launcher, or search for Software Center in the Dash.
3. When the Software Center launches, search for an application, or select a category and find an application from the list.

4. Select the application that you are interested in and click Install.

5. You will be asked to enter your password. Once you have done that the
installation will begin.

6. The installation usually finishes quickly, but could take a while if you have a slow Internet connection.

7. A shortcut to your new app will be added to the Launcher. To disable this feature, uncheck View New Applications in Launcher.
More Information

Add & remove software — Install, remove, extra repositories...

See Also

Install languages — Install more translations and related language support packages.

Remove an application — Remove software that you no longer use.

Use Synaptic for more advanced software management — Synaptic is a powerful but complicated software
management alternative to Ubuntu Software Center.
Remove an application

The *Ubuntu Software Center* helps you to remove software that you no longer use.

1. Click the *Ubuntu Software Center* icon in the Launcher or search for *Software Center* in the Dash.
2. When the Software Center opens, click the Installed button at the top.

3. Find the application that you want to remove by using the search box or by looking through the list of installed applications.

4. Select the application and click Remove.
5. You may be asked to enter your password. After you have done that, the application will be removed.

Some applications depend on other applications to work properly. If you try to remove an application that is needed by another application, both will be removed. You will be asked
to confirm whether you want this to happen before the applications are removed.

More Information

Add & remove software — Install, remove, extra repositories...

See Also

Install additional software — Use the Ubuntu Software Center to add programs and make Ubuntu more useful.
Add a Personal Package Archive (PPA)

Personal Package Archives (PPAs) are software repositories designed for Ubuntu users and are easier to install than other third-party repositories.
Only add software repositories from sources that you trust!

Third-party software repositories are not checked for security or reliability by Ubuntu members, and may contain software which is harmful to your computer.

Install a PPA
1. On the PPA's overview page, look for the heading Adding this PPA to your system. Make a note of the PPA's location, which should look similar to: ppa:mozilla-team/firefox-
next.

2. Click the Ubuntu Software Center icon in the Launcher, or search for
Software Center in the Dash.

3. When the Software Center launches, click Edit ➤ Software Sources

4. Switch to the Other Software tab.

5. Click Add and enter the ppa: location.

6. Click Add Source. Enter
your password in the Authenticate window.

7. Close the Software Sources window. Ubuntu Software Center will then check your software sources for new software.

More Information

Add & remove software — Install, remove, extra repositories…
See Also

Add additional software repositories — Add other repositories to extend the software sources Ubuntu uses for installation and upgrades.
Add additional software repositories

Software is available from third-party sources, as well as from the default Ubuntu software repositories. If you want to install software from a third-party software repository, you must add it to Ubuntu's list of available
Only add software repositories from sources that you trust!

Third-party software repositories are not checked for security or reliability by Ubuntu members, and may contain software which is harmful to your computer.

Install other repositories
1. Click on the *Ubuntu Software Center* icon in the Launcher, or search for Ubuntu Software Center in the search bar of the *Dash*.

2. When the Software Center launches, click *Edit ➤ Software Sources*.

3. You will be asked to enter your password. Once you
have done that, switch to the Other Software tab.

4. Click Add and enter the APT line for the repository. This should be available from the website of the repository, and should look similar to:

deb

http://archive.ubuntu.com/ubuntu/utopic/main
5. Click Add Source then close the Software Sources window. Ubuntu Software Center will then check your software sources for new updates.

Activate the Canonical Partner repository

The Canonical Partner repository offers some proprietary applications
that don't cost any money to use but are closed source. They include software like *Skype*, *Adobe Reader* and *Adobe Flash Plugin*. Software in this repository will appear in Ubuntu Software Center search results but won't be installable until this repository is enabled.

To enable the repository, follow the steps above to open the Other Software tab in *Software Sources*. If you see the Canonical Partners
repository in the list, make sure it is checked then close the Software Sources window. If you don't see it, click Add and enter:

deb http://archive.canonical.com/ubuntu utopic partner

Click Add Source then close the Software Sources window. Wait a moment for Ubuntu Software Center to download the repository
More Information

Add & remove software — Install, remove, extra repositories...

See Also

Add a Personal Package Archive (PPA) — Add PPAs to help test pre-release or specialty software.
Use Synaptic for more advanced software management

*Synaptic Package Manager* is more powerful and can do some software management tasks which *Ubuntu Software Center* can't. Synaptic's
interface is more complicated and doesn't support newer Software Center features like ratings and reviews and therefore isn't recommended for use by those new to Ubuntu.

Synaptic isn't installed by default, but you can install it with Software Center.

Install software with
1. Open Synaptic from the Dash or the Launcher. You will need to enter your password in the Authenticate window.

2. Click Search to search for an application, or click Sections and look through the categories to find one.
3. Right-click the application that you want to install and select Mark for Installation.

4. If you are asked to mark additional changes, click Mark.

5. Select any other applications that you would like to install.

6. Click Apply, and then click
Apply in the window that appears. The applications that you chose will be downloaded and installed.

For more information about using Synaptic, consult the Synaptic How To.

More Information

Add & remove software — Install, remove, extra repositories…
See Also

Install additional software — Use the Ubuntu Software Center to add programs and make Ubuntu more useful.
Install languages

When you install Ubuntu, the language you select at installation gets installed together with English, but you can add further languages.

1. Click the icon at the very right of the menu bar and select System Settings.
2. In the Personal section, click Language Support.

3. Click Install / Remove Languages.... The Installed Languages window lists all the available languages, with the currently installed languages checked.

4. Check the languages you want to install, and uncheck those currently installed.
languages you want to remove.

5. Click Apply Changes.

6. **Administrative privileges** are required. Enter your password, or the password for the requested administrator account.

In addition to the translations used to display menus and messages,
with a new language may follow various language support components such as dictionaries for spell checking, fonts and input methods.

Some translations may be incomplete, and certain applications may not support your language at all.
More Information

Add & remove software — Install, remove, extra repositories…

Language Support

See Also

Install additional software — Use the Ubuntu Software Center to add programs and make Ubuntu more useful.
User & system settings

Color management
Why is this important, Color profiles, How to calibrate a device...

Display & screen
Background, size and rotation, brightness...
Keyboard
Input sources, cursor blinking, super key, keyboard accessibility…

Mouse
Left-handed, speed and sensitivity, touchpad clicking and scrolling…

Online accounts
Add accounts, Remove accounts, Disable services

Power & battery
Suspend, energy savings, power off, screen dimming…
Region & Language
Install languages, change language, region and formats, input sources...

Sound
Volume, speakers and headphones, microphones...

Startup Applications
Choose what applications to start when you log in.

Time & date
Set time and date, timezone, calendar and appointments...
User accounts
Add user or guest user, change password, administrators…Wacom Graphics Tablet Adjust the settings of your Wacom tablet.

More Information
Ubuntu Desktop Guide
Color management

How do I assign profiles to devices?
Look in System Settings ➤ Color for the option to change this.

Why is color management important?
Color management is important for designers, photographers and artists.
Color profiles

How do I import color profiles?
Color profiles can be imported by opening them.

What is a color profile?
A color profile is a simple file that expresses a color space or device response.

What is a color space?
A color space is a defined range of colors.
What's a virtual color managed device?
A virtual device is a color managed device that is not connected to the computer.

Where do I get color profiles?
Color profiles are provided by vendors and can be generated yourself.

Calibration

Can I share my color profile?
Sharing color profiles is never a good idea as hardware changes
good idea as hardware changes over time.

**How do I calibrate my camera?**
Calibrating your camera is important to capture accurate colors.

**How do I calibrate my printer?**
Calibrating your printer is important to print accurate colors.

**How do I calibrate my scanner?**
Calibrating your scanner is important to capture accurate colors.
How do I calibrate my screen?
Calibrating your screen is important to display accurate colors.

What color measuring instruments are supported?
We support a large number of calibration devices.

What's the difference between calibration and characterization?
Calibration and characterization are different things entirely.

Which target types are supported?
Calibration targets are needed to do scanner and camera profiling.

**Why do I need to do calibration myself?**

Calibrating is important if you care about the colors you display or print.

---

**Problems**
Can I get notified when my color profile is inaccurate?
You can be notified if your color profile is old and inaccurate.

How do I test if color management is working correctly?
Testing color management isn't hard, and we even supply some test profiles.
Missing information for whole-screen color correction?

Whole-screen color correction modifies all the screen colors on all windows.

Why don't the default monitor profiles have a calibration expiry?

Default monitor profiles do not have a calibration date.

More Information

Hardware & drivers — Hardware
problems, printers, power settings, color management, Bluetooth, disks…

**User & system settings —**
Keyboard, mouse, display, languages, user accounts…
How do I assign profiles to devices?

Open System Settings ➤ Color, and click the device that you wish to add a profile to.

By clicking Add profile you can select an existing profile or import a new file.
Each device can have multiple profiles assigned to it, but only one profile can be the *default* profile. The default profile is used when there is no extra information to allow the profile to be chosen automatically. An example of this automatic selection would be if one profile was created for glossy paper and another plain paper.
You can make a profile default by changing it with the radio button.

If calibration hardware is connected the Calibrate… button will create a new profile.
Color management — Why is this important, Color profiles, How to calibrate a device…

See Also

How do I import color profiles? — Color profiles can be imported by opening them.

What is a color profile? — A color profile is a simple file that expresses a color space or device response.

Why do I need to do calibration myself? — Calibrating is important if you care about the colors you display or print.
Why is color management important?

Color management is the process of capturing a color using an input device, displaying it on a screen, and printing it all whilst managing the exact colors and the range of colors on each medium.
The need for color management is probably explained best with a photograph of a bird on a frosty day in winter.

A bird on a frosty wall as seen
on the camera view-finder

Displays typically over-saturate the blue channel, making the images look cold.
This is what the user sees on a typical business laptop screen.

Notice how the white is not 'paper white' and the black of the eye is now a muddy brown.
The basic problem we have here is that each device is capable of handling a different range of colors. So while you might be able to take a photo of electric blue, most printers are not going to be able to reproduce it.

Most image devices capture in RGB (Red, Green, Blue) and have to
convert to CMYK (Cyan, Magenta, Yellow, and Black) to print. Another problem is that you can't have white ink, and so the whiteness can only be as good as the paper color.

Another problem is units. Without specifying the scale on which a color is measured, we don't know if 100% red is near infrared or just the deepest red ink in the printer. What is 50% red on one display is probably something like 62% on
another display. It's like telling a person that you've just driven 7 units of distance, without the unit you don't know if that's 7 kilometers or 7 meters.

In color, we refer to the units as gamut. Gamut is essentially the range of colors that can be reproduced. A device like a DSLR camera might have a very large gamut, being able to capture all the colors in a sunset, but a projector
has a very small gamut and all the colors are going to look "washed out".

In some cases we can correct the device output by altering the data we send to it, but in other cases where that's not possible (you can't print electric blue) we need to show the user what the result is going to look like.

For photographs it makes sense to
use the full tonal range of a color device, to be able to make smooth changes in color. For other graphics, you might want to match the color exactly, which is important if you're trying to print a custom mug with the Red Hat logo that has to be the exact Red Hat Red.

More Information

Color management — Why is this important, Color profiles, How to
calibrate a device...
How do I import color profiles?

The profile can be imported by double clicking on the .ICC or .ICM file in the file browser.

Alternatively you can select Import profile… from System Settings Color when selecting a profile for a
More Information

Color profiles

See Also

How do I assign profiles to devices? — Look in System Settings ▸ Color for the option to change this.

What is a color profile? — A color profile is a simple file that expresses a color space or device response.
What is a color profile?

A color profile is a set of data that characterizes either a device such as a projector or a color space such as sRGB.

Most color profiles are in the form of an ICC profile, which is a small file with a .icc or .icm file extension.
Color profiles can be embedded into images to specify the gamut range of the data. This ensures that users see the same colors on different devices.

Every device that is processing color should have its own ICC profile and when this is achieved the system is said to have an end-to-end color-managed workflow. With this kind of workflow you can be sure that colors are not being lost or
More Information

Color profiles

See Also

Can I share my color profile? — Sharing color profiles is never a good idea as hardware changes over time.

How do I assign profiles to devices? — Look in System Settings ➤ Color for the option to change this.
How do I import color profiles? — Color profiles can be imported by opening them.

What is a color space? — A color space is a defined range of colors.

Where do I get color profiles? — Color profiles are provided by vendors and can be generated yourself.
What is a color space?

A color space is a defined range of colors. Well known color spaces include sRGB, AdobeRGB and ProPhotoRGB.

The human visual system is not a simple RGB sensor, but we can approximate how the eye responds with a CIE 1931 chromaticity.
diagram that shows the human visual response as a horse-shoe shape. You can see that in human vision there are many more shades of green detected than blue or red. With a trichromatic color space like RGB we represent the colors on the computer using three values, which restricts up to encoding a triangle of colors.

Using models such as a CIE
1931 chromaticity diagram is a huge simplification of the human visual system, and real gamuts are expressed as 3D hulls, rather than 2D projections. A 2D projection of a 3D shape can sometimes be misleading, so if you want to see the 3D hull, install `gnome-color-manager` and then run `gcm-viewer`.
First, looking at sRGB, which is the smallest space and can encode the least number of colors. It is an approximation of a 10 year old CRT display, and so most modern monitors can display more colors.
than this. sRGB is a least-common-denominator standard and is used in a large number of applications (including the Internet).

AdobeRGB is frequently used as an editing space. It can encode more colors than sRGB, which means you can change colors in a photograph without worrying too much that the most vivid colors are being clipped or the blacks crushed.
ProPhoto is the largest space available and is frequently used for document archival. It can encode nearly the whole range of colors detected by the human eye, and even encode colors that the eye cannot detect!

Now, if ProPhoto is clearly better, why don't we use it for everything? The answer is to do with quantization. If you only have 8 bits (256 levels) to encode each
channel, then a larger range is going to have bigger steps between each value.

Bigger steps mean a larger error between the captured color and the stored color, and for some colors this is a big problem. It turns out that key colors, like skin colors are very important, and even small errors will make untrained viewers notice that something in a photograph looks wrong.
Of course, using a 16 bit image is going to leave many more steps and a much smaller quantization error, but this doubles the size of each image file. Most content in existence today is 8bpp, i.e. 8 bits-per-pixel.

Color management is a process for converting from one color space to another, where a color space can be a well known defined space like sRGB, or a custom space such as
your monitor or printer profile.

More Information

Color profiles

See Also

What is a color profile? — A color profile is a simple file that expresses a color space or device response.
What's a virtual color managed device?

A virtual device is a color managed device that is not connected to the computer. Examples of this might be:

- An online print-shop where photos are uploaded, printed
and sent to you

- Photos from a digital camera stored on a memory card

To create a virtual profile for a digital camera just drag and drop one of the image files onto the System Settings ➤ Color dialog. You can then assign profiles to it like any other device or even calibrate it.
Why do I need to do calibration myself? — Calibrating is important if you care about the colors you display or print.
Where do I get color profiles?

The best way to get profiles is to generate them yourself, although this does require some initial outlay. Many manufacturers do try to provide color profiles for devices, although sometimes they are wrapped up in *driver bundles* which you may need to download, extract
and then search for the color profiles.

Some manufacturers do not provide accurate profiles for the hardware and the profiles are best avoided. A good clue is to download the profile, and if the creation date is more than a year before the date you bought the device then it's likely dummy data generated that is useless.

See [Why do I need to do calibration](#)
myself? for information on why vendor-supplied profiles are often worse than useless.

More Information
Color profiles

See Also
How do I test if color management is working correctly? — Testing color management isn't hard, and we even supply some test profiles.
Missing information for whole-screen color correction? — Whole-screen color correction modifies all the screen colors on all windows.

What is a color profile? — A color profile is a simple file that expresses a color space or device response.

Why do I need to do calibration myself? — Calibrating is important if you care about the colors you display or print.
Can I share my color profile?

Color profiles that you have created yourself are specific to the hardware and lighting conditions that you calibrated for. A display that has been powered for a few hundred hours is going to have a very different color profile to a similar display with the next serial number.
that has been lit for a thousand hours.

This means if you share your color profile with somebody, you might be getting them closer to calibration, but it's misleading at best to say that their display is calibrated.

Similarly, unless everyone has recommended controlled lighting (no sunlight from windows, black walls, daylight bulbs etc.) in a room where
viewing and editing images takes place, sharing a profile that you created in your own specific lighting conditions doesn't make a lot of sense.

⚠️ You should carefully check the redistribution conditions for profiles downloaded from vendor websites or that were created on your behalf.
More Information

Calibration

See Also

What is a color profile? — A color profile is a simple file that expresses a color space or device response.
How do I calibrate my camera?

Camera devices are calibrated by taking a photograph of a target under the desired lighting conditions. By converting the RAW file to a TIFF file, it can be used to calibrate the camera device in the color control panel.
You will need to crop the TIFF file so that just the target is visible. Ensure the white or black borders are still visible. Calibration will not work if the image is upside-down or is distorted by a large amount.

The resulting profile is only valid under the lighting condition that you acquired the original image from. This means you might need to
profile several times for *studio*, *bright sunlight* and *cloudy* lighting conditions.

---

More Information

Calibration

See Also

*How do I calibrate my printer?* — Calibrating your printer is important to print accurate colors.

*How do I calibrate my scanner?*
— Calibrating your scanner is important to capture accurate colors.

How do I calibrate my screen? — Calibrating your screen is important to display accurate colors.

Which target types are supported? — Calibration targets are needed to do scanner and camera profiling.
How do I calibrate my printer?

There are two ways to profile a printer device:

- Using a photospectrometer device like the Pantone ColorMunki
- Downloading a printing a
Using a color company to generate a printer profile is usually the cheapest option if you only have one or two different paper types. By downloading the reference chart from the companies website you can then send them back the print in a padded envelope where they will scan the paper, generate the profile and email you back an
accurate ICC profile.

Using an expensive device such as a ColorMunki works out cheaper only if you are profiling a large number of ink sets or paper types.

If you change your ink supplier, make sure you recalibrate the printer!
More Information

Calibration

See Also

How do I calibrate my camera? — Calibrating your camera is important to capture accurate colors.

How do I calibrate my scanner? — Calibrating your scanner is important to capture accurate colors.

How do I calibrate my screen? — Calibrating your screen is important to display accurate colors.
How do I calibrate my scanner?

You scan in your target file and save it as an uncompressed TIFF file. You can then click Calibrate… from System Settings ➤ Color to create a profile for the device.
Scanner devices are incredibly stable over time and temperature and do not usually need to be recalibrated.

More Information
Calibration

See Also
How do I calibrate my camera? — Calibrating your camera is important to capture accurate
colors.

How do I calibrate my printer? — Calibrating your printer is important to print accurate colors.

How do I calibrate my screen? — Calibrating your screen is important to display accurate colors.

Which target types are supported? — Calibration targets are needed to do scanner and camera profiling.
How do I calibrate my screen?

Calibrating your screen should be a requirement if you're involved in computer design or artwork.

By using a device called colorimeter you accurately measure the different colors that your screen is
able to display. By running System Settings ▶ Color you can create a profile, and the wizard will show you how to attach the colorimeter device and what settings to adjust.

Screens change all the time - the backlight in a TFT will half in brightness approximately every 18 months, and will get yellower as it gets older. This means you should recalibrate
your screen when the (!) icon appears in the color control panel.

LED screens also change over time, but a much slower rate than TFTs.

More Information

Calibration

See Also
How do I calibrate my camera? — Calibrating your camera is important to capture accurate colors.

How do I calibrate my printer? — Calibrating your printer is important to print accurate colors.

How do I calibrate my scanner? — Calibrating your scanner is important to capture accurate colors.
What color measuring instruments are supported?

GNOME relies on the Argyll color management system to support color instruments. Thus the following display measuring instruments are supported:
- Gretag-Macbeth i1 Pro (spectrometer)
- Gretag-Macbeth i1 Monitor (spectrometer)
- Gretag-Macbeth i1 Display 1, 2 or LT (colorimeter)
- X-Rite i1 Display Pro (colorimeter)
- X-Rite ColorMunki Design or Photo (spectrometer)
- X-Rite ColorMunki Create (colorimeter)
- X-Rite ColorMunki Display (colorimeter)
- Pantone Huey (colorimeter)
- MonacoOPTIX (colorimeter)
- ColorVision Spyder 2 and 3 (colorimeter)
- Colorimètre HCFR
The Pantone Huey is currently the cheapest and best supported hardware in Linux.

Thanks to Argyll there's also a number of spot and strip reading reflective spectrometers supported to help you calibrating and characterizing your printers:
• X-Rite DTP20 "Pulse" ("swipe" type reflective spectrometer)

• X-Rite DTP22 Digital Swatchbook (spot type reflective spectrometer)

• X-Rite DTP41 (spot and strip reading reflective spectrometer)

• X-Rite DTP41T (spot and strip reading reflective
• X-Rite DTP51 (spot reading reflective spectrometer)
What's the difference between calibration and characterization?

Many people are initially confused about the difference between calibration and characterization. Calibration is the process of
modifying the color behavior of a device. This is typically done using two mechanisms:

- Changing controls or internal settings that it has
- Applying curves to its color channels

The idea of calibration is to put a device in a defined state with regard to its color response. Often this is
used as a day to day means of maintaining reproducible behavior. Typically calibration will be stored in device or systems specific file formats that record the device settings or per-channel calibration curves.

Characterization (or profiling) is recording the way a device reproduces or responds to color. Typically the result is stored in a device ICC profile. Such a profile
does not in itself modify color in any way. It allows a system such as a CMM (Color Management Module) or a color aware application to modify color when combined with another device profile. Only by knowing the characteristics of two devices, can a way of transferring color from one device representation to another be achieved.
Note that a characterization (profile) will only be valid for a device if it's in the same state of calibration as it was when it was characterized.

In the case of display profiles there is some additional confusion because often the calibration information is stored in the profile for convenience. By convention it is stored in a tag called the \textit{vcg}t tag.
Although it is stored in the profile, none of the normal ICC based tools or applications are aware of it, or do anything with it. Similarly, typical display calibration tools and applications will not be aware of, or do anything with the ICC characterization (profile) information.
Calibration
Which target types are supported?

The following types of targets are supported:

- CMP DigitalTarget
- ColorChecker 24
- ColorChecker DC
• ColorChecker SG

• i1 RGB Scan 14

• LaserSoft DC Pro

• QPcard 201

• IT8.7/2

You can purchase targets from well-known vendors like KODAK, X-Rite and LaserSoft
in various online shops.

Alternatively you can buy targets from Wolf Faust at a very fair price.

More Information

Calibration

See Also

How do I calibrate my camera? — Calibrating your camera is important to capture accurate
How do I calibrate my scanner? — Calibrating your scanner is important to capture accurate colors.
Why do I need to do calibration myself?

Generic profiles are usually bad. When a manufacturer creates a new model, they just take a few items from the production line and average them together:
Display panels differ quite a lot from unit to unit and change substantially as the display ages. It is also more difficult for printers, as just changing the type or weight of paper can invalidate the characterization state and make the profile inaccurate.

The best way of ensuring the profile
you have is accurate is by doing the calibration yourself, or by letting an external company supply you with a profile based on your exact characterization state.

More Information
Calibration

See Also
Can I get notified when my color profile is inaccurate? — You can be notified if your color profile is
old and inaccurate.

How do I assign profiles to devices? — Look in System Settings ➤ Color for the option to change this.

What's a virtual color managed device? — A virtual device is a color managed device that is not connected to the computer.

Where do I get color profiles? — Color profiles are provided by vendors and can be generated yourself.
Can I get notified when my color profile is inaccurate?

Unfortunately we can't tell without recalibrating whether a device profile is accurate. We can use a simple metric of the amount of time since calibration to determine if a
recalibrate is recommended.

Some companies have very specific timeout policies for profiles, as an inaccurate color profile can make a huge difference to an end product.

If you set the timeout policy and a profile is older than the policy then a red warning triangle will be shown in the System Settings ➤ Color dialog next to the profile. A warning notification will also be shown every
time you log into your computer.

To set the policy for display and printer devices, you specify the maximum age of the profile in days:

```
[rupert@gnome] gsettings set org.gnome.settings-daemon.plugins.color recalibrate-printer-threshold 180
[rupert@gnome] gsettings set org.gnome.settings-daemon.plugins.color recalibrate-display-threshold 180
```
Why do I need to do calibration myself? — Calibrating is important if you care about the colors you display or print.
How do I test if color management is working correctly?

The effects of a color profile are sometimes subtle and it may be hard to see if anything much has changed.
In GNOME we ship several profiles for testing that make it very clear when the profiles are being applied:

- **Bluish Test**: This will turn the screen blue and tests if the calibration curves are being sent to the display

- **ADOBEGAMMA-test**: This will turn the screen pink and tests different features of a screen profile
FakeBRG: This will not change the screen, but will swap around the RGB channels to become BGR. This will make all the colors gradients look mostly correct, and there won't be much difference on the whole screen, but images will look very different in applications that support color management.
Add one of the test profiles to your display device using the System Settings ▶ Color preferences.

Using these profiles you can clearly see when an application supports color management.

More Information

Problems

See Also

Where do I get color profiles? —
Color profiles are provided by vendors and can be generated yourself.
Missing information for whole-screen color correction?

Unfortunately, many vendor-supplied ICC profiles do not include the information required for whole-screen color correction. These
profiles can still be useful for applications that can do color compensation, but you will not see all the colors of your screen change.

In order to create a display profile, which includes both calibration and characterization data, you will need to use a special color measuring instruments called a colorimeter or a spectrometer.
Where do I get color profiles? — Color profiles are provided by vendors and can be generated yourself.
Why don't the default monitor profiles have a calibration expiry?

The default color profile used for each monitor is generated automatically based on the display EDID which is stored in a memory.
chip inside the monitor. The EDID only gives us a snapshot of the available colors the monitor was capable of displaying when it was manufactured, and does not contain much other information for color correction.

As the EDID cannot be updated, it has no expiry date.
Getting a profile from the monitor vendor or creating a profile yourself would lead to more accurate color correction.

More Information

Problems

Where do I get color profiles? — Color profiles are provided by vendors and can be generated yourself.
Why do I need to do calibration myself? — Calibrating is important if you care about the colors you display or print.
Display & screen

Automatically lock your screen
Prevent other people from using your desktop when you go away from your computer.

Change the desktop background
Set an image, color, or gradient as your desktop background.

Change the size or rotation of
the screen
Change the resolution of the screen and its orientation (rotation).

Connect an external monitor to your laptop
Set up dual monitors on your laptop.

Connect an extra monitor
Set up dual monitors on your desktop computer.

Set screen brightness
Dim the screen to save power or increase the brightness to make
it more readable in bright light.

**The screen locks itself too quickly**
Change how long to wait before locking the screen in the Brightness & Lock settings.

---

**More Information**

User & system settings — Keyboard, mouse, display, languages, user accounts…
Automatically lock your screen

When you leave your computer, you should **lock the screen** to prevent other people from using your desktop and accessing your files. You will still be logged in and all your applications will keep running, but you will have to enter your **
password to use your computer again. You can lock the screen manually, but you can also have the screen lock automatically.

1. Click the icon at the very right of the menu bar and select System Settings.

2. Select Brightness & Lock.

3. Make sure Lock is switched on, then select a timeout
from the drop-down list below. The screen will automatically lock after you have been inactive for this long. You can also select Screen turns off to lock the screen after the screen is automatically turned off, controlled with the Turn screen off when inactive for drop-down list above.
More Information

Display & screen — Background, size and rotation, brightness...

See Also

Lock the screen

Set screen brightness — Dim the screen to save power or increase the brightness to make it more readable in bright light.

The screen locks itself too quickly — Change how long to wait before locking the screen in the Brightness & Lock settings.
Change the desktop background

You can change the image used for your desktop background, or set it to a simple color or gradient.

1. Right click on the desktop and select Change Desktop.
Background.

2. Select an image or color. The settings are applied immediately.

There are three choices in the drop-down list on the top right.

- Select **Wallpapers** to use one of the many professional background images that ship with Ubuntu. With the
exception of the Ubuntu wallpaper, all of the default wallpaper choices were created by winners of a Community Wallpaper Contest.

Some wallpapers are partially transparent and allow a background color to show through. For these wallpapers, there will be a color selector button in the bottom-right
corner.

- Select Pictures Folder to use one of your own photos from your Pictures folder. Most photo management applications store photos there.

- Select Colors & Gradients to just use a flat color or a linear gradient. Color selector buttons will appear in the
You can also browse for any picture on your computer by clicking the + button. Any picture you add this way will show up under Pictures Folder. You can remove it from the list by selecting it and clicking the - button. Removing a picture from the list will not delete the original file.
Display & screen — Background, size and rotation, brightness...
Change the size or rotation of the screen

You can change how big (or how detailed) things appear on the screen by changing the screen resolution. You can change which way up things appear (for example, if you have a rotating display) by changing the rotation.
1. Click the icon on the very right of the menu bar and select **System Settings**.

2. Open **Displays**.

3. If you have multiple displays and they are not mirrored, you can have different settings on each display. Select a display in the preview area.
4. Select your desired resolution and rotation.

5. Click Apply. The new settings will be applied for 30 seconds before reverting back. That way, if you cannot see anything with the new settings, your old settings will be automatically restored. If you are happy with the new settings, click Keep This Configuration.
When you use another display, like a projector, it should be detected automatically so you can change its settings in the same way as your usual display. If this does not happen, just click Detect Displays.

Resolution
The resolution is the number of pixels (dots on the screen) in each direction that can be displayed. Each resolution has an aspect ratio, the ratio of the width to the height. Wide-screen displays use a 16:9 aspect ratio, while traditional displays use 4:3. If you choose a resolution that does not match the aspect ratio of your display, the screen will be letterboxed to avoid distortion.
You can choose the resolution you prefer from the Resolution drop-down list. If you choose one that is not right for your screen it may look fuzzy or pixelated.

Rotation

On some laptops, you can physically rotate the screen in many directions. It is useful to be able to change the display rotation. You
can choose the rotation you want for your display from the Rotation drop-down list.

More Information

Display & screen — Background, size and rotation, brightness…

Screen problems — Troubleshoot screen and graphics problems.

See Also

Why do things look fuzzy/pixelated on my screen? —
The screen resolution may be set incorrectly.
Connect an external monitor to your laptop

Set up an external monitor

To set up an external monitor with your laptop, connect the monitor to
your laptop. If your system doesn't recognize it immediately, or you would like to adjust the settings:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Displays.

3. Click on the image of the monitor you would like to activate or deactivate, then
4. By default, the Launcher only shows on the primary monitor. To change which monitor is "primary", change the monitor in the Launcher Placement drop-down box. You could also drag the Launcher in the preview to the monitor you want to set as the "primary" monitor.
If you want the Launcher to show on all monitors, change Launcher Placement to All Displays.

5. To change the "position" of a monitor, click on it and drag it to the desired position.

If you would like both monitors to display the
6. When you are happy with your settings, click Apply and then click Keep This Configuration.

7. To close the Displays click on the x in the top corner.
A typical problem with dual monitors is that it's easy for the mouse pointer to "slip" to the other monitor when you don't want it to. Unity's Sticky Edges feature helps with that problem by requiring you to push a little bit harder to move the mouse pointer from one monitor to the other.

You can switch Sticky Edges off if
you don't like this feature.

More Information

Display & screen — Background, size and rotation, brightness…
Connect an extra monitor

To set up a second monitor with your desktop computer, connect the monitor. If your system doesn't recognize it immediately, or you would like to adjust the settings:

1. Click your name on the menu bar and select
System Settings.

2. Open Displays.

3. Click on the image of the monitor you would like to activate or deactivate, then switch it ON/OFF.

4. The monitor with the menu bar is the main monitor. To change which monitor is "main", click on the top bar.
and drag it over to the monitor you want to set as the "main" monitor.

5. To change the "position" of a monitor, click on it and drag it to the desired position.

If you would like both monitors to display the same content, check
the Mirror displays box.

6. When you are happy with your settings, click Apply and then click Keep This Configuration.

7. To close the Displays click on the x in the top corner.
Display & screen — Background, size and rotation, brightness...
Set screen brightness

You can change the brightness of your screen to save power or to make the screen more readable in bright light. You can also have the screen dim automatically when on battery power and have it turn off automatically when not in use.

Set the brightness
1. Click the icon at the very right of the menu bar and select System Settings.

2. Select Brightness & Lock.

3. Adjust the Brightness slider to a comfortable value.

Many laptop keyboards have special keys to adjust the brightness. These have a
picture that looks like the sun and are located on the function keys at the top. Hold down the *Fn* key to use these keys.

Select Dim screen to save power to have the brightness automatically lowered when you're on battery power. The backlight of your screen can take a lot of power and significantly reduce how long your battery will last before it needs to be
recharged.

The screen will automatically turn off after you haven't used it for a while. This only affects the display, and doesn't turn off your computer. You can adjust how long you have to be inactive with the Turn screen off when inactive for option.

More Information

Display & screen — Background,
size and rotation, brightness...

**Power problems** — Troubleshoot problems with power and batteries.

**Screen problems** — Troubleshoot screen and graphics problems.

**See Also**

**Adjust the contrast** — Make windows and buttons on the screen more (or less) vivid, so they're easier to see.

**Automatically lock your screen** — Prevent other people from using your desktop when you go away from your computer.
Why does my screen go dim after a while? — When your laptop is running on battery, the screen will dim when the computer is idle in order to save power.
The screen locks itself too quickly

If you leave your computer for a few minutes, the screen will automatically lock itself so you have to enter your password to start using it again. This is done for security reasons (so no one can mess with your work if you leave the
computer unattended), but it can be annoying if the screen locks itself too quickly.

To wait a longer period before the screen is automatically locked:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Click Brightness & Lock.
3. Change the value in the Lock screen after drop-down list.

If you don't ever want the screen to lock itself automatically, switch Lock off.

More Information

Display & screen — Background, size and rotation, brightness…
Screen problems — Troubleshoot screen and graphics problems.

See Also

Automatically lock your screen — Prevent other people from using your desktop when you go away from your computer.

Lock the screen
Keyboard

Region & Language

Use alternative input sources — Add input sources and switch between them.

Universal access

Keyboard navigation — Use applications and the desktop without a mouse.

Turn on bounce keys — Ignore quickly-repeated key presses of the same key.
Turn on slow keys — Have a delay between a key being pressed and that letter appearing on the screen.

Turn on sticky keys — Type keyboard shortcuts one key at a time rather than having to hold down all of the keys at once.

Use a screen keyboard — Use an on-screen keyboard to enter text by clicking buttons with the mouse.

Other topics

Make the keyboard cursor blink — Make the insertion point blink
and control how quickly it blinks.

**Set keyboard shortcuts** — Define or change keyboard shortcuts in Keyboard settings.

**Turn off repeated key presses** — Make the keyboard not repeat letters when you hold down a key, or change the delay and speed of repeat keys.

**Useful keyboard shortcuts** — Get around the desktop using the keyboard.

**What is the "Super" key?** — The Super key provides access to the Dash and the Launcher.
More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...

User & system settings — Keyboard, mouse, display, languages, user accounts...
Use alternative input sources

Keyboards come in hundreds of different layouts for different languages. Even for a single language, there are often multiple keyboard layouts, such as the Dvorak layout for English. You can make your keyboard behave like a keyboard with a different layout,
regardless of the letters and symbols printed on the keys. This is useful if you often switch between multiple languages.

Some languages, such as Chinese or Korean, require a more complex input method than just a simple key to character mapping. Consequently some of the input sources you can choose between enable such a method.
Options with input methods are only available if respective input method (IM) engine is installed. When you **install a language**, a suitable IM engine is automatically installed if applicable. For example, if you install Korean, the package `ibus-hangul` is installed, and the input source option Korean (Hangul) is made available next time you log in. You can also
install the IBus IM engine of your choice separately.

**Add input sources**

You can preview an image of any layout by selecting it in the list and clicking 📷.

1. Click the icon at the very right of the menu bar and
select System Settings.

2. In the Personal section, click Text Entry.

3. Click the + button, select an input source, and click Add.

The default source is the source at the top of the list. Use the ↑ and ↓ buttons to move sources up and down in the list.
If you select a source with an input method, you can click % to access that method's preferences dialog if any.

**Input source indicator**

You can quickly switch between selected sources using the input source indicator in the menu bar. The menu will display a short
identifier for the current source, such as En for the standard English layout or a symbol in case of a source that uses a special input method, e.g. Chinese (Chewing). Click the input source indicator and select from the menu the source you want to use.

**Keyboard shortcuts**

You can also use keyboard
shortcuts to quickly switch between your selected input sources. By default the shortcut for switching to next source is **Super** + **Space**, but you can change it:

1. Click the icon at the very right of the menu bar and select **System Settings**.
2. In the Personal section, click **Text Entry**.
3. Click the current shortcut definition below the label Switch to next source using.

4. When the shortcut definition has changed to New accelerator..., press the keys you want to use as the new shortcut.

Set input source for all windows or individually
When you use multiple sources, you can choose to have all windows use the same source or to set a different source for each window. Using a different source for each window is useful, for example, if you're writing an article in another language in a word processor window. Your input source selection will be remembered for each window as you switch between...
windows.

By default, new windows will use the default input source. You can instead choose to have them use the source of the window you were last using.

More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…
Text Entry

See Also

Enter special characters — Type characters not found on your keyboard, including foreign alphabets, mathematical symbols, and dingbats.

Set keyboard shortcuts — Define or change keyboard shortcuts in Keyboard settings.
Keyboard navigation

This page details keyboard navigation for people who cannot use a mouse or other pointing device, or who want to use a keyboard as much as possible. For keyboard shortcuts that are useful to all users, see Useful keyboard shortcuts instead.
If you cannot use a pointing device like a mouse, you can control the mouse pointer using the numeric keypad on your keyboard. See "Click and move mouse pointer using the keypad" for details.

Navigate user interfaces

Tab and Move key focus bet
different controls. 

Ctrl + moves between groups of controls, as from a sidebar to main content. Ctrl + can also l
out of a control that uses Tab itself, such as a text area. Hold down Shift to move focus in reverse order. Arrow keys move selection. Tab it. Move selection out of a control.
between items in a single control, or among a set of related controls. Use the arrow keys to focus buttons in a toolbar, select items in a list or icon view, or
select a radio button from a group.

In a tree view, use the left and right keys to collapse and expand items with children.
**Ctrl + Arrow keys**

In a list or icon view, move the keyboard focus to another item without changing which item is selected.

---

**Shift + Arrow keys**

In a list or icon view, select all items from...
Activate a focused item such as a button, checkbox, or list item.
In a list or icon view, select or deselect the focused item without deselecting other items.

Hold down the Alt key to reveal.
accelerators underlined letters on menu items, buttons, and other controls. Press Alt plus the underlined letter to activate a control, just
if you had clicked on it.

Exit a menu, popup, switcher, or dialog window.

Esc

F10

Open the menu on menu bar.
window. Use the arrow keys to navigate the menus.

Shift + F10 or the Menu key Pop up the context menu for the current selection, as if you had right-clicked.
In the file manager, pop up the context menu for the current folder as if you right-click the background and not on any item.
In a tabbed interface, switch to the tab to the left or right.

Navigate the desktop

Quickly switch between windows.
for reverse order.

Switch between windows from the same application, or from the selected application.

Alt + `
This shortcut uses US keyboards, where the key is above other keyboards, the shortcut is
Whatever key is above Ctrl + Alt + Arrow keys

Navigate windows

Alt + F4
Ctrl + Super + ↓

Alt + F7
Alt + F8
Ctrl + Alt + Shift + Arrow keys
Ctrl + Super + ↑

Ctrl + Super + ←

Ctrl + Super + →
Alt + Space
More Information

**Keyboard** — Input sources, cursor blinking, super key, keyboard accessibility…

**Mobility impairments**

See Also

**Useful keyboard shortcuts** — Get around the desktop using the keyboard.
Turn on bounce keys

Turn on *bounce keys* to ignore key presses that are rapidly repeated. For example, if you have hand tremors which cause you to press a key multiple times when you only want to press it once, you should turn on bounce keys.
1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Universal Access and select the Typing tab.

3. Switch Bounce Keys on.

Use the Acceptance delay slider to change how long bounce keys waits before it registers another key press.
after you pressed the key for the first time. Select Beep when a key is rejected if you want the computer to make a sound each time it ignores a key press because it happened too soon after the previous key press.

More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

Mobility impairments
Turn on slow keys

Turn on slow keys if you would like there to be a delay between pressing a key and that letter being displayed on the screen. This means that you have to hold down each key you want to type for a little while before it appears. Use slow keys if you accidentally press
several keys at a time when you type, or if you find it difficult to press the right key on the keyboard first time.

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Universal Access and select the Typing tab.

3. Switch Slow Keys on.
Quickly turn slow keys on and off

Under Enable by Keyboard, select Turn on accessibility features from the keyboard to turn slow keys on and off from the keyboard. When this option is selected, you can press and hold **Shift** for eight seconds to enable or disable slow keys.
Use the Acceptance delay slider to control how long you have to hold a key down for it to register.

You can have your computer make a sound when you press a key, when a key press is accepted, or when a key press is rejected because you didn't hold the key down long enough.
Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

Mobility impairments
Turn on sticky keys

Sticky keys allows you to type keyboard shortcuts one key at a time rather than having to hold down all of the keys at once. For example, the **Alt + Tab** shortcut switches between windows. Without sticky keys turned on, you would have to hold down both keys
at the same time; with sticky keys turned on, you would press \texttt{Alt} and then \texttt{Tab} to do the same.

You might want to turn on sticky keys if you find it difficult to hold down several keys at once.

1. Click the icon at the very right of the menu bar and select \textit{System Settings}.

2. Open \textit{Universal Access} and
select the Typing tab.

3. Switch Sticky Keys on.

Quickly turn sticky keys on and off

Under Enable by Keyboard, select Turn on accessibility features from the keyboard to turn sticky keys on and off from the keyboard. When this option is selected, you can
press **Shift** five times in a row to enable or disable sticky keys.

If you press two keys at once, you can have sticky keys turn itself off temporarily to let you enter a keyboard shortcut in the normal way.

For example, if you have sticky keys turned on but press **Alt** and **Tab** simultaneously, sticky keys
would not wait for you to press another key if you had this option turned on. It *would* wait if you only pressed one key, however. This is useful if you are able to press some keyboard shortcuts simultaneously (for example, keys that are close together), but not others.

Select Disable if two keys are pressed together to enable this.

You can have the computer make a
"beep" sound when you start typing a keyboard shortcut with sticky keys turned on. This is useful if you want to know that sticky keys is expecting a keyboard shortcut to be typed, so the next key press will be interpreted as part of a shortcut. Select **Beep** when a modifier key is pressed to enable this.
Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

Mobility impairments
Use a screen keyboard

If you don't have a keyboard attached to your computer or prefer not to use it, you can turn on the **screen keyboard** to enter text.

1. Click the icon at the very right of the menu bar and select **System Settings**.
2. Open Universal Access and select the Typing tab.

3. Switch on Typing Assistant to show the screen keyboard.

More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

Mobility impairments
Make the keyboard cursor blink

If you find it difficult to see the keyboard cursor in a text field, you can make it blink to make it easier to locate.

1. Click the icon at the far right
of the menu bar and select System Settings.

2. In the Hardware section, click Keyboard.

3. Select Cursor blinks in text fields.

4. Use the Speed slider to adjust how quickly the cursor blinks.
More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility...

Visual impairments
Set keyboard shortcuts

To change the key or keys to be pressed for a keyboard shortcut:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Keyboard and select
3. Select a category in the left pane, and the row for the desired action on the right. The current shortcut definition will change to New accelerator…

4. Hold down the desired key combination, or press Backspace to clear.
To create your own keyboard shortcut:

1. Select Custom Shortcuts in the left pane, and click the button (or click the button in any category). The Custom Shortcut window will appear.
2. Type a Name to identify the shortcut, and a Command to run an application, then click Apply. For example, if you wanted the shortcut to open Rhythmbox, you could name it Music and use the rhythmbox command.

3. Click Disabled in the row that was just added. When it changes to New
accelerator…, hold down the desired shortcut key combination.

The command name that you type should be a valid system command. You can check that the command works by opening a Terminal and typing it in there. The command that opens an application may not have exactly the same name as the application itself.
If you want to change the command that is associated with a custom keyboard shortcut, double-click the name of the shortcut. The Custom Shortcut window will appear, and you can edit the command.

More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

See Also
Use alternative input sources — Add input sources and switch between them.

**Useful keyboard shortcuts** — Get around the desktop using the keyboard.
Turn off repeated key presses

By default, when you hold down a key on your keyboard, the letter or symbol will be repeated until you release the key. If you have difficulty picking your finger back up quickly enough, you can disable this feature, or change how long it takes.
before key presses start repeating.

1. Click the icon at the very right of the menu bar and select System Settings.

2. In the Hardware section, click Keyboard.

3. Turn off Key presses repeat when key is held down to disable repeated keys entirely.
Alternatively, adjust the Delay slider to control how long you have to hold a key down to begin repeating it, and adjust the Speed slider to control how quickly key presses repeat.

More Information

Keyboard — Input sources, cursor blinking, super key,
keyboard accessibility…

Mobility impairments
What is the "Super" key?

This key can usually be found on the bottom-left of your keyboard, next to the Alt key, and usually has a window/squares icon on it. It is sometimes called the Windows key, logo key, or system key.

If you have an Apple keyboard,
there will not be a Windows key on your keyboard. The ⌘ (Command) key can be used instead.

The Super key serves a special function in *Unity*. If you press the Super key, the Dash is displayed. If you press *and hold* the Super key, an overlay showing many of Unity's keyboard shortcuts appears until you release the Super key.
The Super key can help you do even more than that, though. To learn about more uses for the Super key, see the keyboard shortcuts page.

---

More Information

Keyboard — Input sources, cursor blinking, super key, keyboard accessibility…

See Also

Useful keyboard shortcuts — Get
around the desktop using the keyboard.
Mouse

Adjust speed of the mouse and touchpad
Change how quickly the pointer moves when you use your mouse or touchpad.

Adjust the double-click speed
Control how quickly you need to press the mouse button a second time to double-click.

Click and move mouse pointer using the keypad
Enable mouse keys to control the...
Enable mouse keys to control the mouse with the keypad.

**Click, drag, or scroll with the touchpad**
Click, drag, or scroll using taps and gestures on your touchpad.

**Disable touchpad while typing**
Turn the touchpad off while typing to prevent accidental clicks.

**Simulate a right mouse click**
Press and hold the left mouse button to right-click.

**Simulate clicking by hovering**
The Hover Click (Dwell Click)
The Hover Click (Dwell Click) feature allows you to click by holding the mouse still.

**Use your mouse left-handed**
Reverse the left and right mouse buttons in the mouse settings.

**Common problems**

**Mouse pointer is not moving**
How to check your mouse if it is not working.
Mouse reacts with delay before it starts working

If you have to wiggle or click the mouse before it responds.

Tips

Middle-click

Use the middle mouse button to open applications, paste text, open tabs, and more.
More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks…

User & system settings — Keyboard, mouse, display, languages, user accounts…
Adjust speed of the mouse and touchpad

If your pointer moves too fast or slow when you move your mouse or use your touchpad, you can adjust the pointer speed for these devices.

1. Click the icon at the very
right of the menu bar and select System Settings.

2. Open Mouse & Touchpad.

3. Adjust the Pointer Speed slider until the pointer motion is comfortable for you.

You can set the pointer speed differently for your mouse and
touchpad. Sometimes the most comfortable settings for one type of device aren't the most comfortable for another. Just set the sliders on both the Mouse and Touchpad sections.

The Touchpad section only appears if your system has a touchpad.
More Information

Mobility impairments

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...
Adjust the double-click speed

Double-clicking only happens when you press the mouse button twice quickly enough. If the second press is too long after the first, you'll just get two separate clicks, not a double click. If you have difficulty pressing the mouse button quickly,
you should increase the timeout.

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Mouse & Touchpad.

3. Under General, adjust the Double-click slider to a value you find comfortable.

4. Click the Test Your Settings
button to test. A single click in the window will highlight the outer circle. A double-click will highlight the inside circle.

If your mouse double-clicks when you want it to single-click even though you have increased the double-click timeout, your mouse may be faulty. Try plugging a different mouse into your computer
and see if that works properly. Alternatively, plug your mouse into a different computer and see if it still has the same problem.

This setting will affect both your mouse and touchpad, as well as any other pointing device.
Mobility impairments

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...
Click and move mouse pointer using the keypad

If you have difficulties using a mouse or other pointing device, you can control the mouse pointer using the numeric keypad on your keyboard. This feature is called
1. Tap the Super key to open the Dash.

2. Type Universal Access and press Enter to open the Universal Access settings.

3. Press Tab once to select the Seeing tab.

4. Press ← once to switch
to the Pointing and Clicking tab.

5. Press ↓ once to select the Mouse Keys switch then press Enter to switch it on.

6. Make sure that Num Lock is turned off. You will now be able to move the mouse pointer using the keypad.
These instructions provide the shortest way to enable mouse keys using only the keyboard. Select Universal Access Settings to see more accessibility options.

The keypad is a set of numerical buttons on your keyboard, usually arranged into a square grid. If you have a keyboard without a keypad (such as a laptop keyboard), you
may need to hold down the function (Fn) key and use certain other keys on your keyboard as a keypad. If you use this feature often on a laptop, you can purchase external USB keypads.

Each number on the keypad corresponds to a direction. For example, pressing 8 will move the pointer upwards and pressing 2 will move it downwards. Press the 5 key to click once with the
mouse, or quickly press it twice to double-click.

Most keyboards have a special key which allows you to right-click; it is often near to the space bar. Note, however, that this key responds to where your keyboard focus is, not where your mouse pointer is. See Simulate a right mouse click for information on how to right-click by holding down 5 or the left mouse button.
If you want to use the keypad to type numbers while mouse keys is enabled, turn **Num Lock** on. The mouse cannot be controlled with the keypad when **Num Lock** is turned on, though.

**Tip:** The normal number keys, in a line at the top of the keyboard, will not control the mouse pointer. Only the keypad number keys can be used.
More Information

Mobility impairments

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...

See Also

Disable touchpad while typing — Turn the touchpad off while typing to prevent accidental clicks.
Click, drag, or scroll with the touchpad

You can click, double-click, drag, and scroll using only your touchpad, without separate hardware buttons.

1. Click the icon at the very right of the menu bar and
select System Settings.

2. Open Mouse & Touchpad.

3. In the Touchpad section, check Tap to click.

The Touchpad section only appears if your system has a touchpad.

- To click, tap on the touchpad.
- To double-click, tap twice.

- To drag an item, double-tap but don't lift your finger after the second tap. Drag the item where you want it, then lift your finger to drop.

- If your touchpad supports multi-finger taps, right-click by tapping with two fingers at once. Otherwise, you still
need to use hardware buttons to right-click. See Simulate a right mouse click for a method of right-clicking without a second mouse button.

- If your touchpad supports multi-finger taps, middle-click by tapping with three fingers at once.

When tapping or dragging with
multiple fingers, make sure your fingers are spread far enough apart. If your fingers are too close, your computer may think they're a single finger.

**Two finger scroll**

You can scroll using your touchpad using two fingers.
1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Mouse & Touchpad.

3. In the Touchpad section, check Two finger scroll.

When this is selected, tapping and dragging with one finger will work as normal, but if you drag two fingers
across any part of the touchpad, it will scroll instead. If you also select Enable horizontal scrolling, you can move your fingers left and right to scroll horizontally. Be careful to space your fingers a bit apart. If your fingers are too close together, they just look like one big finger to your touchpad.

Two-finger scrolling may not work on all touchpads.
Content sticks to fingers

You can drag content as if sliding a physical piece of paper using the touchpad.

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Mouse & Touchpad.
3. In the Touchpad section, check Content sticks to fingers.

This feature is also known as Natural Scrolling or Reverse Scrolling.

More Information

Mouse — Left-handed, speed and sensitivity, touchpad clicking
and scrolling...

See Also

What are overlay scrollbars? — Overlay scrollbars are the thin orange strips on long documents.
Disable touchpad while typing

Touchpads on laptops are often located where you rest your wrist while typing, which can sometimes cause accidental clicks while you type. You can disable the touchpad while you type. It will only work again a short time after your last
key stroke.

1. Click the icon at the very right of the menu bar and select **System Settings**.

2. Open **Mouse & Touchpad**.

3. In the **Touchpad** section, check **Disable while typing**.

The Touchpad section only
More Information

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...

See Also

Click and move mouse pointer using the keypad — Enable mouse keys to control the mouse with the keypad.
Simulate a right mouse click

You can right-click by holding down the left mouse button. This is useful if you find it difficult to move your fingers individually on one hand, or if your pointing device only has a single button.

1. Click your name on the
menu bar and select System Settings.

2. Open Universal Access and select the Pointing and Clicking tab.

3. Switch Simulated Secondary Click on.

You can change how long you must hold down the left mouse button before it is registered as a right
click. On the Pointing and Clicking tab, change the Acceptance delay under Simulated Secondary Click.

To right-click with simulated secondary click, hold down the left mouse button where you would normally right-click, then release. The pointer fills with blue as you hold down the left mouse button. Once it is entirely blue, release the mouse button to right-click.
Some special pointers, such as the resize pointers, do not change colors. You can still use simulated secondary click as normal, even if you don't get visual feedback from the pointer.

If you use **Mouse Keys**, this also allows you to right-click by holding down the 5 key on your keypad.
are always able to long-press to right-click, even with this feature disabled. Long-press works slightly differently in the overview: You do not have to release the button to right-click.

More Information

Mobility impairments
Mouse — Left-handed, speed
and sensitivity, touchpad clicking and scrolling...
Simulate clicking by hovering

You can click or drag simply by hovering your mouse pointer over a control or object on the screen. This is useful if you find it difficult to move the mouse and click at the same time. This feature is called Hover Click or Dwell Click.
When Hover Click is enabled, you can move your mouse pointer over a control, let go of the mouse, and then wait for a while before the button will be clicked for you.

1. Click your name on the menu bar and select System Settings.

2. Open Universal Access and select the Pointing and
Clicking tab.

3. Switch Hover Click on.

The Hover Click window will open, and will stay above all of your other windows. You can use this to choose what sort of click should happen when you hover. For example, if you select Secondary Click, you will right-click when you hover. After you double-click, right-click, or drag, you will be
automatically returned to clicking.

When you hover your mouse pointer over a button and don't move it, it will gradually change color. When it has fully changed color, the button will be clicked.

Adjust the Delay setting to change how long you have to hold the mouse pointer still before clicking.

You don't need to hold the mouse
perfectly still when hovering to click. The pointer is allowed to move a little bit and will still click after a while. If it moves too much, however, the click will not happen.

Adjust the Motion threshold setting to change how much the pointer can move and still be considered to be hovering.
Mobility impairments

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...
Use your mouse left-handed

You can swap the behavior of the left and right buttons on your mouse or touchpad to make it more comfortable for left-handed use.

1. Click the icon at the very
right of the menu bar and select System Settings.

2. Open Mouse & Touchpad.

3. In the General section, switch Primary button to Right.

This setting will affect both your mouse and touchpad, as well as any other pointing
More Information

Mouse — Left-handed, speed and sensitivity, touchpad clicking and scrolling...
Mouse pointer is not moving

Check that the mouse is plugged in
Check that the mouse was recognized by your computer
Check that the mouse actually works
Checking wireless mice
Check that the mouse is plugged in

If you have a mouse with a cable, check that it is firmly plugged in to your computer.

If it is a USB mouse (with a rectangular connector), try plugging it in to a different USB port. If it is a PS/2 mouse (with a small, round connector with six pins), make sure that it is plugged in to the green
mouse port rather than the purple keyboard port. You may need to restart the computer if it was not plugged in.

Check that the mouse was recognized by your computer

1. Type Ctrl + Alt + T to open the Terminal.
2. In the terminal window, type

```
xsetpointer -l | grep Pointer
```

exactly as it appears here, and press Enter.

3. A short list of mouse devices will appear. Check that at least one of the items says

```
[XExtensionPointer]
```

to it, and that one of the
The [XExtensionPointer] items have the name of the mouse to the left of it.

4. If there is no entry that has the name of the mouse followed by [XExtensionPointer], then the mouse was not recognized by your computer. If the entry exists, your mouse was
recognized by your computer. In this case you should check that the mouse is **plugged in** and in **working condition**.

If your mouse has a serial (RS-232) connector, you may need to perform some extra steps to get it working. The steps might depend on the make or model of your mouse.

It can be complicated to fix
problems with mouse detection. Ask for support from your distribution or vendor if you think that your mouse has not been detected properly.

Check that the mouse actually works

Plug the mouse in to a different computer and see if it works.

If the mouse is an optical or laser mouse, a light should be shining out
of the bottom of the mouse if it is turned on. If there is no light, check that it is turned on. If it is and there is still no light, the mouse may be broken.

Checking wireless mice

- Make sure the mouse is turned on. There is often a switch on the bottom of the mouse to turn the mouse off
completely, so you can move it from place to place without it constantly waking up.

- If you are using a Bluetooth mouse, make sure you have actually paired the mouse with your computer. See Connect your computer to a Bluetooth device.

- Click a button and see if the mouse pointer moves now.
Some wireless mice go to sleep to save power, so might not respond until you click a button. See *Mouse reacts with delay before it starts working.*

- Check that the battery of the mouse is charged.
- Make sure that the receiver (dongle) is firmly plugged in to the computer.
• If your mouse and receiver can operate on different radio channels, make sure that they are both set to the same channel.

• You may need to press a button on the mouse, receiver or both to establish a connection. The instruction manual of your mouse should have more details if this is the case.
Most RF (radio) wireless mice should work automatically when you plug them into your computer. If you have a Bluetooth or IR (infrared) wireless mouse, you may need to perform some extra steps to get it working. The steps might depend on the make or model of your mouse.

More Information

Common mouse problems
Mouse reacts with delay before it starts working.

Wireless and optical mice, as well as touchpads on laptops, may need to "wake up" before they start working. They automatically go to sleep when not in use to save...
battery power. To wake up your mouse or touchpad, you can click on a mouse button or wiggle the mouse.

Laptop touchpads sometimes react with delay after you stop typing before they start working. This is to prevent you from accidentally touching the touchpad with your palm while typing. See Disable touchpad while typing for details.
More Information

Common mouse problems
Middle-click

Many mice and some touchpads have a middle mouse button. On a mouse with a scroll wheel, you can usually press directly down on the scroll wheel to middle-click. If you don't have a middle mouse button, you can press the left and right mouse buttons at the same time to middle-click. If you find you are unable to middle-click this way you
can try following these instructions.

On touchpads that support multi-finger taps, you can tap with three fingers at once to middle-click. You have to **enable tap clicking** in the touchpad settings for this to work.

Many applications use middle-click for advanced click shortcuts.

- One common shortcut is to paste selected text. (This is
sometimes called primary selection paste.) Select the text you want to paste, then go to where you want to paste it and middle-click. The selected text is pasted at the mouse position.

Pasting text with your middle mouse button is completely separate from the normal clipboard. Selecting text does not copy it to your clipboard.
This quick method of pasting only works with the middle mouse button.

- On scrollbars and sliders, a regular click in the empty space moves by a set amount (such as one page) in the direction you clicked. You can also middle-click in the empty space to move to exactly the location you clicked.
• You can quickly open a new window for an application with middle-click. Simply middle-click on the application's icon, either in the Launcher on the left, or in the Dash.

• Most web browsers allow you to open links in tabs quickly with the middle mouse button. Just click any link with your middle mouse button, and it will open in a new tab. Be
careful clicking the link in the Firefox web browser, though. In Firefox, if you middle-click anywhere except on a link, it will try to load your selected text as a URL, as if you used middle-click to paste it to the location bar and pressed Enter.

- In the file manager, middle-click serves two roles. If you middle-click a folder, it will
open in a new tab. This mimics the behavior of popular web browsers. If you middle-click a file, it will open the file, just as if you had double-clicked.

Some specialized applications allow you to use the middle mouse button for other functions. Search your application's help for *middle-click* or *middle mouse button*. 
More Information

Mouse tips

Tips & tricks — Special characters, middle click shortcuts...
Online accounts

You can enter your login details for online services, such as Google and Facebook, into the Online Accounts application. This will let you access your calendar, mail, chat accounts, and similar applications without having to enter your account details again.
Add an account
Connect to online accounts

Disable account services
Some online accounts allow you to use multiple services (like calendar and email). You can control which of these services can be used by local applications.

Remove an account
Remove online account services

Which applications take advantage of online accounts?
Applications can use the accounts created in Online
Accounts and the services they exploit.

Why is my account type not on the list?
Why aren't service providers listed?

Why should I add an account?
Why add your email or social media accounts to your desktop?

More Information
User & system settings — Keyboard, mouse, display,
languages, user accounts...
Add an account

Adding an account will help link your online accounts with your Ubuntu desktop. Thus, your email, chat, and other related applications will be set up for you.

1. Click the icon at the very right of the menu bar and select System Settings.
2. Select Online Accounts.

3. Select an Account Type from the right hand windowpane.

If you want to configure more accounts, you can repeat this process afterwards.
4. A small web user interface will open where you can enter your online account credentials. For example, if you are setting up a Google account, enter your Google username, password and sign in.

5. If you entered your credentials correctly, you will be prompted to accept the terms. Select Accept to
continue. Once accepted, Ubuntu needs permission to access your account. To allow access, click on the Grant Access button. When prompted, enter the current user's password.

6. Now you can select the applications you want linked to your online account. For example, if you want to use an online account for chat,
but do not want the calendar, turn the calendar option off.

After you have added the accounts, each application you have selected will automatically use those credentials when you log into your account.

For security reasons, Ubuntu will not store your password on
your computer. Instead, it stores a token that is provided by the online service. If you want to fully revoke the link between your desktop and the online service, remove it.

More Information

Online accounts — Add accounts, Remove accounts, Disable services
Disable account services

Some types of online accounts allow access to several services from a single user account. For example, Google accounts provide access to email, calendar, code, contacts, among others. You can choose Google for email and Yahoo! for
chat, or any combination the service provider allows.

To disable services:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Select Online Accounts.

3. Select the account you want to change from left
windowpane.

4. Services available for this account are listed in the right windowpane.

5. Switch off the services you do not want used.

Once a service has been disabled, local applications no longer have access to it. To
regain access, go back into Online Accounts and switch it on.

More Information

Online accounts — Add accounts, Remove accounts, Disable services

See Also

Remove an account — Remove online account services
Remove an account

1. Click the icon at the very right of the menu bar and select System Settings.

2. Select Online Accounts.

3. From the left windowpane, select the account you wish
4. Click the **Remove Account** button in the lower-right portion of the window.

Removing the selection from *Online Accounts* in no way affects the account from your service provider.
5. Click Remove.

Instead of deleting the account completely, you can restrict the service from being accessed by your desktop.

More Information

Online accounts — Add accounts, Remove accounts, Disable services
See Also

Disable account services — Some online accounts allow you to use multiple services (like calendar and email). You can control which of these services can be used by local applications.
Which applications take advantage of online accounts?

*Online Accounts* can be used by external applications to automatically configure themselves.
With a Google account

- *Evolution*, the email application. Your email account will be added to *Evolution* automatically, so it will retrieve your mail, give you access to your contacts, and display your calendar items in your Google agenda.

- *Empathy*, the instant messaging application. Your
online account will be added and you will be able to communicate with your friends.

- **Contacts**, which will allow you to see and edit your contacts.

- **Documents** can access your online documents and display them.
With Windows Live, Facebook or Twitter accounts

*Empathy* can use these accounts to connect you online and chat with your contacts, friends, and followers.

With a SkyDrive account

*Documents* can access your online
documents in Microsoft SkyDrive and display them.

With a Exchange account

Once you have created an Exchange account, Evolution will start retrieving mails from this account.

With a ownCloud
account

When an ownCloud account is set up, *Evolution* is able to access and edit contacts and calendar appointments.

*Files* and other applications will be able to list and access your online files stored in the ownCloud installation.
More Information

Online accounts — Add accounts, Remove accounts, Disable services
Why is my account type not on the list?

Support for your favorite online service provider needs someone to develop it. Currently, the following types of online accounts are supported:
<table>
<thead>
<tr>
<th>Facebook</th>
<th>Flickr</th>
<th>Google</th>
</tr>
</thead>
<tbody>
<tr>
<td>Twitter</td>
<td>AIM</td>
<td>Windows Live</td>
</tr>
<tr>
<td>Salut</td>
<td>Jabber</td>
<td>Yahoo</td>
</tr>
</tbody>
</table>

If you're interested in adding support for other services, contact the developers on the [bug tracker](#).
More Information

Online accounts — Add accounts, Remove accounts, Disable services
Why should I add an account?

Adding your accounts brings a choice of services like calendar, chat, and e-mail straight to your desktop, making services a seamless part of your user experience. By adding accounts, you can keep in touch with services
of different accounts, like chats, at the same time. Just set your account once and every time you start your computer all the accounts and services you've added will be ready for you.

More Information

**Online accounts** — Add accounts, Remove accounts, Disable services
Power & battery

Get the most out of your laptop battery
Tips such as "Do not let the battery charge get too low"

How do I hibernate my computer?
Hibernate is disabled by default since it's not well supported.

Log out, power off, switch
users
Learn how to leave your user account, by logging out, switching users, and so on.

Use less power and improve battery life
Tips to reduce the power consumption of your computer.

What happens when I suspend my computer?
Suspend sends your computer to sleep so it uses less power.

Why does my computer turn off when I close the lid?
Laptops go to sleep when you close the lid, in order to save power.

**Battery settings**

**The estimated battery life is wrong**

The battery life displayed when you click on the battery icon is an estimate.

**Why did my computer turn off/suspend when the battery got to 10%?**

Allowing the battery to completely
Allowing the battery to completely discharge is bad for it.

Why do I have less battery life than I did on Windows/Mac OS?

Tweaks from the manufacturer and differing battery life estimates may be the cause of this problem.
Why does my screen go dim after a while?
When your laptop is running on battery, the screen will dim when the computer is idle in order to save power.

Why is my laptop slow when it is on battery?
Some laptops intentionally slow down when they are running on battery.

Problems
An error reports my battery has low capacity

I have no wireless network when I wake up my computer

My computer gets really hot

My computer will not turn on

Set screen brightness

The laptop fan is always running

Why won't my computer turn back on after I suspended it?

Will my computer work with a power supply in another country?

More Information
Hardware problems

More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...

User & system settings — Keyboard, mouse, display, languages, user accounts...
Get the most out of your laptop battery

As laptop batteries age, they get worse at storing charge and their capacity gradually decreases. There are a few techniques that you can use to prolong their useful lifetime, although you should not expect a big difference.
• Do not let the battery run all the way down. Always recharge *before* the battery gets very low, although most batteries have built-in safeguards to prevent the battery running too low. Recharging when it is only partially discharged is more efficient, but recharging when it is only slightly discharged is worse for the battery.
• Heat has a detrimental effect on the charging efficiency of the battery. Do not let the battery get any warmer than it has to.

• Batteries age even if you leave them in storage. There is little advantage in buying a replacement battery at the same time as you get the original battery - always buy replacements when you need
This advice applies specifically to Lithium-Ion (Li-Ion) batteries, which are the most common type. Other types of battery may benefit from different treatment.
energy savings, power off, screen dimming…

See Also

An error reports my battery has low capacity — Your battery is probably not broken; it's more likely that it's just old.
How do I hibernate my computer?

When the computer *hibernates*, all of your applications and documents are stored and the computer completely switches off so it does not use any power, but the applications and documents will still be open when you switch on the
computer again.

Unfortunately, hibernate doesn't work in many cases, which can cause you to lose data if you expect your documents and applications to re-open when you switch your computer back on. Therefore, hibernate is disabled by default.

Test if hibernate works

Always save your work
before hibernating

You should save all of your work before hibernating the computer, just in case something goes wrong and your open applications and documents cannot be recovered when you switch on the computer again.

You can use the command line to test if hibernate works on your
1. Open the *Terminal* by searching for *terminal* in the Activities overview.

2. Type `sudo pm-hibernate` into the terminal and press Enter.

Enter your password when prompted.
3. After you computer turns off, switch it back on. Did your open applications re-open?

If hibernate doesn't work, check if your swap partition is at least as large as your available RAM.

Enable hibernate
If the hibernate test works, you can continue to use the `sudo pm-hibernate` command when you want to hibernate.

You can also enable the hibernate option in the menus. To do that, use your favorite text editor to create `/etc/polkit-1/localauthority/50-local.d/com.ubuntu.enable-hibernate.pkla`. Add the following to the file and save:
[Re-enable hibernate by default in upower]
Identity=unix-user:*
Action=org.freedesktop.upower.hibernate
ResultActive=yes

[Re-enable hibernate by default in logind]
Identity=unix-user:*
Action=org.freedesktop.login1.hibernate;org.freedesktop.login1.hibernate-multiple-sessions
ResultActive=yes

More Information
Power & battery — Suspend, energy savings, power off, screen dimming...

See Also
Log out, power off, switch users — Learn how to leave your user account, by logging out, switching users, and so on.

Use less power and improve battery life — Tips to reduce the power consumption of your computer.

Why won't my computer turn back on after I suspended it? — Some computer hardware causes problems with suspend or hibernate.
Use less power and improve battery life

Computers can use a lot of power. By using some simple energy-saving strategies, you can reduce your energy bill and help the environment. If you have a laptop, this will also help to increase the amount of time it can run on battery.
General tips

- **Suspend your computer** when you are not using it. This significantly reduces the amount of power it uses, and it can be woken up very quickly.

- **Turn off** the computer when you will not be using it for
longer periods. Some people worry that turning off a computer regularly may cause it to wear out faster, but this is not the case.

• Use the Power preferences in System Settings to change your power settings. There are a number of options that will help to save power: you can automatically dim the display after a certain time;
reduce the display brightness (for laptops); and have the computer automatically suspend if you have not used it for a certain period of time.

- Turn off any external devices (like printers and scanners) when you are not using them.

Laptops, netbooks, and other devices with
- **Reduce the screen brightness;** powering the screen accounts for a significant fraction of a laptop's power consumption.

Most laptops have buttons on the keyboard (or a keyboard shortcut) that you can use to reduce the brightness.
If you do not need an Internet connection for a little while, turn off the wireless/Bluetooth card. These devices work by broadcasting radio waves, which takes quite a bit of power.

Some computers have a physical switch that can be used to turn it off, whereas others have a keyboard shortcut that you can use
instead. You can turn it on again when you need it.

More advanced tips

- Reduce the number of tasks that are running in the background. Computers use more power when they have more work to do.

Most of your running applications do very little when
you are not actively using them. However, applications that frequently grab data from the internet, play music or movies can impact your power consumption.

More Information

Power & battery — Suspend, energy savings, power off, screen dimming...

See Also
How do I hibernate my computer? — Hibernate is disabled by default since it's not well supported.

Power off or restart

What happens when I suspend my computer? — Suspend sends your computer to sleep so it uses less power.
What happens when I suspend my computer?

When you *suspend* the computer, you send it to sleep. All of your applications and documents remain open, but the screen and other parts of the computer switch off to save power. The computer is still switched on though, and it will still
be using a small amount of power. You can wake it up by pressing a key or clicking the mouse. If that does not work, try pressing the power button.

Some computers have problems with hardware support which mean that they may not be able to suspend or hibernate properly. It is a good idea to test suspend on your computer to see if it does work before relying on it.
Always save your work before suspending

You should save all of your work before suspending the computer, just in case something goes wrong and your open applications and documents cannot be recovered when you resume the computer again.
More Information

Power & battery — Suspend, energy savings, power off, screen dimming...

See Also

Suspend

Use less power and improve battery life — Tips to reduce the power consumption of your computer.
Why does my computer turn off when I close the lid?

When you close the lid of your laptop, your computer will *suspend* in order to save power. This means that the computer isn't actually turned off - it has just gone to sleep.
You can resume it by opening the lid. If it doesn't resume, try clicking the mouse or pressing a key. If that still doesn't work, press the power button.

Some computers are unable to suspend properly, normally because their hardware isn't completely supported by the operating system (for example, the Linux drivers are incomplete). In this case, you may find that you are unable to resume
your computer after you've closed the lid. You can try to fix the problem with suspend, or you can prevent the computer from trying to suspend when you close the lid.

Stop the computer from suspending when the lid is closed

If you don't want the computer to suspend when you close the lid, you
can change the settings for that behavior:

⚠️ Be very careful if you change this setting. Some laptops can overheat if they are left running with the lid closed, especially if they are in a confined place like a backpack.

1. Click the icon at the very
right of the menu bar and select System Settings.

2. In the Hardware section, click Power.

3. Set the drop-down menus next to When the lid is closed to Do nothing.

More Information

Power & battery — Suspend,
energy savings, power off, screen dimming…

See Also

Why won't my computer turn back on after I suspended it? — Some computer hardware causes problems with suspend or hibernate.
The estimated battery life is wrong

When you check the remaining battery life, you may find that the time remaining that it reports is different to how long the battery actually lasts. This is because the amount of remaining battery life can only be estimated. Normally, the
estimates improve over time.

In order to estimate the remaining battery life, a number of factors must be taken into account. One is the amount of power currently being used by the computer: power consumption varies depending on how many programs you have open, which devices are plugged in, and whether you are running any intensive tasks (like watching a DVD or converting music files, for
example). This changes from moment to moment, and is difficult to predict.

Another factor is how the battery discharges. Some batteries lose charge faster the emptier they get. Without precise knowledge of how the battery discharges, only a rough estimate of remaining battery life can be made.

As the battery discharges, the
power manager will figure out its discharge properties and will learn how to make better estimates of battery life. They will never be completely accurate, though.

If you get a completely ridiculous battery life estimate (say, hundreds of days), the power manager is probably missing some of the data it needs to make a sensible
estimate.

If you unplug the power and run the laptop on battery for a while, then plug it in and let it recharge again, the power manager should be able to get the data it needs.

More Information

Battery settings
See Also

Why do I have less battery life than I did on Windows/Mac OS? — Tweaks from the manufacturer and differing battery life estimates may be the cause of this problem.
Why did my computer turn off/suspend when the battery got to 10%?

When the charge level of the battery gets too low, your computer will automatically **suspend**. It does
this to make sure that the battery doesn't completely discharge, since this is bad for the battery. If the battery just ran out, the computer wouldn't have time to shut down properly either.

You can change what happens when the battery level gets too low. First, click the battery menu in the menu bar and select Power Settings. At the 'When power is critically low' setting, you can
choose for the computer to suspend, hibernate, or shut down. If you choose shut down, your applications and documents will not be saved when the computer turns off.

Some computers have problems suspending, and may not be able to recover the applications and documents you had open when you turn on the computer again. In this case, it is possible that you could
lose some of your work if you didn't save it before the computer suspended. You may be able to fix problems with suspend though.

More Information

Battery settings
Why do I have less battery life than I did on Windows/Mac OS?

Some computers appear to have a shorter battery life when running on Linux than they do when running Windows or Mac OS. One reason
for this is that computer vendors install special software for Windows/Mac OS that optimizes various hardware/software settings for a given model of computer. These tweaks are often highly specific, and may not be documented, so including them in Linux is difficult.

Unfortunately, there is not an easy way of applying these tweaks yourself without knowing exactly
what they are. You may find that using some *power-saving methods* helps, though. If your computer has a *variable-speed processor*, you might find that changing its settings is also useful.

Another possible reason for the discrepancy is that the method of estimating battery life is different on Windows/Mac OS than on Linux. The actual battery life could be exactly the same, but the different
methods give different estimates.

More Information

Battery settings

See Also

The estimated battery life is wrong — The battery life displayed when you click on the battery icon is an estimate.
Why does my screen go dim after a while?

When your laptop computer is running on battery, the screen will dim when the computer is idle in order to save power. When you start using the computer again, the screen will brighten.
You can stop the screen from dimming itself:

1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Brightness & Lock and uncheck Dim screen to save power.
More Information

Battery settings

Screen problems — Troubleshoot screen and graphics problems.

See Also

Set screen brightness — Dim the screen to save power or increase the brightness to make it more readable in bright light.
Why is my laptop slow when it is on battery?

Some laptops intentionally slow down when they are running on battery in order to conserve power. The processor (CPU) in the laptop switches to a slower speed, and
processors use less power when running slower, so the battery should last longer.

This feature is called CPU frequency scaling.
An error reports my battery has low capacity

When you first log in, you might see a message that says:

“Battery may be broken. Your battery has a very low capacity which means that it
may be old or broken.

This message is displayed when the computer detects that your battery is not capable of storing much charge. The most likely reason for this is that your battery is old; it's probably not broken, so there's no need to worry.

Over time, all laptop batteries lose their ability to store charge. After a while (normally a year or more), the
battery will only be able to store a fraction of the charge that it could when it was new. The message above is shown when this happens.

If your computer or battery is relatively new, it should be capable of holding a high percentage of its design charge. If it can't, then your battery may be broken and you might need to seek a replacement.
More Information

Power problems — Troubleshoot problems with power and batteries.

See Also

Get the most out of your laptop battery — Tips such as "Do not let the battery charge get too low"
My computer gets really hot

Most computers get warm after a while, and some can get quite hot. This is normal: it's simply part of the way that the computer cools itself. However, if your computer gets very warm it could be a sign that it is overheating, which can potentially cause damage.
Most laptops get reasonably warm once you have been using them for a while. It's generally nothing to worry about - computers produce a lot of heat and laptops are very compact, so they need to remove their heat rapidly and their outer casing warms up as a result. Some laptops do get too hot, however, and may be uncomfortable to use. This is normally the result of a poorly-designed cooling system.
You can sometimes get additional cooling accessories which fit to the bottom of the laptop and provide more efficient cooling.

If you have a desktop computer which feels hot to the touch, it may have insufficient cooling. If this concerns you, you can buy extra cooling fans or check that the cooling fans and vents are free from dust and other blockages. You might want to consider putting the
computer in a better-ventilated area too - if kept in confined spaces (e.g. in a cupboard), the computer's cooling system may not be able to remove heat and circulate cool air fast enough.

Some people are concerned about the health risks of using hot laptops. There are suggestions that prolonged use of a hot laptop on your lap might possibly reduce (male) fertility, and there are reports
of minor burns being suffered too (in extreme cases). If you are concerned about these potential problems, you may wish to consult a medical practitioner for advice. Of course, you can simply choose not to rest the laptop on your lap.

Most modern computers will shut themselves down if they get too hot, to prevent themselves from becoming damaged. If your computer keeps shutting down, this
might be the reason. If your computer is overheating, you will probably need to get it repaired.

More Information

**Power problems** — Troubleshoot problems with power and batteries.
My computer will not turn on

There are a number of reasons why your computer will not turn on. This topic gives a brief overview of some of the possible reasons.

Computer not plugged in, empty battery, or loose cable
Make sure that the power cables of the computer are firmly plugged in and the power outlets are switched on. Make sure that the monitor is plugged in and switched on too. If you have a laptop, connect the charging cable (in case it has run out of battery). You may also want to check that the battery is correctly fitted in place (check the underside of the laptop) if it's removable.
Problem with the computer hardware

A component of your computer may be broken or malfunctioning. If this is the case, you will need to get your computer repaired. Common faults include a broken power supply unit, incorrectly-fitted components (such as the memory/RAM) and a faulty motherboard.
The computer beeps and then switches off

If the computer beeps several times when you turn it on and then turns off (or fails to start), it may be indicating that it has detected a problem. These beeps are sometimes referred to as *beep codes*, and the pattern of beeps is intended to tell you what the problem with the computer is. Different manufacturers use
different beep codes, so you will have to consult the manual for your computer's motherboard, or take your computer in for repairs.

The computer fans are spinning but nothing is on the screen

The first thing to check is that your monitor is plugged in and turned on.

This problem could also be due to a
hardware fault. The fans might turn on when you press the power button, but other essential parts of the computer might fail to turn on. In this case, take your computer in for repairs.

More Information

Power problems — Troubleshoot problems with power and batteries.

Screen problems — Troubleshoot
screen and graphics problems.
If your laptop's cooling fan is always running, it could be that the hardware that controls the laptop's cooling system isn't very well supported in Linux. Some laptops need extra software to control their cooling fans efficiently, but this
software may not be installed (or available for Linux at all) and so the fans just run at full speed all of the time.

If this is the case, you may be able to change some settings or install extra software that allows full control of the fan. For example, `vaiofand` can be installed to control the fans of some Sony VAIO laptops. Installing this software is quite a technical process which is
highly dependent on the make and model of your laptop, so you may wish to seek specific advice on how to do it for your computer.

It is also possible that your laptop just produces a lot of heat. This does not necessarily mean that it is overheating; it might just need the fan to run at full speed all of the time to allow it to stay cool enough. If this is the case, you have little option but to let the fan run at full
speed all of the time. You can sometimes buy additional cooling accessories for your laptop which may help.

More Information

Power problems — Troubleshoot problems with power and batteries.
Why won't my computer turn back on after I suspended it?

If you suspend or hibernate your computer, then try to resume it or turn it back on, you may find that it does not work as you expected. This could be because suspend and
hibernate aren't supported properly by your hardware.

My computer is suspended and isn't resuming

If you suspend your computer and then press a key or click the mouse, it should wake up and display a screen asking for your password. If this doesn't happen, try pressing the
power button (don't hold it in, just press it once).

If this still doesn't help, make sure that your computer's monitor is switched on and try pressing a key on the keyboard again.

As a last resort, turn off the computer by holding in the power button for 5-10 seconds, although you will lose any unsaved work by doing this. You should then be able
to turn on the computer again.

If this happens every time you suspend your computer, the suspend feature may not work with your hardware.

⚠️ If your computer loses power and doesn't have an alternative power supply (such as a working battery), it will switch off.
None of my applications/documents are open when I turn on the computer again

If you hibernated your computer and switched it on again, but none of your documents or applications are open, it probably failed to hibernate properly. Sometimes this happens because of a minor problem, and the computer will be able to hibernate properly the next
time you do it. It might also happen because you had installed a software update which required the computer to be restarted; in this case, the computer may have shut down instead of hibernating.

It is also possible that the computer is not capable of hibernating because the hardware doesn't support it properly. This might be because of a problem with Linux drivers for your hardware, for
example. You can test this by hibernating again and seeing if it works the second time. If it doesn't, it is probably a problem with your computer's drivers.

My wireless connection (or other hardware) doesn't work when I wake up my computer.

If you suspend or hibernate your
computer and then resume it again, you may find that your internet connection, mouse, or some other device doesn't work properly. This could be because the device's driver doesn't properly support suspend or hibernate. This is a **problem with the driver** and not the device itself.

If the device has a power switch, try turning it off and then on again. In most cases, the device will start working again. If it connects via a
USB cable or similar, unplug the device and then plug it in again and see if it works.

If you cannot turn off/unplug the device, or if this does not work, you may need to restart your computer for the device to start working again.

More Information

Power problems — Troubleshoot
problems with power and batteries.

**Screen problems** — Troubleshoot screen and graphics problems.

**See Also**

**How do I hibernate my computer?** — Hibernate is disabled by default since it's not well supported.

**I have no wireless network when I wake up my computer** — Some wireless devices have problems handling when your computer is suspended and doesn't resume properly.
Why does my computer turn off when I close the lid? — Laptops go to sleep when you close the lid, in order to save power.
Will my computer work with a power supply in another country?

Different countries use power supplies at different voltages (usually 110V or 220-240V) and AC.
frequencies (usually 50 Hz or 60 Hz). Your computer should work with a power supply in a different country as long as you have an appropriate power adapter. You may also need to flip a switch.

If you have a laptop, all you should need to do is get the right plug for your power adapter. Some laptops come packaged with more than one plug for their adapter, so you may already have the right one. If not,
plugging your existing one into a standard travel adapter will suffice.

If you have a desktop computer, you can also get a cable with a different plug, or use a travel adapter. In this case, however, you may need to change the voltage switch on the computer's power supply, if there is one. Many computers don't have a switch like this, and will happily work with either voltage. Look at the back of the
computer and find the socket that the power cable plugs into. Somewhere nearby, there may be a small switch marked "110V" or "230V" (for example). Switch it if you need to.

⚠️ Be careful when changing power cables or using travel adapters. Switch everything off first if you can.
More Information

Power problems — Troubleshoot problems with power and batteries.
Region & Language Support

Install languages
Install more translations and related language support packages.

Change which language you use
Switch to a different language for
Change date and measurement formats
Choose a region used for date and time, numbers, currency, and measurement.

Text Entry

Use alternative input sources
Add input sources and switch between them.
More Information

User & system settings — Keyboard, mouse, display, languages, user accounts…
Change which language you use

You can use your desktop and applications in any of dozens of languages, provided you have the proper language packs installed on your computer.
1. Click the icon at the very right of the menu bar and select System Settings.

2. Click Language Support.

3. Select your desired language on the Language tab. Drag the language to the top of the list.

4. You have to log out and back in for language
changes to take effect. Click the icon at the very right of the menu bar and select Log Out to log out.

Some translations may be incomplete, and certain applications may not support your language at all.

There are some special folders in your home folder where applications
can store things like music, pictures, and documents. These folders use standard names according to your language. When you log back in, you will be asked if you want to rename these folders to the standard names for your selected language. If you plan to use the new language all the time, you should update the folder names.

Change the system
When you change your language, you only change it for your account after you log in. You can also change the system language, the language used in places like the login screen.

1. Change your language, as described above.

2. Click Apply System-Wide.
3. **Administrative privileges** are required. Enter your password, or the password for the requested administrator account.

You can find more detailed guidance on languages and regional formats in [Language Support Help](#).
More Information

Language Support

See Also

Change date and measurement formats — Choose a region used for date and time, numbers, currency, and measurement.
Change date and measurement formats

You can control the formats that are used for dates, times, numbers, currency, and measurement to match the local customs of your region.
1. Click the icon at the very right of the menu bar and select System Settings.

2. Open Language Support and select the Regional Formats tab.

3. Select the region that most closely matches the formats you'd like to use. By default, the list only shows regions
that use the language set on the Language tab.

4. You have to log out and back in for these changes to take effect. Click the icon at the very right of the menu bar and select Log Out to log out.

After you've selected a region, the area below the list shows various examples of how dates and other
values are shown. Although not shown in the examples, your region also controls the starting day of the week in calendars.

Change the system formats

When you change your region for formats, you only change it for your account after you log in. You can also change the system formats,
the formats used in places like the login screen.

1. Change your formats, as described above.

2. Click Apply System-Wide.

3. Administrative privileges are required. Enter your password, or the password for the requested administrator account.
You can find more detailed guidance on languages and regional formats in Language Support Help.

More Information
Language Support

See Also
Change which language you use — Switch to a different language
for user interface and help text.
Time & date

Change the date and time
Update the time/date displayed at the top of the screen.

Calendar appointments
Display your appointments on the calendar at the top of the screen.

Change how much information is shown in the clock
Choose to show additional information such as the date or day of the week.
Show other timezones
Add other timezones so you can see what time it is in other cities.

More Information
User & system settings — Keyboard, mouse, display, languages, user accounts...
Change the date and time

If the date and time displayed on the top bar are incorrect or in the wrong format, you can change them:

1. Click on the clock at the right side of the top bar and select Date and Time
2. You may need to click Unlock and type the admin password.

3. Adjust the date and time by clicking on the arrows to choose the hour and minute. You can choose the year, month and day from the drop-down lists.
4. If you like, you can have the clock update itself automatically by switching Network Time on.

When *Network Time* is switched on, the computer will periodically synchronize its clock with a very accurate clock on the internet, so you don't have to do it manually. This will only work if you are
connected to the internet.

5. You can also change how the hour is displayed by selecting 24-hour or AM/PM format.

More Information

Time & date — Set time and date, timezone, calendar and appointments...

See Also
Show other timezones — Add other timezones so you can see what time it is in other cities.
Change how much information is shown in the clock

By default, Ubuntu only shows the time in the clock. You can set the clock to show additional information if you choose.
Click on the clock and select **Date & Time Settings**. Switch to the **Clock tab**. Select the time and date options you want to display.

You can also turn the clock off entirely by unchecking **Show a clock in the menu bar**.

If you later change your mind, you can get the clock back by clicking the icon in the very
right of the menu bar and selecting **System Settings**. In the System section, click **Time & Date**.

**Change the date format**

You can also change the clock's date format to match the preferred standard for your location.

1. Click the icon at the very
right of the menu bar and select System Settings.

2. In the Personal section, click Language Support.

3. Switch to the Regional Formats tab.

4. Select your preferred location in the dropdown list.

5. You will need to log out and
log back in for this change to take effect.

More Information

Time & date — Set time and date, timezone, calendar and appointments…
Show other timezones

If you want to know what time it is in different cities around the world, you can add additional timezones to the clock menu. These additional cities will show up below the calendar when you click on the clock.

1. Click on the clock and
select Date & Time Settings.

2. Switch to the Clock tab and select Time in other locations.

3. Click Choose locations.

4. Click + to add a location.

5. Fill in the Location blank with the city name you want to add. Wait a moment for a
list of possible cities to show up in the drop-down list.

6. Select the city you want and the current time in that location will fill in automatically.

7. Click to delete a city from the list.

8. You can also drag and drop the cities in this Locations
window to change the order in which they will show up in the clock menu.

More Information

**Time & date** — Set time and date, timezone, calendar and appointments…

See Also

**Change the date and time** — Update the time/date displayed at the top of the screen.
User accounts

Each person that uses the computer should have a different user account. This allows them to keep their files separate from yours and to choose their own settings. It's also more secure. You can only access a different user account if you know the password.
Manage user accounts

Add a new user account
Add new users so that other people can log in to the computer.

Change your login screen photo
Add your photo to the login and user screens.
Delete a user account
Remove users that no longer use your computer.

Launch a restricted guest session
Let a friend or colleague borrow your computer in a secure manner.

Passwords
Change your password
Keep your account secure by changing your password often in your account settings.

Choose a secure password
Use longer, more complicated passwords.

I forgot my password!
Advanced techniques for resetting your password

User privileges
Change who has administrative privileges

You can change which users are allowed to make changes to the system by giving them administrative privileges.

How do administrative privileges work?

You need admin privileges to change important parts of your system.
Problems caused by administrative restrictions

You can only do some things, like installing applications, if you have admin privileges.

More Information

User & system settings — Keyboard, mouse, display, languages, user accounts…
Add a new user account

You can add multiple user accounts to your computer. Give one account to each person in your household or company. Every user has their own home folder, documents, and settings.

1. Click the icon at the far right
of the menu bar and select System Settings.

2. Open User Accounts.

3. You need administrator privileges to add user accounts. Click Unlock in the top right corner and type your password.

4. In the list of accounts on the left, click the +
button to add a new user account.

5. If you want the new user to have administrative access to the computer, select Administrator for the account type. Administrators can do things like add and delete users, install software and drivers, and change the date and time.
6. Enter the new user's full name. The username will be filled in automatically based on the full name. The default is probably OK, but you can change it if you like.

7. Click Create.

8. The account is initially disabled until you choose what to do about the user's
password. Under Login Options click Account disabled next to Password. Select Set a password now from the Action drop-down list, and have the user type their password in the New password and Confirm password fields. See Choose a secure password.

You can also click the button next to the New
password field to select a randomly generated secure password. These passwords are hard for others to guess, but they can be hard to remember, so be careful.

9. Click Change.

In the User Accounts window you can click the image next to
the user's name on the right to set an image for the account. This image will be shown in the login window. GNOME provides some stock photos you can use, or you can select your own or take a picture with your webcam.
See Also

Launch a restricted guest session — Let a friend or colleague borrow your computer in a secure manner.
Change your login screen photo

When you log in or switch users, you will see a list of users with their login photos. You can change your photo to a stock image or an image of your own. You can even take a new login photo with your webcam.
1. Click the icon at the far right of the menu bar and select System Settings.

2. Open User Accounts.

3. Click the picture next to your name. A drop-down gallery will be shown with some stock login photos. If you like one of them, click it to use it for yourself.
4. If you'd rather use a picture you already have on your computer, click Browse for more pictures.

More Information

Manage user accounts
Delete a user account

You can add multiple user accounts to your computer. See Add a new user account to learn how. If somebody is no longer using your computer, you can delete that user's account.

1. Click the icon at the far right
of the menu bar and select System Settings.

2. Open User Accounts.

3. Click Unlock in the top right corner and type your password to make changes. You must be an administrative user to delete user accounts.

4. Select the user you want to
delete and click the - button.

5. Each user has their own home folder for their files and settings. You can choose to keep or delete the user's home folder. Click Delete Files if you're sure they won't be used anymore and you need to free up disk space. These files are permanently
deleted. They can't be recovered. You may want to back up the files to an external drive or CD before deleting them.
Change your password

It is a good idea to change your password from time to time, especially if you think someone else knows what your password is.

1. Click the icon at the far right of the menu bar and select System Settings.
2. Open User Accounts.

3. Click the label next to Password.

![Note] The label should look like a series of dots or boxes if you already have a password set.

4. Enter your current password, then a new
password. Enter your new password again in the Confirm password field.

You can also click the button next to the New password field to select a randomly generated secure password. These passwords are hard for others to guess, but they can be hard to remember, so be careful.
5. Click Change.

Make sure you choose a good password. This will help to keep your user account safe.

Change the keyring password

If you change your login password, it may become out of sync with the keyring password. The keyring
keeps you from having to remember lots of different passwords by just requiring one *master* password to access them all. If you change your user password (see above), your keyring password will remain the same as your old password. To change the keyring password (to match your login password):

1. Open the *Passwords and Keys* application from the
2. In the View menu, ensure By keyring is checked.

3. In the sidebar under Passwords, right-click on Login keyring and select Change Password.

4. Enter your Old Password, followed by your new Password, and Confirm
your new password by entering it again.

5. Click OK.

More Information

Passwords

See Also

Choose a secure password — Use longer, more complicated passwords.
Choose a secure password

🌟 Make your passwords easy enough for you to remember, but very difficult for others (including computer programs) to guess.
Choosing a good password will help to keep your computer safe. If your password is easy to guess, someone may figure it out and gain access to your personal information.

People could even use computers to systematically try to guess your password, so even one that would be difficult for a human to guess might be extremely easy for a computer program to crack. Here are some tips for choosing a good
password:

- Use a mixture of upper-case and lower-case letters, numbers, symbols, and spaces in the password. This makes it more difficult to guess. There are more symbols to choose from, so more possible passwords would have to be checked by someone when trying to guess yours.
A good method for choosing a password is to take the first letter of each word in a phrase that you can remember. The phrase could be the name of a movie, a book, a song, or an album. For example, "Flatland: A Romance of Many Dimensions" would
become F:ARoMD or faromd or f: aromd.

- Make your password as long as possible. The more characters it contains, the longer it should take for a person or computer to guess it.

- Do not use any words that appear in a standard dictionary in any language.
Password crackers will try these first. The most common password is "password" -- people can guess passwords like this very quickly!

- Do not use any personal information, such as a date, license plate number, or any family member's name.

- Do not use any nouns.
• Choose a password that can be typed quickly, to reduce the chance of someone being able to make out what you have typed if they happen to be watching you.

Never write your passwords down anywhere. They can be found!
• Use different passwords for different things.

• Use different passwords for different accounts.

If you use the same password for all of your accounts, anyone who guesses it will be able to access all of your accounts immediately.

It can be difficult to remember
lots of passwords. Though not as secure as using a different passwords for everything, it may be easier to use the same one for things that don't matter (like websites), and different ones for important things (like your online banking account and your email).

- Change your passwords regularly.
More Information

Passwords

See Also

Change your password — Keep your account secure by changing your password often in your account settings.
I forgot my password!

It is important to choose not only a good and secure password, but also one that you can remember. If you have forgotten the password to log in to your computer account, you can follow the following steps to reset it.
If you have an encrypted home directory, you will not be able to reset a forgotten password.

If you simply want to change your password, see Change your password.

Reset password using Grub
Reset password using a Live CD or USB
Get rid of the keyring
1. Restart your computer, and hold down **Shift** during bootup to get into the Grub menu.

If you have a dual-boot machine and you choose at boot time
which operating system to boot into, the Grub menu should appear without the need to hold down Shift.

If you are unable to get into the Grub boot menu, and therefore cannot choose to boot into recovery mode,
you can use a live CD to reset your user password.

2. Press the down arrow on your keyboard to highlight the line that ends with the words 'recovery mode', then press Enter.

3. Your computer will now begin the boot process. After a few moments, a
Recovery Menu will appear. Use your down arrow key to highlight root and press Enter.

4. At the # symbol, type:

```
passwd username
```

`username` is the username of the account you're changing the password for.

5. You will be prompted to
enter a new UNIX password, and to confirm the new password.

6. Then type:

```
# reboot
```

After you successfully log in, you will not be able to access your keyring (since you don't remember the old password). This means that all your saved passwords for wireless
networks, jabber accounts, etc. will no longer be accessible. You will need to **delete the old keyring** and start a new one.

---

**Reset password using a Live CD or USB**

1. Boot the Live CD or USB.
2. Mount your drive.
3. Press \textbf{Alt + F2} to get the Run Application window.

4. Type \texttt{gksu nautilus} to launch the file manager with system-wide privileges.

   Within the drive you just mounted, you can check that it is the right drive by clicking \texttt{home} and then your
5. Go to the top-level directory of the mounted drive. Then go into the etc directory.

Locate the 'shadow' file and make a backup copy:

1. Right-click on the shadow file and select copy.

2. Then right-click in the
empty space and select paste.

3. **Rename** the backup "shadow.bak".

6. Edit the original "shadow" file with a text editor.

7. Find your username for which you have forgotten the password. It should look something like this (the
characters after the colon will be different):

username:$1$2abCd0E or

username:$1$2abCd0E:13721

8. Delete the characters after the first colon and before the second colon. This will remove the password for the account.

Save the file, exit out of
everything and reboot your computer without the live CD or USB.

9. When you boot back into your installation, click your name in the menu bar. Open My Account and reset your password.

10. For Current password do not enter anything, as your current password is blank.
Just click Authenticate and enter a new password.

After you successfully log in, you will not be able to access your keyring (since you don't remember the old password). This means that all your saved passwords for wireless networks, jabber accounts, etc. will no longer be accessible. You will need to delete the old keyring and start a new one.
Get rid of the keyring

This will delete all your saved passwords for wireless networks, instant messaging accounts, etc. Only do this if you can't remember the password you used for your keyring.

1. Go to your Home folder by
typing 'home' in the Dash.

2. Press Ctrl + h (or click View ➤ Show Hidden Files.)

3. Double click on the folder ~/.local/share.

4. Double click on the folder called keyrings.

5. Delete any files you find in the keyrings folder.
6. Restart the computer.

After you restart and log in you will be asked to enter your wireless networks password.

More Information

Passwords
Change who has administrative privileges

Administrative privileges are a way of deciding who can make changes to important parts of the system. You can change which users have admin privileges and which ones...
don't. They are a good way of keeping your system secure and preventing potentially damaging unauthorized changes.

1. Click the icon at the far right of the menu bar and select System Settings.

2. Open User Accounts.

3. Click Unlock and enter your password to unlock the
account settings. (To give a user admin privileges, you must have admin privileges yourself.)

4. Select the user whose privileges you want to change.

5. Click the label Standard next to Account type and select Administrator.
6. Close the User Accounts window. The user's privileges will be changed when they next log in.

The first user account on the system has admin privileges. This is the user account that was created when you first installed the system.

It is unwise to have too many
More Information

User privileges

See Also

How do administrative privileges work? — You need admin privileges to change important parts of your system.
How do administrative privileges work?

As well as the files that you create, your computer has a number of files which are needed by the system for it to work properly. If these important system files are changed
improperly they can cause various things to break, so they are protected from changes by default. Certain applications also modify important parts of the system, and so are also protected.

The way that they are protected is by only allowing users with *administrative privileges* to change the files or use the applications. In day-to-day use, you won't need to change any system files or use
these applications, so by default you do not have admin privileges.

Sometimes you need to use these applications, so you may be able to temporarily get admin privileges to allow you to make the changes. If an application needs admin privileges, it will ask for your password. For example, if you want to install some new software, the software installer (package manager) will ask for your admin
password so it can add the new application to the system. Once it has finished, your admin privileges will be taken away again.

Admin privileges are associated with your user account. Some users are allowed to have admin privileges and some are not. Without admin privileges you will not be able to install software. Some user accounts (for example, the "root" account) have permanent admin
privileges. You shouldn't use admin privileges all of the time, because you might accidentally change something you did not intend to (like delete a needed system file, for example).

In summary, admin privileges allow you to change important parts of your system when needed, but prevent you from doing it accidentally.
What does "super user" mean?

A user with admin privileges is sometimes called a *super user*. This is simply because that user has more privileges than normal users. You might see people discussing things like `su` and `sudo`; these are programs for temporarily giving you "super user" (admin) privileges.
Why are admin privileges useful?

Requiring users to have admin privileges before important system changes are made is useful because it helps to prevent your system from being broken, intentionally or unintentionally.

If you had admin privileges all of the time, you might accidentally change an important file, or run an
application which changes something important by mistake. Only getting admin privileges temporarily, when you need them, reduces the risk of these mistakes happening.

Only certain trusted users should be allowed to have admin privileges. This prevents other users from messing with the computer and doing things like uninstalling applications that you need, installing
applications that you don't want, or changing important files. This is useful from a security standpoint.

More Information

User privileges

See Also

Change who has administrative privileges — You can change which users are allowed to make changes to the system by giving them administrative privileges.
Other users can't edit the network connections — You need to uncheck the Available to all users option in the network connection settings.
Problems caused by administrative restrictions

You may experience a few problems if you don't have administrative privileges. Some tasks require admin privileges in order to work, such as:
• Connecting to networks or wireless networks

• Viewing the contents of a removable disk connected to the computer, or the contents of a different disk partition (e.g. a Windows partition)

• Installing new applications

You can change who has admin privileges.
More Information

User privileges
Wacom
Graphics Tablet

Choose a monitor
Map the Wacom tablet to a specific monitor.

Configure the stylus
Define the button functions and pressure feel of the Wacom stylus.

Set the Wacom tablet's tracking mode
Switch the tablet between tablet mode and mouse mode.

**Use the tablet left-handed**

Switch the Wacom tablet to Left-Handed Orientation.

---

**More Information**

User & system settings —
Keyboard, mouse, display, languages, user accounts...
Choose a monitor

1. Click the icon at the far right of the menu bar and select System Settings.

2. Open Wacom Graphics Tablet.
If no tablet is detected, you'll be asked to Please plug in or turn on your Wacom tablet.

3. Click Map to Monitor…

4. Check Map to single monitor.

5. Next to Output, select the monitor you wish to receive
input from your graphics tablet.

Only the monitors that are configured will be selectable.

6. Click Close.

More Information

Wacom Graphics Tablet —
Adjust the settings of your Wacom tablet.
Configure the stylus

1. Click the icon at the far right of the menu bar and select System Settings.

2. Open Wacom Graphics Tablet.
If no tablet is detected, you'll be asked to please plug in or turn on your Wacom tablet.

3. The lower part of the panel contains details and settings specific to your stylus, with the device name (the stylus class) and diagram to the left. These settings can be adjusted:
Eraser Pressure Feel: use the slider to adjust the "feel" (how physical pressure is translated to digital values) between Soft and Firm.

Button/Scroll Wheel configuration (these change to reflect the stylus). Click the menu next to each label to select one of these.
functions: No Action, Left Mouse Button Click, Middle Mouse Button Click, Right Mouse Button Click, Scroll Up, Scroll Down, Scroll Left, Scroll Right, Back, Forward.

Tip Pressure Feel: use the slider to adjust the "feel" between Soft and Firm.
If you have more than one stylus, when the additional stylus gets close to the tablet, a pager will be displayed next to the stylus device name. Use the pager to choose which stylus to configure.
Adjust the settings of your Wacom tablet.
Set the Wacom tablet's tracking mode

Tracking Mode determines how the pointer is mapped to the screen.

1. Click the icon at the far right of the menu bar and select System Settings.
2. Open Wacom Graphics Tablet.

If no tablet is detected, you'll be asked to Please plug in or turn on your Wacom tablet.

3. Next to Tracking Mode, select Tablet (absolute) or Touchpad (relative).
In *absolute* mode, each point on the tablet maps to a point on the screen. The top left corner of the screen, for instance, always corresponds to the same point on the tablet.

In *relative* mode, if you lift the pointer off the tablet and put it down in a different position, the cursor on the screen doesn't move. This is the way a mouse operates, allowing you to cover
distances on the screen with less hand movement.

More Information

Wacom Graphics Tablet — Adjust the settings of your Wacom tablet.
Use the tablet left-handed

Some tablets have hardware buttons on one side. The tablet can be rotated 180 degrees to position these buttons for left-handed people. To switch the orientation to left-handed:

1. Click the icon at the far right
of the menu bar and select System Settings.

2. Open Wacom Graphics Tablet.

If no tablet is detected, you'll be asked to please plug in or turn on your Wacom tablet.

3. Switch Left-Handed
Orientation to ON.

More Information

**Wacom Graphics Tablet** — Adjust the settings of your Wacom tablet.
Hardware & drivers

**Bluetooth**
Connect, send files, turn on and off...

**Color management**
Why is this important,
Color profiles,
How to calibrate a device...
Disks & storage
Disk space, performance, problems, volumes and partitions…

Keyboard
Input sources, cursor blinking, super key, keyboard accessibility…

Mouse
Left-handed, speed and sensitivity, touchpad clicking and scrolling…

Power & battery
Suspend, energy savings, power off, screen dimming…
Printing
Local setup, order and collate, two-sided and multi-page...

More topics
What are proprietary drivers? — Proprietary device drivers are not freely available or open source.

What is a driver? — A hardware/device driver allows your computer to use devices that are attached to it.
Common problems

Bluetooth problems

Media card reader problems — Troubleshoot media card readers

Power problems — Troubleshoot problems with power and batteries.

Printer problems — Undetected printers, paper jams, print-outs that look wrong…

Screen problems — Troubleshoot screen and graphics problems.

Sound problems — Troubleshoot problems like having no sound or
having poor sound quality.

**Wireless network troubleshooter** — Identify and fix problems with wireless connections

---

**More Information**

**Ubuntu Desktop Guide**
What are proprietary drivers?

Most of the devices (hardware) attached to your computer should function properly in Ubuntu. These devices are likely to have open source drivers, which means that the drivers can be modified by the Ubuntu developers and problems
with them can be fixed.

Some hardware does not have open source drivers, usually because the hardware manufacturer has not released details of their hardware which would make it possible to create such a driver. These devices may have limited functionality or may not work at all.

If a proprietary driver is available for a certain device, you can install it in
order to allow your device to function properly, or to add new features. For example, installing a proprietary driver for certain graphics cards may allow you to use more advanced visual effects.

Many computers do not need proprietary drivers at all because the open source drivers fully support the hardware.
Most problems with proprietary drivers cannot be fixed by Ubuntu developers.

More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...
What is a driver?

Devices are the physical "parts" of your computer. They may be external like printers and monitor or internal like graphics and audio cards.

In order for your computer to be able to use these devices, it needs to know how to communicate with
them. This is done by a piece of software called a *device driver*.

When you attach a device to your computer, you must have the correct driver installed for that device to work. For example, if you plug in a printer but the correct driver isn't available, you won't be able to use the printer. Normally, each model of device uses a driver that is not compatible with any other model.
On Linux, the drivers for most devices are installed by default, so everything should work when you plug it in. However, the drivers may need to be installed manually or may not be available at all.

In addition, some existing drivers are incomplete or partially non-functional. For example, you might find that your printer can't do double-sided printing, but is otherwise completely functional.
More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...

See Also

I can't connect my Bluetooth device — The adapter could be turned off or may not have drivers, or Bluetooth might be disabled or blocked.
Bluetooth

Bluetooth is a wireless protocol that allows you to connect many different types of devices to your computer. Bluetooth is commonly used for headsets and input devices like mice and keyboards. You can also use Bluetooth to send files between devices, such as from your computer to your cell phone.
Turn Bluetooth on or off
Enable or disable the Bluetooth device on your computer.

Connect your computer to a Bluetooth device
Pair Bluetooth devices.

Control sharing over Bluetooth
Bluetooth file sharing and receiving options.

Remove a connection between Bluetooth devices
Remove a device from the list of Bluetooth devices.
Send a file to a Bluetooth device
Share files to Bluetooth devices such as your phone.

**What is Bluetooth visibility?**
Whether or not other devices can discover your computer.

**Problems**

I can't connect my Bluetooth device
The adapter could be turned off or may not have drivers, or
Bluetooth might be disabled or blocked.

More Information

Hardware problems

More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...
Turn Bluetooth on or off

You can turn Bluetooth on to use Bluetooth devices and send and receive files, but turn it off to conserve power. To turn Bluetooth on, click the Bluetooth icon on the top bar and switch Bluetooth on.

Many laptop computers have a hardware switch or key combination
to turn Bluetooth on and off. If the Bluetooth hardware is turned off, you will not see a Bluetooth icon in the top bar. Look for a switch on your computer or a key on your keyboard. The keyboard key is often accessed with the help of the \[\text{Fn}\] key.

To turn Bluetooth off, click the Bluetooth icon and switch Bluetooth off.
You only need to switch Visibility on if you are connecting to this computer from another device. See What is Bluetooth visibility? for more information.

More Information

Bluetooth — Connect, send files, turn on and off…

See Also
Turn off wireless (airplane mode) — Click the network menu on the menu bar and uncheck Enable Wireless.
Connect your computer to a Bluetooth device

Before you can use a Bluetooth device like a mouse or a headset, you first need to connect your computer to the device. This is also called pairing the Bluetooth devices.
Before you begin, make sure Bluetooth is enabled on your computer. See Turn Bluetooth on or off.

1. Click the Bluetooth icon on the top bar and select Set up a New Device.

2. Make the other Bluetooth device discoverable or visible and place it within 10
meters (about 33 feet) of your computer. Click Continue. Your computer will begin searching for devices.

3. If there are too many devices listed, use the Device type drop-down to display only a single type of device in the list.

4. Click PIN options to set how
a PIN will be delivered to the other device.

The automatic PIN setting will use a six-digit numerical code. A device with no input keys or screen, such as a mouse or headset, may require a specific PIN such as 0000, or no PIN at all.
Check your device's manual for the proper setting.

Choose an appropriate PIN setting for your device, then click Close.

5. Click Continue to proceed. If you did not choose a preset PIN, the PIN will be displayed on the screen.
6. If required, confirm the PIN on your other device. The device should show you the PIN you see on your computer screen, or may prompt you to enter the PIN. Confirm the PIN on the device, then click Matches.

You need to finish your entry within about 20 seconds on most devices, or the connection will not be
completed. If that happens, return to the device list and start again.

7. A message appears when the connection successfully completes. Click Close.

You can remove a Bluetooth connection later if desired.

To control access to your
shared files, refer to the Bluetooth Sharing settings.

See **Control sharing over Bluetooth**.

---

**More Information**

**Bluetooth** — Connect, send files, turn on and off…

**See Also**

**Control sharing over Bluetooth** — Bluetooth file sharing and receiving options.
Control sharing over Bluetooth

You can allow access to your Public and Downloads folders for Bluetooth file sharing, and also restrict that access to only trusted devices. Configure Personal File Sharing Preferences to control access to the shared folders on your computer.
A Bluetooth device is trusted if you have paired, or connected your computer to it. See Connect your computer to a Bluetooth device.

Share your Public folder over Bluetooth

1. In the Dash, open Personal File Sharing.

2. Select the desired Bluetooth
file sharing and receiving
options from the list.

More Information

**Bluetooth** — Connect, send files, turn on and off…

See Also

**Connect your computer to a Bluetooth device** — Pair Bluetooth devices.
Remove a connection between Bluetooth devices

If you don't want to be connected to a Bluetooth device anymore, you can remove the connection. This is useful if you no longer want to use a
device like a mouse or headset, or if you no longer wish to transfer files to or from a device.

1. Click the Bluetooth icon on the top bar and select Bluetooth Settings.

2. Select the device you want to disconnect in the left pane, then click the - icon underneath the list.
3. Click Remove in the confirmation window.

You can reconnect a Bluetooth device later if desired.

More Information

Bluetooth — Connect, send files, turn on and off...
What is Bluetooth visibility?

Bluetooth visibility simply refers to whether other devices can discover your computer when searching for Bluetooth devices. When Bluetooth visibility is turned on, your computer will advertise itself to all other devices within range, allowing them...
to attempt to connect to you.

Your computer does not need to be visible to search for other devices, but those devices need to be visible for your computer to discover them.

After you have connected to a device, neither your computer nor the device needs to be visible to communicate with each other.

Unless you or someone you trust
needs to connect to your computer from another device, you should leave visibility off.

More Information

**Bluetooth** — Connect, send files, turn on and off…
I can't connect my Bluetooth device

There are a number of reasons why you may not be able to connect to a Bluetooth device, such as a phone or headset.

Connection blocked or untrusted

Some Bluetooth devices block
connections by default, or require you to change a setting to allow connections to be made. Make sure that your device is set up to allow connections.

Bluetooth hardware not recognized

Your Bluetooth adapter/dongle may not have been recognized by the computer. This could be because drivers
for the adapter aren't installed. Some Bluetooth adapters aren't supported on Linux, so you may not be able to get the right drivers for them. In this case, you will probably have to get a different Bluetooth adapter.

Adapter not switched on

Make sure that your Bluetooth adapter is switched on. Click
the Bluetooth icon on the top bar and check that it's not **disabled**.

Device Bluetooth connection switched off

Check that Bluetooth is turned on on the device you're trying to connect to. For example, if you're trying to connect to a phone, make sure that it's not in airplane mode.
No Bluetooth adapter in your computer

Many computers do not have Bluetooth adapters. You can buy an adapter if you want to use Bluetooth.

More Information

Bluetooth problems

See Also

What is a driver? — A
hardware/device driver allows your computer to use devices that are attached to it.
Disks & storage

Check how much disk space is left
Use Disk Usage Analyzer or System Monitor to check space and capacity.

Check your hard disk for problems
Test your hard disk for problems to make sure that it's healthy.
Manage volumes and partitions
Understand what volumes and partitions are and use the disk utility to manage them.

Test the performance of your hard disk
Run benchmarks on your hard disk to check how fast it is.

Wipe everything off a removable disk
Remove all of the files and folders from an external hard disk or USB flash drive by formatting it.
More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks…
Check how much disk space is left

You can check how much disk space is left with *Disk Usage Analyzer* or *System Monitor*.

Check with *Disk Usage Analyzer*
To check the free disk space and disk capacity using *Disk Usage Analyzer*:

- Open the *Disks* application from the *Activities* overview. The window will display the Total file system capacity and Total file system usage.

- Click one of the toolbar buttons to choose to Scan Home, Scan filesystem, Scan
a folder, or Scan a remote folder.

The information is displayed according to Folder, Usage, Size and Contents. See more details in Disk Usage Analyzer.

Check with System Monitor

To check the free disk space and disk capacity with System Monitor:
1. Open the *System Monitor* application from the Activities overview.

2. Select the *File Systems* tab to view the system's partitions and disk space usage. The information is displayed according to Total, Free, Available and Used.
What if the disk is too full?

If the disk is too full you should:

- Delete files that aren't important or that you won't use anymore.

- Make **backups** of the important files that you won't need for a while and delete them from the hard drive.
More Information

Disks & storage — Disk space, performance, problems, volumes and partitions…
Check your hard disk for problems

Checking the hard disk

Hard disks have a built-in health-check tool called SMART (Self-Monitoring, Analysis, and Reporting Technology), which continually
checks the disk for potential problems. SMART also warns you if the disk is about to fail, helping you avoid loss of important data.

Although SMART runs automatically, you can also check your disk's health by running the Disks application:

Check your disk's health using the Disks application

1. Open the Disks application
from the Activities overview.

2. Select the disk you want to check from the Storage Devices list. Information and status of the disk will appear under Drive.

3. SMART Status should say "Disk is healthy".

4. Click the SMART Data button to view more drive
information, or to run a self-test.

What if the disk isn't healthy?

Even if the SMART Status indicates that the disk *isn't* healthy, there may be no cause for alarm. However, it's better to be prepared with a backup to prevent data loss.
If the status says "Pre-fail", the disk is still reasonably healthy but signs of wear have been detected which mean it might fail in the near future. If your hard disk (or computer) is a few years old, you are likely to see this message on at least some of the health checks. You should **backup your important files regularly** and check the disk status periodically to see if it gets worse.

If it gets worse, you may wish to
take the computer/hard disk to a professional for further diagnosis or repair.

More Information

**Disks & storage** — Disk space, performance, problems, volumes and partitions…
Manage volumes and partitions

The word *volume* is used to describe a storage device, like a hard disk. It can also refer to a *part* of the storage on that device, because you can split the storage up into chunks. The computer makes this storage accessible via
your file system in a process referred to as \textit{mounting}. Mounted volumes may be hard drives, USB drives, DVD-RWs, SD cards, and other media. If a volume is currently mounted, you can read (and possibly write) files on it.

Often, a mounted volume is called a \textit{partition}, though they are not necessarily the same thing. A “partition” refers to a \textit{physical} area of storage on a single disk drive.
Once a partition has been mounted, it can be referred to as a volume because you can access the files on it. You can think of volumes as the labeled, accessible “storefronts” to the functional “back rooms” of partitions and drives.

View and manage volumes and partitions using the disk utility
You can check and modify your computer's storage volumes with the disk utility.

1. Open the Dash and start the *Disk Utility* application.

2. In the pane marked Storage Devices, you will find hard disks, CD/DVD drives, and other physical devices. Click the device you want to
inspect.

3. In the right pane, the area labeled Volumes provides a visual breakdown of the volumes and partitions present on the selected device. It also contains a variety of tools used to manage these volumes.

Be careful: it is possible to completely erase the data
on your disk with these utilities.

Your computer most likely has at least one *primary* partition and a single *swap* partition. The swap partition is used by the operating system for memory management, and is rarely mounted. The primary partition contains your operating system, applications, settings, and personal files. These files can also
be distributed among multiple partitions for security or convenience.

One primary partition must contain information that your computer uses to start up, or *boot*. For this reason it is sometimes called a boot partition, or boot volume. To determine if a volume is bootable, look at its **Partition Flags** in the disk utility. External media such as USB drives and CDs may also contain a
More Information

Disks & storage — Disk space, performance, problems, volumes and partitions…
Test the performance of your hard disk

To test the speed of your hard disk:

1. Open the *Disks* application from the activities overview.

2. Choose the hard disk from the *Disk Drives* list.
3. Click the gear button and select Benchmark Drive.

4. Click Start Benchmark and adjust the Transfer Rate and Access Time parameters as desired.

5. Click Start Benchmarking to test how fast data can be read from the disk.

Administrative privileges may be required. Enter your
password, or the password for the requested administrator account.

If Also perform write-benchmark is checked, the benchmark will test how fast data can be read from and written to the disk. This will take longer to complete.
When the test is finished, the results will appear on the graph. The green points and connecting lines indicate the samples taken; these correspond to the right axis, showing access time, plotted against the bottom axis, representing percentage time elapsed during the benchmark. The blue line represents read rates, while the red line represents write
rates; these are shown as access data rates on the left axis, plotted against percentage of the disk traveled, from the outside to the spindle, along the bottom axis.

Below the graph, values are displayed for minimum, maximum and average read and write rates, average access time and time elapsed since the last benchmark test.
More Information

Disks & storage — Disk space, performance, problems, volumes and partitions…
Wipe everything off a removable disk

If you have a removable disk, like a USB memory stick or an external hard disk, you may sometimes wish to completely remove all of its files and folders. You can do this by formatting the disk - this deletes all of the files on the disk and leaves it
Format a removable disk

1. Open the *Disks* application from the *Activities* overview.

2. Select the disk you want to wipe from the *Storage Devices* list.

⚠️ Make sure that you have selected the
correct disk! If you choose the wrong disk, all of the files on the other disk will be deleted!

3. In the Volumes section, click Unmount Volume. Then click Format Volume.

4. In the window that pops up, choose a filesystem Type for the disk.
If you use the disk on Windows and Mac OS computers in addition to Linux computers, choose FAT. If you only use it on Windows, NTFS may be a better option. A brief description of the file system type will be presented as a label.

5. Give the disk a name and click Format to begin wiping
the disk.

6. Once the formatting has finished, safely remove the disk. It should now be blank and ready to use again.

⚠️ Formatting a disk does not securely delete your files.

Formatting a disk is not a completely secure way of wiping all of its data. A
formatted disk will not appear to have files on it, but it is possible that special recovery software could retrieve the files. If you need to securely delete the files, you will need to use a command-line utility, such as *shred*. 

---

More Information

**Disks & storage** — Disk space,
performance, problems, volumes and partitions...
How can I check my printer's ink/toner levels?

Check the amount of ink or toner left in printer cartridges.

Set up a printer

Set up a local printer

Set up a printer that is connected to your computer.
Set the default printer
Pick the printer that you use most often.

Different paper sizes and layouts
Change the paper size when printing
Print a document on a different paper size or orientation.

Make pages print in a different order
Collate and reverse the print order.

Print envelopes and labels
Make sure that you have the envelope/label the right way up, and have chosen the correct paper size.
Print only certain pages
Print only specific pages, or only a range of pages.

Print two-sided and multi-page layouts
Print on both sides of the paper, or multiple pages per sheet.

Printer problems
Cancel, pause or release a print job
Cancel a pending print job and remove it from the queue.

Clearing a paper jam
How you clear a paper jam will depend on the make and model of printer that you have.

Why are there streaks, lines or the wrong colors on my print-outs?
If print-outs are streaky, fading, or missing colors, check your ink levels or clean the print head.
More Information

Hardware problems

More Information

Hardware & drivers — Hardware problems, printers, power settings, color management, Bluetooth, disks...
How can I check my printer's ink/toner levels?

How you check how much ink or toner is left in your printer depends on the model and manufacturer of your printer, and the drivers and
applications installed on your computer.

Some printers have a built-in screen to display ink levels and other information.

The drivers and status tools for most HP printers are provided by the HP Linux Imaging and Printing (HPLIP) project. Other manufacturers might supply proprietary drivers with similar
features.

Alternatively, you can install an application to check or monitor ink levels. *Inkblot* shows ink status for many HP, Epson and Canon printers. See if your printer is on the list of supported models. Another ink levels application for Epson and some other printers is *mktink*.

Some printers are not yet well supported on Linux, and others are
not designed to report their ink levels.

More Information

Printing — Local setup, order and collate, two-sided and multi-page...
Set up a local printer

Your system can recognize many types of printers automatically once they're connected. Most printers are connected with a USB cable that attaches to your computer.

ℹ️ You do not need to select whether you want to install
network or local printer now. They are listed in one window.

1. Make sure the printer is turned on.

2. Connect the printer to your system via the appropriate cable. You may see activity on the screen as the system searches for drivers, and you may be
asked to authenticate to install them.

3. A message will appear when the system is finished installing the printer. Select Print Test Page to print a test page, or Options to make additional changes in the printer setup.

If your printer was not set up automatically, you can add it in the
1. Click the icon at the far right of the menu bar and select System Settings.

2. Open Printers.

3. Click Add and select the printer from the Devices window.

4. Click Forward and wait while
it searches for drivers.

5. You can customize the printer's name, description, and location if you like. When finished, click Apply.

6. You can now print a test page or click Cancel to skip that step.

If there are multiple drivers
available for your computer, you may be asked to select a driver. To use the recommended driver, just click Forward on the make and model screens.

After you install the printer, you may wish to change your default printer.

More Information

Set up a printer
Set the default printer

If you have more than one printer available, you can select which will be your default printer. You may want to pick the printer you use most often.

1. Click the icon at the far right of the menu bar and select
2. Open Printers.

3. Right click your desired default printer from the list of available printers, and click Set as Default.

When choosing from the list of available printers, you can filter the printer search results by
specifying a name or location of the printer (for example, 1st floor or entrance).

The search results filtering is available only in the dialog for addition of new printers.

When you print in an application, the default printer is automatically used, unless you choose a different printer for that specific print job.
More Information

Set up a printer
Change the paper size when printing

If you want to change the paper size of your document (for example, print a US Letter-sized PDF on A4 paper), you can change the printing format for the document.
1. Click File ➤ Print

2. Select the Page Setup tab.

3. Under the Paper column, choose your Paper size from the drop-down list.

4. Click Print and your document should print.

You can also use the Orientation menu to choose a different
orientation:

- Portrait
- Landscape
- Reverse portrait
- Reverse landscape

More Information

Different paper sizes and layouts
Make pages print in a different order

Reverse

Printers usually print the first page first, and the last page last, so the pages end up in reverse order when you pick them up. If needed, you
can reverse this printing order.

To reverse the order:

1. Click File ▸ Print.

2. In the General tab of the Print window under Copies, check Reverse. The last page will be printed first, and so on.
If you are printing more than one copy of the document, the print-outs will be grouped by page number by default (i.e. all of the copies of page one come out, then the copies of page two, and so on). Collating will make each copy come out with its pages grouped together in the right order instead.

To Collate:
1. Click File ▶ Print.

2. In the General tab of the Print window under Copies check Collate.

More Information

Different paper sizes and layouts
Print envelopes and labels

Most printers will allow you to print directly onto an envelope or sheet of labels. This is especially useful if you have a lot of letters to send, for example.
There are two things you need to check when trying to print onto an envelope. The first is that your printer knows what size the envelope is. After you click Print and the Print window appears, go to the Page Setup tab and choose the Paper type as "Envelope" if you can. If you can't do this, see if you can change the Paper size to an envelope size (e.g. "C5"). The pack of envelopes will say what size they
are; most envelopes come in standard sizes.

Secondly, you need to make sure that the envelopes are loaded with the right side up in the printer's in-tray. Check the printer's manual for this, or try to print a single envelope and check which side is printed on to see which way is the right way up.
Some printers are not designed to be able to print envelopes, especially some laser printers. Check your printer's manual to see if it accepts envelopes; otherwise, you could damage the printer by feeding an envelope in.
Different paper sizes and layouts
Print only certain pages

To only print certain pages from the document:

1. Click File ▸ Print

2. In the General tab in the Print window choose Pages from the Range section.
3. Type the numbers of the pages you want to print in the text box, separated by commas. Use a dash to denote a range of pages.

For example, if you enter "1,3,5-7,9" in the Pages text box, pages 1,3,5,6,7 and 9 will be printed.
More Information

Different paper sizes and layouts
Print two-sided and multi-page layouts

To print on both sides of each sheet of paper:

1. Click File ➤ Print.

2. Go to the Page Setup tab of the Print window and
choose an option from the Two-sided drop-down list. If the option is disabled, two-sided printing is not available for your printer.

Printers handle two-sided printing in different ways. It's a good idea to experiment with your printer to see how it works.

3. You can print more than
one page of the document per side of paper too. Use the Pages per side option to do this.

The availability of these options may depend on the type of printer you have, as well as the application you are using. This option may not always be available.
More Information

Different paper sizes and layouts
Cancel, pause or release a print job

You can cancel a pending print job and remove it from the queue in the printer settings.

Cancel a print job

If you accidentally started printing a
document, you can cancel the print so that you do not need to waste any ink or paper.

How to cancel a print job:

1. Click the icon at the far right of the menu bar and select System Settings.

2. Click Printers.

3. Click the Show Jobs button on the right-hand side of the
4. Cancel the print job by clicking the stop button on the play-pause-stop symbols.

If this does not cancel the print job like you expected, try holding down the Cancel button on your printer.

As a last resort, especially if you have a big print job with a lot of
pages that won't cancel, remove the paper from the printer's paper input tray. The printer should realize that there is no paper and will stop printing. You can then try canceling the print job again, or try turning the printer off and then on again.

Be careful that you don't damage the printer when removing the paper, though - if you would have to pull hard on
the paper to remove it, you should probably just leave it where it is.

---

**Pause and release a print job**

If you want to pause or release a print job, you can do so by going to the jobs dialog in the printer settings and click the appropriate button.
1. Click the icon at the far right of the menu bar and select System Settings.

2. Click Printers.

3. Click the Show Jobs button on the right-hand side of the Printers dialog and either pause or release the print job based on your needs.
More Information

Printer problems — Undetected printers, paper jams, print-outs that look wrong...
Clearing a paper jam

Sometimes printers incorrectly feed sheets of paper and get jammed.

The manual for your printer will usually provide detailed instructions on how to clear paper jams. Usually, you will need to open one of the printer's panels to find the jam inside and then firmly (but carefully!)
pull the jammed paper out of the printer's feeding mechanism.

Once the jam has been cleared you may need to press the printer's Resume button to start printing again. With some printers, you may even need to turn the printer off and then on again, and then start the print job again.
Printer problems — Undetected printers, paper jams, print-outs that look wrong…
Why are there streaks, lines or the wrong colors on my print-outs?

If your print-outs are streaky, faded, have lines on them that shouldn't be there, or are otherwise poor in quality, this may be due to a
problem with the printer or a low ink/toner supply.

- Fading text or images

You may be running out of ink or toner. Check your ink/toner supply and buy a new cartridge if necessary.

- Streaks and lines

If you have an inkjet printer, the print head may be dirty or
partially blocked. Try cleaning the print head (see the printer's manual for instructions).

- Wrong colors

The printer may have run out of one color of ink or toner. Check your ink/toner supply and buy a new cartridge if necessary.
• Jagged lines, or lines aren't straight

If lines on your print-out that should be straight turn out jagged, you may need to align the print head. See the printer's instruction manual for details on how to do this.

More Information

Printer problems — Undetected
printers, paper jams, print-outs that look wrong...
Screen problems

Most problems with the display are caused by issues with graphics drivers or configuration. Which of the topics below best describes the problem you are experiencing?

- Change the size or rotation of the screen
- Change the resolution of the
screen and its orientation (rotation).

**Set screen brightness**

Dim the screen to save power or increase the brightness to make it more readable in bright light.

**The screen locks itself too quickly**

Change how long to wait before locking the screen in the Brightness & Lock settings.

**Why do things look fuzzy/pixelated on my screen?**

The screen resolution may be set
Why does my screen go dim after a while?

When your laptop is running on battery, the screen will dim when the computer is idle in order to save power.

Why won't my computer turn back on after I suspended it?

Some computer hardware causes problems with suspend or hibernate.

My computer will not turn on

Loose cables and hardware
problems are possible reasons.

More Information

Hardware problems
Why do things look fuzzy/pixelated on my screen?

This can happen because the display resolution that you have set it is not the right one for your screen.

To solve this, click the icon at the
very right of the menu bar and go to System Settings. In the Hardware section, choose Displays. Try some of the Resolution options and set the one that makes the screen look better.

When multiple displays are connected

If you have two displays connected to the computer (for example, a
normal monitor and a projector), the displays might have different resolutions. However, the computer's graphics card can only display the screen in one resolution at a time, so at least one of the displays might look fuzzy.

You can set it so that the two displays have different resolutions, but you won't be able to display the same thing on both screens simultaneously. In effect, you will
have two independent screens connected at the same time. You can move windows from one screen to another, but you can't show the same window on both screens at once.

To set up the displays so that they each have their own resolution:

1. Click the icon at the very right of the menu bar and
select System Settings.
Open Displays.

2. Uncheck Mirror Displays.

3. Select each display in turn from the gray box at the top of the Displays window.
Change the Resolution until that display looks right.

More Information
Screen problems — Troubleshoot screen and graphics problems.

See Also

Change the size or rotation of the screen — Change the resolution of the screen and its orientation (rotation).
Universal access

The GNOME desktop includes assistive technologies to support users with various impairments and special needs, and to interact with common assistive devices. Many accessibility features can be accessed from the accessibility menu in the top bar.
Visual impairments

Blindness

Read screen aloud — Use the *Orca* screen reader to speak the user interface.

Read screen in Braille — Use the *Orca* screen reader with a refreshable Braille display.

Low vision

Adjust the contrast — Make windows and buttons on the screen more (or less) vivid, so they're easier to see.

Change text size on the screen
— Use larger fonts to make text easier to read.

Make the keyboard cursor blink
— Make the insertion point blink and control how quickly it blinks.

---

**Hearing impairments**

Flash the screen for alert sounds
— Enable visual alerts to flash the screen or window when an alert sound is played.

---

**Mobility impairments**
Mouse movement

Adjust speed of the mouse and touchpad — Change how quickly the pointer moves when you use your mouse or touchpad.

Click and move mouse pointer using the keypad — Enable mouse keys to control the mouse with the keypad.

Clicking and dragging

Adjust the double-click speed — Control how quickly you need to press the mouse button a second time to double-click.

Simulate a right mouse click —
Press and hold the left mouse button to right-click.

**Simulate clicking by hovering** — The Hover Click (Dwell Click) feature allows you to click by holding the mouse still.

**Keyboard use**

**Keyboard navigation** — Use applications and the desktop without a mouse.

**Turn off repeated key presses** — Make the keyboard not repeat letters when you hold down a key, or change the delay and speed of repeat keys.
Turn on bounce keys — Ignore quickly-repeated key presses of the same key.

**Turn on slow keys** — Have a delay between a key being pressed and that letter appearing on the screen.

**Turn on sticky keys** — Type keyboard shortcuts one key at a time rather than having to hold down all of the keys at once.

**Use a screen keyboard** — Use an on-screen keyboard to enter text by clicking buttons with the mouse.
More Information

Ubuntu Desktop Guide
Read screen aloud

GNOME provides the Orca screen reader to speak the user interface. Depending on how you installed GNOME, you might not have Orca installed. Install Orca, and then refer to the Orca Help for more information.
More Information

Visual impairments

See Also

Read screen in Braille — Use the Orca screen reader with a refreshable Braille display.
Read screen in Braille

GNOME provides the Orca screen reader to display the user interface on a refreshable Braille display. Depending on how you installed GNOME, you might not have Orca installed. Install Orca, then refer to the Orca Help for more information.
More Information

Visual impairments

See Also

Read screen aloud — Use the *Orca* screen reader to speak the user interface.
Adjust the contrast

You can adjust the contrast of windows and buttons so that they're easier to see. This is not the same as changing the brightness of the whole screen; only parts of the user interface will change.

1. Click the icon at the very
right of the menu bar and select System Settings.

2. Open Universal Access and select the Seeing tab.

3. Switch High Contrast to ON.

More Information

Visual impairments

See Also

Set screen brightness — Dim the
screen to save power or increase the brightness to make it more readable in bright light.
Change text size on the screen

If you have difficulty reading the text on your screen, you can change the size of the font.

1. Click the icon at the very right of the menu bar and
select System Settings.

2. Open Universal Access and select the Seeing tab.

3. Switch Large Text to ON.

In many apps, you can increase the text size at any time by pressing $\text{Ctrl} + \text{+}$. To reduce the text size, press $\text{Ctrl} + \text{-}$. 
More Information

Visual impairments
Flash the screen for alert sounds

Your computer will play a simple alert sound for certain types of messages and events. If you have a hard time hearing these sounds, you can have either the entire screen or your current window visually flash whenever the alert
This can also be useful if you're in an environment where you need your computer to be silent, such as in a library (see Choose or disable the alert sound to learn how to mute the alert sound).

1. Click the icon at the very right of the menu bar and select System Settings.
2. Open Universal Access and select the Hearing tab.

3. Switch Visual Alerts on. Select whether you want the entire screen or just your current window title to flash.

More Information

Hearing impairments
See Also

Choose or disable the alert sound — Choose the sound to play for messages, set the alert volume, or disable alert sounds.
Tips & tricks

Enter special characters
Type characters not found on your keyboard, including foreign alphabets, mathematical symbols, and dingbats.

Middle-click
Use the middle mouse button to open applications, paste text, open tabs, and more.

Screenshots
Take a picture of what's
happening on your screen.

**Useful keyboard shortcuts**

Get around the desktop using the keyboard.

---

**More Information**

Ubuntu Desktop Guide
Enter special characters

You can enter and view thousands of characters from most of the world's writing systems, even those not found on your keyboard. This page lists some different ways you can enter special characters.
Methods to enter characters

Character map

Code points

Input sources

Character map

GNOME comes with a character map application that allows you to browse all the characters in Unicode. Use the character map to
find the character you want, and then copy and paste it to wherever you need it.

You can find Character Map in the Dash. For more information on the character map, see the Character Map Manual.

**Code points**

You can enter any Unicode character using only your keyboard
with the numeric code point of the character. Every character is identified by a four-character code point. To find the code point for a character, find the character in the character map application and look in the status bar or the Character Details tab. The code point is the four characters after U+.

To enter a character by its code point, press Ctrl + Shift + U, type the four-character code point,
and press Enter. If you often use characters that you can't easily access with other methods, you might find it useful to memorize the code point for those characters so you can enter them quickly.

Input sources

You can make your keyboard behave like the keyboard for another language, regardless of the
letters printed on the keys. You can even switch between different input sources using an icon in the menu bar. To learn how, see Use alternative input sources.

More Information

Tips & tricks — Special characters, middle click shortcuts...

See Also

Use alternative input sources —
Add input sources and switch between them.
Screenshots

You can take a picture of your screen (a screenshot). This is useful if you want to show someone how to do something on the computer, for example. Screenshots are just normal picture files, so you can email them and share them on the web.
To take a picture of what's on your screen:

1. Go to the Dash and open the Screenshot tool.

2. In the Take Screenshot window, select whether to grab the entire desktop, a single window, or an area of the screen. Set a delay if
you need to select a window or otherwise set up your desktop for the screenshot. Then choose any effects you want.

3. Click Take Screenshot.

If you selected Select area to grab, the pointer changes into a crosshair. Click and drag the area you want for the screenshot.
4. In the Save Screenshot window, enter a file name and choose a folder, then click Save.

More Information

Tips & tricks — Special characters, middle click shortcuts...

See Also

Useful keyboard shortcuts — Get around the desktop using the
keyboard.
Get more help

About this guide
A few tips on using the Ubuntu Desktop Guide.

Participate to improve this guide
How and where to report problems with these help topics.

Report a problem in Ubuntu
How and where to report problems with Ubuntu.
More Information

Ubuntu Desktop Guide
About this guide

This guide gives you a tour of Ubuntu desktop features, answers your computer-related questions, and provides tips on using your computer effectively.

- The guide is divided into small, task-oriented topics - not chapters. This means that
you don't need to skim through an entire manual to find answers to your questions.

- Related items are linked together. "See Also" links at the bottom of some pages direct you to related topics.

- The text input box at the top of this guide acts as a search bar, and relevant results will
appear beneath it as soon as you start typing. Left-click on any result to open its page.

- The guide is constantly being improved. Although we attempt to provide you with a comprehensive collection of helpful information, we know we won't answer all of your questions here. We will keep adding more information to make things more helpful,
though.

Thank you for taking the time to read the *Ubuntu Desktop Guide*.

-- The Ubuntu Documentation team

---

**More Information**

**Get more help** — Tips on using this guide, help improve this guide…

**See Also**

**Welcome to Ubuntu** — A visual
introduction to the Unity desktop.
Participate to improve this guide

This help system is created by a volunteer community. You are welcome to participate. If you notice a problem with these help pages (like typos, incorrect instructions or topics that should be covered but aren't), you can file a bug report.
To file a bug, press `Alt + F2` and type `ubuntu-bug ubuntu-docs`.

Press `Enter` to begin the bug collection process.

See the [Ubuntu bug reporting instructions](https://help.ubuntu.com/community/BugReporting) for more information about how to file your bug.

Thanks for helping make the Ubuntu Help better!
More Information

Get more help — Tips on using this guide, help improve this guide...

See Also

Report a problem in Ubuntu — How and where to report problems with Ubuntu.
Report a problem in Ubuntu

If you notice a problem in Ubuntu, you can file a *bug report*.

1. Type `Alt + F2` and type `ubuntu-bug nameofprogram`

   If you have a hardware
issue or don't know the name of the program affected, just type **ubuntu-**bug

2. After running one of the above commands, Ubuntu will gather information about the bug. This may take a few minutes. Review the collected information if you wish. Click *Send to*
continue.

3. A new web browser tab will open to continue processing the bug data. Ubuntu uses the website Launchpad to manage its bug reports. If you do not have a Launchpad account, you will need to register for one to file a bug and receive email updates about its status. You can do this by clicking
Create a new account.

4. After logging in to Launchpad, enter a description of the problem in the summary field.

5. After clicking Next, Launchpad will search for similar bugs in case the bug you are reporting has already been reported. If the bug has already been
reported, you can mark that bug as also affecting you. You can also subscribe to the bug report to receive updates about progress with fixing it. If the bug has not already been reported, click No, I need to report a new bug.

6. Fill in the description field with as much information as you can. It's important that
you specify three things:

a. What you expected to happen

b. What actually happened

c. If possible, a minimal series of steps necessary to make it happen, where step 1 is "start the program"

7. Your report will be given an
ID number, and its status will be updated as it is being dealt with. Thanks for helping make Ubuntu better!

If you get the "This is not a genuine Ubuntu package" error, it means that the software you are trying to report a bug about is not from
the official Ubuntu repositories. In this case, you cannot use Ubuntu's built-in bug reporting tool.

For more information about reporting bugs in Ubuntu, please read the extensive online documentation.
this guide, help improve this guide…

See Also

Participate to improve this guide — How and where to report problems with these help topics.